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Introduction & Acknowledgements 

Macintosh' .. User's Handbook is meant to serve as a tutor­
ial as well a s an on-going reference guide to the operation of the 
Apple® M acintosh . All of the Mac's many features are dis­
cussed including: 

• Installation 
• The Finder' .. 
• Disks and Disk Drives 
• The Font M over' .. 
• Disk Copy 
• MacWrite™ 
• MacPaint' .. 
• Communications 
• MacTerminal"' 
• Troubleshooting 

A number of exa mples are included with the text to illus­
trate the topics being discussed. T erms that may be unfamiliar 
to the reader will be presented in bold in the text. These terms 
will be defined in subsequent paragraphs. 

Chapter one of this book is meant to serve as an introduc­
tion to the Macintosh. The chapter begins with a comparison 
of the Macintosh with the IBM® PC. Next appears a history of 
the Mac. The remainder of the chapter consists of a discussion 

9 
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of the hardwa re a nd so ftwa re co mprising the the typica l M ac 

system. 
C ha pter two is des ig ned to provide step by ste p instruc­

t ions to t he insta llation of the system. T his includes some oft he 
o ptional peripheral equip ment ava ilable fo r the Mac. 

C ha pter three describes the startup and use of the M ac's 
visua l operating system. The Deskto p a nd the Finder a re de­

scribed in deta il. This cha pter lays the bas ic foundati on fo r the 
operation of the enti re Mac system. 

C ha pter four conta ins a n in de pth discussion of t he Mac's 
d isks a nd d isk drive. T his cha pter reviews the various tech­
niques which will o ptimize the M ac's data resources. 

C hapters five, six, a nd seve n discuss two importa nt a ppli­
ca tions for the M ac, MacWrite a nd M ac Pa int. Each cha pter 
uses one or mo re examples which the operator ma y use for 
ha nds-on learning. 

C hapter eight is a d iscussion of Macintosh communica­
t ions. It describes the means by which the operator may use the 
MacTerminal a pplicat ion to lin k the Mac to other infor mati on 
sources. 

Chapter nine is designed t o aid the operator in interp ret­
ing a bnorma l situa t ions with the M ac. It a lso discusses more 
adva nced operating techniques. 

We have included two a ppendices in this boo k. Append ix 
A is listing of the ASCII codes w hich the Mac recognizes. 
A ppendix B is a list of Wa rning boxes which the operato r 
might encounter during norma l operati on. Interpretations 
accompany each box to help identify the conditions which 
might cause the wa rning. 

We gratefully acknowledge Ala in Rossman a nd S teve 
H oyt of A pple's Macintosh depart ment for their help in 
o btaining technica l informa t ion a nd software for us in a timely 
ma nner. We a lso tha nk the ComputerLa nd sto re in May fi eld 
Heights , Ohio for their patient ass ista nce. 
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Overview of the Mac 

Introduction 

The Macintosh™ perso na l co mputer has been hera lded by 
ma ny individua ls ins ide a nd out side of the persona l compute r 
indust ry as the most importa nt development in the computer 
ind ust ry in the past severa l years. T he Apple Computer Corpo­
ration is describing the machine as the foreru nner of a new 
genera t io n of perso na l computers. Many experts, however, 
have maintained that a lthough the Mac is indeed diffe rent , it is 
not a fo rerunner of a new wave of persona l computing. They 
mainta in tha t the new devices incorporated in the Mac such as 
the mouse, the Desktop, and pull-down menus, are not signifi­
ca nt productivity aids. 

11 
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As to the ultimate answer, you will have to decide whether 
the Mac suits yo ur need s better than more co nvent ional com­
pute rs such as the IBM PC®, Compaq® portable, Kaypro®, 
etc. In this chapter, as well as throughout much of the 
remainder of this book, we will attempt to provide an objec­
tive, unbiased view of the Mac. For those of you familiar with 
the more traditional personal compute rs, the differe nce between 
the Mac and these will be immediately apparent. For those of 
yo u not familiar with traditional computers, we have provided 
a brief discussion which contrasts the Mac a nd the IBM PC. 

We will not attempt to carry this discussion through the 
remainder of this book. Therefore , if your purpose in reading 
this book is to gain information to help in making a purchase 
decis ion between the Mac and a traditional computer, we 
recommend that you do additional research o n those tradi­
tional computers. We will attempt to provide the necessary 
information on the Mac. 

Why is the Mac Different? 

In order to operate conventional perso nal computers, the 
use r must master that computer's operat ing system. An operat­
ing system can be defined as a group of programs which 
manage the overall operation of the computer. 

The most popular persona l computer ope rating systems 
to date have been MS-DOS® and CP / M®. Both of these could 
be desc ribed as literate o pera ting systems. In this context, 
lite rate means the ability to read and write with comprehen­
sion. With a litera te operating system, the user must have the 
ability to encode an operation into a written command. That 
command must be entered into the computer via the keyboard. 
After it has been entered, the computer will display the com­
mand. Here the user will generally read the comma nd , check­
ing it for accuracy. Once he or she is certain that the command 
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has been accurately e ntered, the user will execute the com­
mand. In many instances, the operating system then responds 
with its own written messages which must be answered by the 
user. In effect, a series of written messages controls the 
operation of the computer. 

The Mac also has an operating system known as the 
Finder™. However, the Finder is a visual rather than a literate 

operating system. With the Finder, commands are entered by 
moving a pointer to a symbol or message on the Mac's scree n. 
Although some lea rning is required to master the Finde r, this 
process is far easier tha n sifting through thick manuals filled 
with complex commands. 

The difference between the Mac's visual environment and 
a literate environment can best be illustrated with an e xa mp le. 
Suppose that you owned an IBM PC computer, and you 
wanted to create a second copy of a text file named LET­
TER I .TXT on drive A with a new name. The following steps 
would be required to create that file and to check the disk to 
verify that fact: 

I. Insert a diskette in dri ve A which contains the 
necessa ry DOS startup files and LETTER l.TXT. 

2. Power on the IBM PC. 

3. Enter the following co mmand: 
COPY LETTER1.TXT LETTER2.TXT 

4. Enter DIR. The va ri ous files, includi ng LET­
TER2.TXT, conta ined on the disk will be 
displayed . 
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To create a co py of a text* fi le on the Mac, the fo llowing 
steps wo uld be req u ired : 

I. Power on the Mac. 

2. Insert a sta rtup d isk containing LETTER l.TXT 
in the Mac's drive. We will assume this d isk was 
na med Exa mple Disk. 

3. Open the Exa mple Disk ico n o n the Desktop by 
moving the po inter to it a nd double-click ing the 
mouse button. Example Disk's wind ow will 
a ppear. T he LETTER l.TXT document icon wi ll 
be displayed in tha t wind ow. 

4. Select LETT ER l.TXT by moving the pointer to it 
and clicking the mouse button. 

5. Move the pointer to the File menu a nd pu ll down 
that menu. Ind icate Duplicate by clicking the 
mouse button. A new icon na med Copy of LET­
T ER l.TXT will a ppear in the window. 

Notice tha t approximately the sa me number of ste ps were 
required to perform the copy operation on bo th co mputers. 
Although the co mpa rati ve number of steps req uired will va ry 
acco rding to the operation being performed , in our opinion, 
this copying ope ra tion was a fa irly representa ti ve test. 

As pointed o ut in this example, the maj or differences 
between the Mac a nd a conventi onal computer such as the 
IBM P C co nsist o f how a task is acco mplished . The IBM PC 
copying opera ti on required the fo rmula tio n a nd e ntry of a 
specific li tera te co mmand: 

COPY LETTER1 .TXT LETTER2.TXT 

* Text fi les a re known as documents on the Mac. 
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On the o ther hand, with the Mac, the copyi ng operation 
was performed by moving the pointer to various ico ns and file 
menus o n the Des ktop and selecti ng the desi red items by 
clicking the mouse button. 

The end-user must, of course, make the final decisio n as to 
which environme nt, visua l or literate, he o r she prefe rs. The 
probability is great, however, that the first-time computer user 
will find the Mac's visual system eas ie r to master than the I BM 
PC's literate system. 

History of the Mac 

The concepts behind the Macintosh's visual interface were 
initially developed at the Xerox Corporati on 's Pa lo Alto 
Research Center. Xerox actually brought a machine to market 
in 198 1 tha t incorporated these ideas, the Xerox Star®. How­
ever, the Star was not a la rge co mme rcial success proba bly due 
to the fact that its cost was beyond the mea ns of the average 
personal computer consumer. 

In 1983, Apple® introduced the original Lisa™ mode l. The 
Lisa includes a visua l interface similar to tha t used on the Mac. 
The original Lisa was subsequently modified a nd rei ntroduced 
in the spring of 1984 as the Lisa 2. 

The main difference between the Mac a nd its predeces­
sors, the Xerox Star a nd the A pple Lisa, is price. The Mac was 
the firs t persona l computer introduced with a visua l interface 
and with a price tag under $3000. The Mac's relatively low 
price coupled with its efficient design a nd visua l interface have 
resulted in it being a success in the marketplace. 
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The Typical Mac System 

A typical Mac system might consist of the following items: 

• System unit 
• Keyboard 
• Mouse 
• Printer 
• Extra disk drive 
• Numeric keypad 
• Modem 
• System disk 
• Language disk(s) 
• Applications softwa re disk(s) 

The minimum requirements for a working Mac system 
consist of the following items: 

• Sys tem unit 
• Keyboard 
• Mouse 
• System disk 
• Applications software disk 

These are depicted in figure I. I 
In the following sections, we will describe the com po ne nts 

of the basic Mac system as well as the devices and software that 
you will most likely wish to add to it. 

SYSTEM UNIT 

The system unit , as depicted in figure 1.2, is the heart of 
the Mac . It contains the Mac's e lectronic circuitry, a built-in 
disk drive for storing information, and a built-in 9 inc h, high 
resolution monitor for displaying information. 
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Figure 1.1. Basic Mac system 

Figure 1.2. Mac system unit (front view): a, m onitor; 
b, disk drive; c, keyboard plug. (Rear view): a, on / o ff 
b, power cord plug; c, se rial data ports 
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The system unit is surprisingly compact. It only requires a 
JO inch by I 0 inch desk or table top area and is only 13Yi inches 
high. With a weight of less than 23 po unds, the system is light as 
well as compact. 

INTERNAL CIRCUITRY 

Two circuit boards are installed inside the system unit. 
One board contains all of the Mac's analog circuitry while the 
other board contains all of its digital circuitry. 

Most personal co mputers contain four or more boards. 
By using only two boards, the Mac's manufacturing cost was 
reduced and its reliability increased . 

THE MAC MICROPROCESSOR 

The heart of the Mac is the 68000 microprocessor. A 
microprocessor can be defined as a single chip which contains 
the logic of a central processing unit as well as any additiona l 
logic that must complement the CPU. The central processing 
unit, or CPU, is the heart of any computer. The CPU controls 
all of the other computer components. 

Microprocessor logic is based upon the bit. A bit (or 
binary digit) is the bas is of a ll information sto rage within the 
computer. A bit consists of a simple switch that can lie in either 
of the two binary states, on o r off. Bits are often separated into 
groups of eight. These groups of eight bits are known as bytes. 
A byte is required to represent a single character (i.e. letter, 
number, or symbol). Generally, bytes are processed by the 
computer in groups of two. 

The Motorola 68000 can process 32 bits internally at one 
time. This makes it more powerful than other microprocesso rs 
generally used in personal computers which , as a rule, can only 
process 16 or 8 bits internally. 
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Although the m ore powerful Lisa computer system uses 
the same microprocesso r, the Mac processes da ta fa ster using a 
7.83 MHZ* clock as opposed to the Lisa's 5 MHZ clock. 

MAC MEMORY 

The Mac conta ins l 28K o f RAM me mo ry and 64K of 
ROM memory. ROM sta nds for Read-Only Memory. ROM 
will hold the data stored in it perma nently. If the power to the 
Mac is shut off, the info rma ti o n sto red in ROM will re ma in 
there. 

RAM sta nds fo r Ra ndom Access Mem ory. Any d a ta 
stored in RAM will be lost when the Mac's power is shut o ff. 

THE VIDEO DISPLAY 

In o rder to relay info rma tion back to the user, the Mac 
features a nine inch, high resolution cathode ray tube (C RT) 
display. Its high resolution is due to its 51 2 x 342 picture 
e lements (pixe ls) giving a to ta l of 175, 104 individual d ots on 
the screen. That works out to a bout 80 pixe ls pe r inch. The da ta 
for the display is stored in a bout 22K of the ava ila ble RAM . 

Instead of recogni zing letters or word s o n the screen, the 
Mac displays info rmatio n on a pixel by pixel basis relying on 
the a pplica tio n softwa re to provide the proper lettering infor­
ma ti on. This helps reduce both the ha rd wa re a nd software 
needed for the C RT. 

The display is black a nd white as opposed to the gree n or 
a mber a nd black found o n ma ny othe r computers . Although 
there is some thought tha t the green o r a mber displays are 
eas ie r o n the eyes, the Mac's high resolution screen is very easy 
to work with a nd ca uses no d iscernible eyestra in. 

• I MHZ clock generates I m ill ion clock pulses per second. 
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DISKS AND DISK DRIVES 

The disk drive is one of the most importa nt parts of a 
computer. Disk drives allow the storage of large a mounts of 
data. This data is actually stored on a disk (or diskette) which is 
read from or written to within the drive. The 3Yi inch disk 
currently used with the Mac can store a bout 400,000 (or 400K) 
characters of data on one of its sides. Eve ntually, the disks used 
with the Mac will be expanded giving a total capacity of 800K. 
This is about 6Yi times as much data as can be stored on 128K 
of RAM. 

Unlike RAM storage, when information is sto red on a 
disk, the information is not lost when the computer is turned 
off. In other words, disks offer a permanent means of storing 
data. Disk storage is not as permanent as ROM data storage, 
howeve r, since a computer can a lter the data on a disk whereas 
a ROM cannot be a ltered without destroying it.* 

A disk stores data in a magnetic form much like data is 
stored on magnetic tape. The main difference between storage 
on a magnetic tape a nd storage on a d is k is that the disk a llows 
data to be accessed more quickly. 

The disk drive contains a device known as a read/ write 
head, which is used to read and wri te information. The compu­
ter can move the head t o any position desired on the disk 
surface. This is in cont rast t o magnetic tape, where data is read 
from or written onto the ta pe in consecutive o rder. 

Consider the d ifference between an audio cassette tape 
and a phonograph record. In order to locate a song on the 
cassette, you must wind through the tape to the appropriate 
place. With magnetic tape, the computer must wind through the 
ta pe until it find s the information it needs. This is known as 
sequential access. On the other hand , with the phonograph 
record , you simply jump a head to the desired position. Sim­
ila rly, with a magnetic disk, the computer just advances 

* With the exception of PRO M's (programmable ROM). 
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directly to the desired sp ot to access information. Thi s is ca lled 
random access. 

The Mac uses a floppy disk dri ve. A second type of disk 
drive known as the Winchester fi xed disk is also available on 
ma ny persona l computers. Winchester di sk drives are designed 
so that from six to twelve times more d ata can be stored on 
their surface than on a standard floppy diskette. Fixed disks 
are mo re durable than fl oppy disk s beca use they are made of a 
hard , inflexible materia l. Winchester disks must be kept very 
clean as they are extremely vulnera ble to dust, dirt , and smoke. 

Since they must be kept so clea n, Winchester disks must 
be sea led inside of the disk drive. This mea ns that Winchester 
disks cannot be cha nged unless they are installed in sea led 
cartridges. 

Floppy disk systems a re often used in co nj u ncti on with 
Winchester disks to a ll ow for back-up storage. A Winchester 
drive is shown in figure 1.3. 

Courtesy of Corvus Systems 

Figure 1.3. Winchester disk system 
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Apple does not offer a Winchester drive with the Mac*. 
However, Apple has announced that their new Lisa 2** models 
will be offered with 5MB*** and IOMB of fixed disk storage. If 
you desire additional disk storage, you should examine the 
Lisa 2/ 5 (5MB) and Lisa 2/ 10 (IOMB). Also, independent 
vendors such as Tecmar have announced Winchester disk add­
ons for the Mac. 

THE KEYBOARD 

The keyboard unit consists of a standard , 58 key, full 
travel, typewriter style keyboard. The keyboard unit is con­
nected to the main console via a coiled, telephone style cord. 
This feature allows the keyboard to be moved to a convenient 
location within five feet of the Mac without moving the entire 
computer. 

The keyboard operates in much the same way as a normal 
typewriter keyboard. It features all the standard keys with 
some minor additions. These additions serve to help operate 
special functions on the Mac. In place of the Shift Lock key 
provided on most typewriters, the Mac keyboard has a key 
labeled Caps Lock. This key operates as a shift for the letters on 
the keyboard giving capital letters, but for all other characters, 
it has no effect. In order to type the alternate characters , you 
must press the Shift key. 

The Command@, Option, and Enter keys are located to 
the left and right of the space bar. Their functions are explained 
in detail on page 47 of chapter 3 and page 143 of chapter 5. 

• This may, however, be a future d evelopment. 

•• At the time of this writing, Apple has a nnounced that the Lisa 2 series will be 
compatible with the Macintosh . 

••• MB is an a bbreviation for mega byte. IM B is equal to I million bytes. 
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THE MOUSE 

The mouse, a s shown in figure 1.4, is a combinat ion 
pointing device and signaling device. The mouse ca n be used as 
a pointing device by sliding it over the work surface. The mo use 
operates using a small rubbe r ball which rotates within its 
socket a s the mouse moves across the tab le. The ball turns two 
rota ting vanes which interrupt light beams. These light bea ms 
operate light sensitive transistors which se nd signa ls to the Mac 
through the attached electrical connection. T he pointer on the 
Mac's screen will move relative to the moveme nt of the m ouse 
o n the work surfa ce . This is depicted in figure 1.5. 

The mouse ca n be used as a signaling device by clicking the 
mouse button. The mouse is gene rally used as a signa ling 
device when some piece of informa tion is being selected . Th is 
process will be discussed in cha pter 3. 

Figure 1.4. The Macintosh mouse. a, mo use button 
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Figure 1.5. Using the mouse as a pointing device 

THE IMAGEWRITER PRINTER 

The Imagewriter® printer is a seria l interface, d ot matri x 
type printer designed fo r use with the Apple Lisa and Apple 
Maci ntosh computers. Seria l interface devices receive each bit 
of da ta sequentia lly instead of byte by b yte as with para llel 
devices. This method of data transfer allows a simpler d esign 
for the compute r while sacrificing little in terms of speed . T he 
p rinter has its own microprocesso r as we ll as I K byte of 
memory so that it can accept pa rt of the computing burden 
fro m the computer. 

T he dot matrix printing technique operates in the follow­
ing ma nner. T he print head on th e lmagewriter co nta ins a 
series of dot po ints which ope rate much like pencil points. 
These d ots a re arra nged in a matrix 16 wide by 9 high. When 
printing, the printer begins each line by placing the print head 
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over the beginning of the line and st riki ng the page through the 
typewriter ribbon. When the operation is complete, the print 
head moves on to the next position on the page. Each time a 
dot passes over a position to be printed , the pencil poin t shoots 
out a nd strikes the paper. 

T he Imagewriter was designed to print one character 
within the p rint head space, but the Mac uses it differently 
treating each dot on the print head as if it were a pixe l on the 
screen. This way, the printer can print lettering of any size. 

Another design feature of the Imagewriter is its abili ty to 
accommodate both single sheet and tractor-fed paper. This 
a llows the user to print letters on his or her company's letter­
head or to print long reports without constantly inserting 
paper. 

OPTIONAL DISK DRIVE 

The Mac features two se rial ports o n its back panel which 
can be used to connect the Mac to various peripheral devices. 
One of those optiona l devices is the optional disk drive. The 
di sk drive available from Apple is constructed li ke the internal 
disk drive provided on the basic unit. It uses a seria l data bus as 
does the printer. 

The advantage to having an extra d isk drive connected to 
yo ur Mac is that it a llows easier data handling when two disks 
are involved in an opera ti on . This happe ns quite often since 
more than two-thirds of a disk can be taken up by the operating 
system, applications software, and other essential files leaving 
little space for text files. 

Most Mac applications create text fil es which can occupy 
a sizable amount of space. Since the Mac's internal memory is 
relatively small*, it must refer to the disks often whe n perform­
ing various operations. When two disks are involved , these 

• We a re assuming I 28K. This may be expanded at some future date. 
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operations can require as many as ten disk swaps. This can 
cause undo wear and tear on the disks causing them to age 
prematurely. In fact, we feel that the optional second disk drive 
is essentia l to normal operation of the Mac. 

THE NUMERIC KEY PAD 

Another optional unit avai lable for the Mac is the numeric 
key pad . It plugs directly into the keyboard. The numeric key 
pad allows easier entry of pure numeric d a ta into a text fi le. 
This option features a standard numeric key pattern along with 
direction arrows for maneuvering a bout a document. It can 
substitute for the keyboard when using Macintosh applications. 

MACINTOSH COMMUNICATIONS 

In order to connect the Mac to other data processing 
machines through phone lines, Apple has provided for the 
addition of an op tional modem. Modems are availa ble in 300 
baud* a nd 300/ 1200 baud models. Although Apple distributes 
the standard modem for the Mac, other companies manufac­
ture compatible modems as well. 

A softwa re package called MacTerminal is due to be 
released in mid 1984 which will allow the Mac to use the 
modem to communicate. The program will feature a utomatic 
dialing and answering and will operate with touch-tone a nd 
rotary dial systems. Communications will be possible with 
other computers a s well as many of the various data services 
which operate around the world. 

* One baud is about one bit per second data transfer. 
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MACINTOSH SOFTWARE 

The types of fil es stored on a diskette is a potentia lly 
co nfusing issue. It is important to realize the differences a mo ng 
the three types of files : system files, application files , a nd 
documents. The system fi les a re a set of programs tha t manage 
the overall operation of the computer. The tasks invo lved in 
this system management include: 

• System sta rtup 
• System fi le maintenance 
• User disk file maintenance 
• Applica tion opening routines 
• Peripheral device control 

Whenever the computer is powered on, a diskette tha t 
contains the system fil es (usually called a system diskette) must 
be inserted in the disk drive. A diskette tha t d oes no t conta in 
these files will not be a ble to start up the system. 

System programs are executed a utomatica lly by the com­
pute r system. As a result , it is not necessa ry fo r a n o perator to 
und erstand exactly how the system prog ra ms are used o r what 
they a re used fo r. The computer manipula tes these programs as 
necessa ry, o nly when they are needed . 

The second category of fi les is called a p plicatio n files or 
simply a pplica tions. T hese types of fi les a re used to perform 
specific functio ns with the computer. Applicati ons differ from 
system programs in the fac t tha t a n a pplica tio n ca nn ot be used 
unless the system programs are a lready active. Also , a pplica­
tio ns a re only executed when the opera to r req uests them. 
Unlike system progra ms, a pplica tio ns a re not directly und er 
the co ntrol of the computer. Word p rocessors, gra phics pro­
grams, games, a nd fi nancia l record programs are a ll examples 
of a pplications. 

BASIC, Pasca l, FORT R AN, and Care examples of high­
level programming la nguages. A high-level programming la n­
guage enables its user to write a program using nea r-English 
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terminology. This contrasts to low-level assembly and machine 
languages in which numbers and mnemonics are used to com­
municate instructions to the microprocessor. At the time of 
writing of this book, no high-level programming languages 
were available from Apple* for use on the Mac. Apple is 
presently in the process of writing two such programs, Macin­
tosh BASIC, and Macintosh Pascal. These languages will 
differ from th ose normally used in that they will rely heavily 
upon the visual interface concept of the Mac. 

The final category of files is documents. These types of 
files do not contain programs, so they are never executed in the 
sense that a system or application file is executed . Instead , 
documents contain information that an application program 
need s in order to execute properly. For example, the Mac­
Write™ word processor is considered an application, but a file 
that contains a memo or letter is considered a document. Sim­
ilarly, the MacPaint™ graphics program is considered an appli­
cation, but a file that contains a specific illustration is called a 
document. 

In light of the different types of files, the operation of the 
computer can be summarized as follows. When the computer is 
powered on, be sure that a set of system programs is available 
to start up the system and maintain its operation. Next, acti­
vate an application program that performs the desired task. 
Finally, access the document that conta ins the information to 
be processed. Some applications do not require the use of 
documents, so this step is not always necessary. If a new 
document is to be created , it is not necessary to load an existing 
document. Each applica tion that uses documents contains 
provisions for creating new docume nts. 

The icons used to represent the commonly used types of 
files are depicted in figure 1.8. 

• Microsoft Corp. has released a version of BASIC for the Mac. 
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2 
Installation 

Introduction 

Now that we have looked at the Mac computer system, we 
are ready to set up the physical components or hardware. To 
start with we will assume that you have purchased a basic Mac 
system. We will, therefore, discuss the optional units, the 
second disk drive and the numeric key pad, only in minor 
detail. 

Assembly of the Mac requires only a few minutes. Even 
the first time computer user can easily assemble the system. It is 
nea rly impossible to improperly connect the cables on the Mac. 
Most plugs fit only in their appropriate sockets. The owner 
should, however, be careful not to drop any of the Mac's parts. 
Although they are designed to be quite durable, they will not 
tolerate excessive abuse. Be especially careful of the main 
system console. The CRT display located inside the console 
will explode if it is broken. 

31 
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Installation 

The installation of the Mac is simple and straightforward. 
Since the basic system has only three components, it only takes 
a few minutes to make the proper connections between the 
devices. This section provides instructions for the installation 
of the main Mac components as well as the Imagewriter 
printer. 

CHOOSING A LOCATION 

The installation of a computer system begins with the 
selection of a suitable location for the equipment. The compu­
ter system must be located on a firm surface near an electrical 
outlet. The equipment should be located in an area where the 
computer will not be exposed to any sort of hazard. A compu­
ter system should never be exposed to dust, intense heat or 
humidity, intense cold, or direct sunlight. The electronic com­
ponents within the computer generate a moderate amount of 
heat during normal operation. Therefore, do not place the 
computer at a location where ventilation is restricted. 

A computer system should not share an electrical outlet 
with heavy equipment or be powered by an outlet controlled by 
a wall switch. T hese types of situations often cause electrical 
disturbances that can seriously disrupt the operation of the 
system. 

UNPACKING 

Proceed with the installation of the system by unpacking 
the components. All of the following parts should be included 
with the system. If all of these parts cannot be located, contact 
your dealer as soon as possible. 
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• Main console 
• Keyboard unit 
• Mouse 
• Keyboard cable 
• Power cord 
• Manual 

INSTALLING MAIN CONSOLE 

Place the main console on a desk or tabletop near an 
electrical outlet. Remove the power cord from its box and 
insert the end into the receptacle in the back of the main 
console. The appropriate receptacle has the marking of a wave 
( - ) to symbolize a standard A.C. power supply. Insert the 
other end in a three conductor, grounded outlet. The Mac may 
be operated on 50 or 60 H z voltages from I 05 to 125 VAC. The 
Mac is intended to be operated with a grounded electrical 
system ONLY! If a three conductor outlet is not available, use 
an appropriate adapter and be sure that the ground wire is 
properly connected. 

INSTALLING THE KEYBOARD 

Choose a suitable location for the keyboard near the main 
console. The keyboard should be located close enough to the 
mai n console so the video display can be easily viewed while 
working at the keyboard. Use the coiled, telephone style cord 
to connect the keyboard to the console. This cord a llows the 
keyboard to be moved anywhere within about five feet of the 
console. Figure 2.1 depicts the proper installation of the 
keyboard. 
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Figure 2.1. Keyboard insta llat io n 

A ltho ugh the coi led co rd is similar to a telephone ha ndset 
cord , never use a n o rd ina ry telephone cord with the Mac 
keyboard unit. 

INSTALLING THE MOUSE 

Insta llation of the mouse is simple a nd st raight forward. 
Begin by selecting a clean, Oa t, sm ooth surface w here the 
mouse ca n be easi ly ma nipulated. Avoid using the mo use in 
areas where dust or di rt accumu late. The installat io n of the 
mouse is dep icted in figure 2.2. 
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Figure 2.2. Mouse installation 

As with a ll computer equipment, protect the mouse from 
excessive heat, cold, moisture, or su nlight. It is usually a good 
practice not to eat or drink in t he vicinity of the computer 
system. 

The plug on the end of the mouse cord is accommodated 
by the receptacle in the lower left corner of the main console 
back panel. The receptacle is denoted by a small picture of the 
mouse. Hold t he plug with the Apple logo fac ing upward a nd 
press the plug into the receptacle. T he plug is su pplied with two 
screws to securely fasten the plug into position. The screws 
have la rge knobs attac hed that a ll ow these to be tighte ned 
without the use of any tools. 
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INSTALLING THE IMAGEWRITER PRINTER 

The lmagewriter printer, like the main console, requires a 
three conductor, grounded electrical outlet. Once again, be 
sure that the equipment is properly grounded before using it. 
The power cord plugs directly into the back of the printer at the 
lower right-hand side. The receptacle is la be led with a wave(- ) 
to indicate a standard electrical outlet. 

The larger connector on the printer interface cable sup­
plied with the printer should be connected to the receptacle on 
the lower left side of the back of the printer. The receptacle is 
similar to the mouse connectors, but about twice as large. Be 
sure that the plug is properly aligned with the receptacle before 
forcing the plug into position. An improperly aligned connec­
tion can damage the plug as well as the receptacle. Tighten the 
fastening screws to secure the connection. 

The smaller plug on the printer cable should be connected 
to the main computer console. The appropriate receptacle is 
labeled with a picture of a printer. Once again, observe the 
proper alignment of the connectors and tighten the fastening 
screws to secure the connection. 

The proper installation of the printer is outlined in detail 
in the printer manual. Follow these instructions carefully and 
review the installation with the following guidelines. 

Be sure that all packing material has been removed from 
the printer. The printer is carefully packaged at the factory to 
protect it during shipping. However, all packing material must 
be removed to ensure proper operation of the printer. It is 
usually a good practice to save the packing materials in case the 
printer needs to be shipped or stored in the future. 

Before operating the printer, the ribbon cartridge must be 
properly installed. The ribbon cartridge snaps into place on the 
carriage assembly. Figure 2.3 shows the proper installation of a 
ribbon cartridge. Note that the ribbon must be aligned in front 
of the print head . 
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Figure 2.3. Ribbon installation. a, ribbon; b, cartridge; 
c,ribbon advance knob 

The tension on the ribbon can be adjusted by rotating the 
ribbon advance knob clockwise. Do not attempt to rotate the 
knob in the other directio n. Also, be sure that both of the 
cartridge fasteners are in place before attempting to operate the 
printer. 

The I magewriter printer can be operated wit h two types of 
paper. The first type of paper is called pin feed or tractor feed. 
This type of paper has holes a long the edges that allow t he 
paper to be pulled through the printer by sprockets. Many 
types of paper, labels, invoices, and other types of forms are 
available in pin feed format. The I magewriter can also be used 
with standard paper and forms. The printer has a friction feed 
system that allows paper to be pulled through by pinch ing it 
between two rollers. This type of paper feed is simi lar to that 
used in most typewriters. 
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The release lever to the left of the platen determines which 
type of paper feed system is to be used. Figure 2.4 shows the 
location of the release lever. When the lever is fo rward, the 
friction feed system is engaged. When the lever is back, the 
friction feed system is disengaged , and the pin feed system can 
be used exclusively. 

The locations for the sprockets of the pin feed system can 
be adjusted to accommodate paper or forms with a ny width 
between 4 and I 0 Yi inches. The back cover panel of the printer 
encloses the pin feed mechanism. To move the sprockets, 
remove the cover and locate the white release levers (see figure 
2.5). Pushing the levers toward the back of the pri nter releases 
the sprockets and allows them to be moved. Once the correct 
configuration has been established, Jock the sprockets in place 
by pushing the release levers forward. 

The sprockets are equipped with paper clamps that keep 
the paper securely in position. These clamps can be released by 
simply lifting upward on the inside edge of the cla mp. The 
clamps can be secured once again by pressing downward until 
they snap into position. 

The friction feed system is used in the same manner as a 
typical typewriter. When the paper release lever is forward , 
simply insert a sheet of paper behind the platen and use the 
paper advance knob on the side of the printer to ad vance the 
paper to an appropriate position . T he paper release lever can 
be used to allow the paper to be straig htened after it has been 
inserted into the printer. 
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Figure 2.4. Paper release lever 

B B 

Figure2.5. Pin feed mec ha nism. a, sprockets; b, sprocket 
release levers; c, paper clamp 
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THE NUMERIC KEYPAD 

The optional numeric keypad is installed in a manner 
similar to the keyboard. Follow the directions accompanying 
the unit. Connect the unit to the Mac. Then connect the key­
board to the numeric keypad. The keyboard should operate 
norma lly. The keypad will substitute for the keyboard when 
entering numbers. 

OPTIONAL SECOND DISK DRIVE 

To install the optional second disk drive, locate the serial 
interface connection on the back of the Mac. It is identified by 
the sma ll image of a disk drive etched into the plastic directly 
above the socket. Find the cable which should have accompan­
ied the disk drive and press the end of the cable with the large 
knobs into the socket. As with all other Mac connections, be 
certain that the connector pins are correctly aligned before 
attempting to insert the plug. The large knobs on the plug, like 
those on the mouse cable, are designed for ease of installation. 

There is no need for a se parate power connection for the 
disk drive. The Mac will control the unit completely and supply 
its power. To operate the second disk drive, simply insert a disk 
into it. The Mac will recognize the disk and its origin. The unit 

will aid greatly in multi-disk operations. When using the unit as 
a data disk for applications, be certain that the disk is inserted 
before trying to call on it. If it is not in place, the Mac will 
assume that the disk is to go into the main disk drive, and it will 
eject the applications disk. 

APPLE MODEM 

The Apple modem is used to establish communications 
with other data processing units through telephone lines. 
Unpack the mode m a nd place it near the Mac. Locate the 
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cables which came with the unit. There should be a power 
cable, a serial interface cable with 9-pin connectors, and a 
modular telephone cable. 

Be sure that the Mac is turned off. The modem should be 
turned off if it has been plugged in. If not, plug it into a 
grounded electrical outlet. If you use the Mac, the printer, and 
the modem, you will need to find three separate outlets in order 
to utilize a ll three units a t once. If you use a multi-plug ada pter, 
be certain that it is a good quality unit a nd provides a secure 
ground . Do not overload the circuit. The power requirements 
for a ll Macintosh units are listed o n the rear panels of th ose 
units. Although they do not require very much power, they 
may overload the circuit when placed on the sa me receptacle as 
other appliances. The Mac alone uses about as much power as 
a 60 watt light bulb. 

Locate the serial modem connection on the rear panel of 
the Macintosh. It is identified by a n image of a telephone 
handset etched into the plastic. Inse rt one end of the data cable 
into the Mac's receptacle. As always, be carefu l of the pin 
alignment. Insert the other end into the serial port on the rear 
panel of the mod em. Use a screw driver to tighten the lock­
down screws on the connectors. Under a specia l configuration, 
the modem may be connected to the printer serial port. Details 
regarding this appear on page 272 of cha pte r 8. 

There are several possibilities for the connection with the 
telephone line. If you pla n to connect the modem in conj unc­
tion with an existing telephone, simply unplug the modular 
cable for that phone a nd plug it into one of the modular sockets 
on the modem's rear panel. Then connect the telephone to the 
remaining modular socket using the telephone cab le accom­
panying the modem. The modem unit is designed to allow the 
telephone to rest upon it. See figure 2.6 for the proper connec­
tions wi th this configuration. 
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Figure 2.6. Connecting the modem with a telephone. 

The telephone in the above described procedure is 
optional. Its co nnection is sim ply for the operator's conven­
ience . It does not play a part in the modem's operation. You 
may connect the modem to the wall receptacle using any 
approved modular style telephone cord. In any case, the 
modem ca n be permanently attached to the telephone system. 
When not in use, the modem will act like a telephone extension 
which is hung up. It shou ld not interfere with normal telephone 
business. 

If you utilize another type of modem, follow the installa­
tion inst ructions which came with that unit. The general 
proced ure remains the same. The modem will require a separ­
ate power connection, a data connection with the Mac, and a 
telephone con nection. Some m odems come with a power con­
verter wh ich changes the standard outlet voltage to a voltage 
specified for that modem. These non-Apple modems may 
req uire special cable adapters to interface with the Mac. 
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Using the Finder 

Introduction 

In chapter I, we gained a n overview of the Mac a nd its 
peripherals. In chapter 2, we installed the Mac. We are now 
ready to learn how to use the Mac. We will begin learning the 
Mac by exploring the System Disk.* The System Disk is 
provided with the Mac a nd is used to sta rt-up the Mac. By 
copying some of the contents of the System Disk to other 
diskettes, these diskettes can a lso be used to start-up the Mac. 
Diskettes whic h can be used to start-up the Mac a re known as 
start-up diskettes. We will expla in how to create sta rt-up 
diskettes in chapter 4. 

• We will use the terms disk and diskette interchangeably in th is book. 
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Power-On 

The first step in exploring the System Diskette is to power 
on the Mac. This is accomplished by pressing the power switch 
located on the rear of the system unit to the I or On position. 
The power switch is shown in figure 1.2. When the Mac is 
powered on, the screen will appear as depicted in figure 3.1. 
The flashing question mark(?) is meant as a reminder to the 
operator that a diskette should be installed . Since we are going 
to explore the System Disk, let's locate and insert that disk . 

The System Diske tte, as any other Mac diskette, has a 
rectangular metal bar on its top side and an identical metal bar 
and a metal ring on its bottom side. The metal ring is actually a 
part of the disk surface. It protrudes through an opening in the 
plastic cover which protects the diskette surface. The 3Yi inch 
diskettes used with the Mac are pictured in figure I. I. 

Figure 3.1. Mac display screen upon power on 
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Diskettes should be inserted into the disk drive with the 
top side (the side without the metal ring in the center) facing 
up. The edge with the rectangular metal bar should be inserted 
into the disk drive. If you are inserting the disk properly, you 
should notice a small arrow on the disk surface to the left of the 
metal bar. This arrow should be pointing towards the Mac's 
d isk drive. The proper procedure for inserting a disk into a 
Mac disk drive is shown in figure 3.2. 

Figure 3.2. Inserting the System Diskette 

Once we have inserted the System Disk, the Mac will 
begin emitting a series of sounds a nd the image on the screen 
will turn into a smi ling face. 

A series of screen displays will then appear. The first will 
include the message "Welcome to Macintosh." This display 
will be replaced by that depicted in figure 3.3. The menu 
portion will appear first , followed by the System Disk and 
Trash icons. 
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Figure 3.3. Initial System Diskette d isplay 

An icon is a graphic symbol used by the Mac to represent 
either a physica l object or a non-physical concept. In our initia l 
display, the System Disk icon represents a physica l object. The 
Trash ico n represents a concept -- in this case, a n imaginary 
location in which to dispense of information which is no lo nger 
needed. 

The display depicted in figure 3.3 is known as the Desk­
top. The Desktop is the Mac's work area. The Desktop con­
sists of the white menu bar a nd the gray desk surface. The 
Mac's desk surface can be used as would an actua l d esk. 
Objects can be placed on the desk surface, moved a bout the 
desk surface, a nd removed fro m the desk su rface. We will see 
ho w to work with the Desktop later in this chapter. 
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The Keyboard 

The Mac keyboard resembles a typewriter keyboard in 
most respects. All letters, numbers, and special characters 
appea r in their usual places. The term "Caps Lock" replaces 
the usual "Shift Lock" but performs the same function for 
a lphabetic characters.The exceptions a re the keys surrounding 
the space bar: 

• Option 

• Command ( ~ ) 
• Enter 

The Command key is used in conjunction with specified 
cha racters as a substitute for the mouse. Many of the me nu 
options appear accompanied by the Command symbol and a 
letter. Pressing the key while typing the letter will ca use the 
sa me result as selection with the m ouse. 

The Enter key is used in special cases to enter computer 
instructions while using certain Mac a pplications. In most 
cases it has no effect. 

The Option key helps expand the scope of the keyboard to 
include many commonly used scientific, foreign, and punctua­
tion characters, in addition to many specia l sym bols not 
included on the regular keyboard. The Key Caps option allows 
the operator t o display these symbols for review. The Option 
and Option with Shift characters appear in figu re 3.4 a nd 3.5. 
Some characters may not be available with all fonts. 



48 Macintosh Use~s Handbook 

Key Caps 

Figure 3.4. Optional characters 

Figure 3.5. Optional characters (with shift) 
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Ejecting the System Diskette 

Now that we know how to insert the System Diskette, let's 
learn how to eject it. There are two methods for doing so. One 
way is by pressing the Command key simultaneously with the 
E key. The Command key is located to the immed iate left of 
the space bar. Its key top is inscribed with the symbol ~ . 

In order to learn the second method of ejecting a diskette, 
we will first need to understand how to use the mouse. The 
mouse controls the arrow shaped pointer on the Desktop 
surface. The pointer can be moved by sliding the mouse across 
the working surface. Try sliding the mouse to the left. The 
pointer should also move to the left. If the mouse is slid to the 
right, the pointer will a lso move to the right. Notice that the 
pointer cannot be moved off of the Desktop surface. 

Move the mouse so that the pointer is positioned on the 
word "File" in the menu bar. Be certain the tip of the arrow is 
positioned in the white margin near the word "File." Then 
press the mouse button. The Desktop surface should appear as 
shown in figure 3.6. Notice that the contents of the File menu 
are displayed on the Desktop. The procedure we have just 
undertaken is known as pulling down the File menu. 

While pressing the mouse button, move the mouse so that 
the arrow is pointing to Eject in the File menu. Then release the 
mouse button. The System Disk will be ejected. 

Notice that certain menu selections are displayed in black 
while o thers are displayed in gray. Only those in black can be 
chosen. We will discuss this in more detail later in this chapter. 

If you pull down a menu and subsequently decide not to 
select an item from it, you can exit this situation either by 
moving the pointer outside of the area containing the selec­
tions a nd releasing the mouse button or by moving the pointer 
back to File in the menu bar and releasing the mouse button. 
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Figure 3.6. Desktop surface with Fi le menu opened 

You may have run out of room to maneuve r your mouse 
in the last exercise. You ca n solve this proble m by picking up 
the mouse and moving it to a new location on yo ur wo rking 
surface. Notice that whe n you pick up the mouse and move it, 
the a rrow on the Desktop remains in the same positi on. 

Icons 

So far we have exa mined only two icons, the System Disk 
icon and the Trash icon. Five genera l types of icons are used by 
the Mac. These are : 

• Disk icons 
• Applica tio ns program icons 
• Document icons 
• Folder icons 
• Mini-M ac icons 
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The symbols for these icons are depicted in figure 3.7. 
Disk icons are used to represent the contents of a disk. 

The System Disk icon is an example. Applications program 
icons are used to represent an applications program used by 
the Mac. The Font Mover™ icon is an example. Document 
icons are used to store documents created by applications 
programs. We will encounter documents when we begin using 
MacWrite and MacPaint. Folder icons can be used to store 
applications programs and / or documents. A special folder, the 
System Folder, is used to hold system programs that the Mac 
requires in order to operate. These systems programs are 
represented with the Mini-Mac icon. 

oO E (g 
5'11s1tm F oldtr Systtm 

a. Disk: b. Applications program: c, Document: d. Folder: e, Mini-Mac 

Figure 3.7. Icon symbols 

SELECTING AN ICON 

Selecting an icon can be defined as designating it for some 
subsequent action. No action can be undertaken with an icon 
unless it has first been selected. 
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The icons* currently selected are displayed in black on the 
Desktop surface. Notice from the Desktop that the System 
Disk icon is selected. An icon can be deselected by movi ng the 
pointer outside the icon and pressing the mouse button. Try 
this. The Desktop should resemble that shown in figure 3.8. 

To se lect an icon, move the pointer onto that icon and 
press the mouse button. Experiment by selecting and deselect­
ing the Trash icon. 

Two or more icons can be selected simultaneous ly. This is 
accomplished by using the mouse to surround the icons to be 
selected with a rectangle. This procedure is best lea rned with 
an example. Assuming both the System Disk and Trash icons 
have been deselected , move the pointer just above and to the 
left of the System Disk icon. Press the mouse button and hold 
it down. Move the pointer to the right unti l it is positioned just 
beyond the System Disk icon. 

Notice that a line is displayed on the screen wh ich traces 
the pointer's path. Move the pointer down a long the screen's 
rightedge until it is located just beneath the Trash icon. Notice 
that a rectangle is drawn on the Desktop surround ing both 
icons. This is depicted in figure 3.9. Finally, release the mouse 
button. Both the System Disk and Trash icons will have been 
selected. 

• Several icons can be selected simultaneously. 
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Figure 3.8. Desktop with System Disk icon deselected 

Figure 3.9. Selecting two or more icons 



54 Macintosh User's Handbook 

MOVING AN ICON 

As we mentioned earlier, icons can be moved about the 
Desktop, just as objects can be moved about an actual desk. To 
move an icon , position the pointer with in the icon and press 
the mouse button. While holding the mouse button, move the 
pointer about the Desktop surface. Notice that an outline of 
the icon moves with the pointer. This is depicted in figure 3.10. 
When the mouse button is released , the icon will move from its 
original position to the position indicated by the outline. The 
procedure just described is known as dragging the icon. 

Figure 3.10. Moving an icon on the desktop 
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OPENING AND CLOSING AN ICON 

Generally, when an icon is opened, its contents are dis­
played on the Desktop in a rectangle known as a window. A 

window is depicted in figure 3.11. The window contents are 
known collectively as the icon's directory. The term directory 
is also used with many standard computer operating systems 
to d escribe a listing of the files resident on a diskette. 

An icon can be opened in two different ways. We will 
describe each method. We'll term the first method "File menu 

open," as it involves using the Open selection in the File menu. 
The first step is to select the icon to be opened. For our 
purposes, we will select the System Disk icon . Then , position 
the pointer to File in the white menu bar above the Desktop. 

iew Special 

CJ ~ 
System Folder LJ ~ 

Empt~ Foldfr Font Mover 

o, Window 

Figure 3.11. Opening the System Disk icon 
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Press the mouse button . The File me nu will be displayedjust as 
it was when we wanted to eject the System Disk. Move the 
pointer to Open in the File menu, and release the mouse 
button. An outline will leap out of the icon and fill the left side 
of the screen as a window. 

Notice that the System Disk ico n is no longer black, but is 
hollow. This indicates that it is open. 

Now that we have opened the System Disk icon, let's close 
it. There are two methods for closing an icon. We will term the 
method described here as "File menu close, "as we wi ll again be 
using the File menu. The method is simple. Pull down the File 
menu, indicate Close, and release the mouse button. The win­
dow will disappear from the screen and leap back into the 
System Disk icon. 

Now that the System Disk icon has been closed , it can be 
reopened usi ng the second method for opening a n icon. Since 
this method involves clicking the mouse button, we will term it 
"Clicking an icon open." Clicking ca n be defined a s pressing 
and releasing the mouse button. 

First, let's deselect the System Disk icon by moving the 
pointer outside it and clicking the mouse button. Next, move 
the pointer inside of the System Disk icon and press the mouse 
button twice. This is known as double clicking. If nothing 
happened, you probably did not press the button quickly 
enough the second time. Try again. The Desktop should 
resemble figure 3. 11. 

C lose the System Disk icon using the File menu close 
method. Notice that the System Disk icon is selected . Position 
the pointer on the System Disk icon and click the mouse 
button twice. Again, the System Disk icon will be opened. 

We a re now ready to learn the second method for closing 
an icon. In this method , the pointer is moved to a small square 
in the window's title bar known as the close box.This is shown 
in figure 3. 12. When the pointer is positioned within the close 
box, click the mouse button. The window will jump back into 
the System Disk icon. 
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CHANGING AN ICON'S NAME 

An ico n must be se lected in o rd er to c ha nge its name. To 
cha nge the selected icon 's na me, position the poi nter to the 
loca tio n where the cha nges a re to be made . Notice tha t the 
po inter cha nges fro m a n a rrow the symbo l, X. This symbo l 
ind icates that text ca n be ente red a t the indica ted posi tion on 
the Desktop. 

If the mo use butto n is pressed , a blin king vertica l ba r will 
a ppear underneath the X. This ba r represe nts the insertion 
point, whic h can be de fined a s the point where keyb oa rd 
entries will be added to text. Next , move the mouse so as to 
remove the X pointer. Text can now be add ed via the keyboa rd . 
Ex isting text ca n be erased by positioning the blinking inser­
tion poi nt after the character to be removed a nd pressing the 
Backspace key. 

The Edit menu comma nds ca n a lso be used to cha nge a n 
icon's name. These will be discussed la ter in this cha pter. 

-o SyJtem Dhk 

3 items 23SK in disk 164K available 

IQ1 
LJ ~ ~~ 

<~-~ 
System Fold£-r LJ '\. .... _ 

v 
Font Meover 

Empty folder 
~ 

~ ~ Q] 

Figure 3.12. System Disk icon window 
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Windows 

As evidenced in the last section , when an icon is opened, a 
window is often displayed on the Desktop. As we saw earlier, a 
window can be used to view the contents of an icon . Windows 
can be moved around the Desktop, their contents can be edited 
or scrolled through , a nd thei r size can be c hanged. We will 
discuss these va rious operations us ing the window created by 
opening the System Dis k icon. This window is depicted in 
figures 3.1 1 and 3. 12. 

EXAMINING THE WINDOW 

Examine the illustration of a wi nd ow in figure 3. 12. The 
bar alo ng the top of the window is known as the title bar. The 
title bar includes the close box, the t itle of the icon which the 
window is referencing, and an optional group of six parallel 
horizonta l lines. 

We will refer to th ese as active window lines. They indi­
cate which window is active . The Mac allows more tha n one 
window to be di splayed on the Desktop at the sa me t ime. 
When more than one window is displayed , the Mac needs to 
know which one the user is working with . This wi ndow is 
known as the active window. When an ico n is ope ned , it 
automatically becomes the active window. We will discuss the 
procedure for changi ng a window's sta tus to active later in this 
chapter. 

The bar immediately be low the title bar d isplays informa­
tion pertaining to the icon. In the System Disk icon example, 
we see that two items are stored in the icon; these items occ upy 
235K of disk space; and 164K of di sk space is ava ilable. 

The main portion of the window is used to display the 
icons stored in the icon that is open. From our example, we ca n 
see that the System Folder, Empty Folder, and Font Mover 
icons are stored in the System D isk icon. 
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The size box is located at the bottom right-hand corner of 
the window. As will be shown later in this chapter, the size box 
can be used to change the window's size. This has no bearing 
on the quantity of information which can be stored in a win­
dow's directory. 

The shaded bars with arrows at either end located on the 
bottom and right-hand side of the window are used to scroll 
through the window. In many instances, especially when work­
ing with document files, all of the information contained in an 
icon cannot be displayed in a window. The scroll bars allow the 
window to display different portions of the icon . 

CHANGING THE ACTIVE WINDOW 

As we can see from figure 3. 11 , when the System Disk icon 
is opened, its window is initially active. Notice that the active 
window lines are displayed in the System Disk window's title 
bar. Let's open the System Folder and Empty Folder icons as 
well. Our Desktop will resemble that depicted in figure 3. 13. 

Since the Empty Folder icon was opened last , it is cur­
rently active. We can change the active window by moving the 
pointer inside of the window we wish to be active and clicking 
the mouse button. Move the pointer inside the System Folder 
window and click the mouse button. As shown in figure 3.14, 
the System Folder window is now active. 
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·1 E it ew 

System Disk 

m= Empty Folder 
0 items 

Figure 3.13. Desktop with System Disk, System Folder, 
and Empty Folder icons open 

Fil Edit lliew 

System Disk 

Empty Folder 
0 ihms 

Figure 3.14. Desktop with System Folder window active 
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Notice from figures 3.13 and 3.14, that the active window 
is frontmost on the Des ktop. If we close the active window, the 
next window behind the frontmost window will become the 
active window. * 

Try this by opening the fo llowing icons in order: 

• System Disk 
• System Folder 
• Trash 

The Desk top will resemble that depicted in figure 3.15. 
By closing these icons in the following order, 

• Trash 
• System Folder 

we can see that the window behind the frontmost window is 
made active when the frontmost window is closed. 

Edit llieu• Special 

system Disk 

217K in foldor 

~ e SJ ~ ~ 
firoder lmo9e.,riter Note Pod rMe Clipboord f~t Scrapbook File 

Trnsh 
O items OK in Trosh 

Figure 3.15. Desktop with System Disk , System Folder, 
Empty Folder, and Trash icons open 

• This is true in most cases. 
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MOVING THE WINDOW 

A window can be moved around the Desktop by fo llow­
ing these steps: 

• Position the pointer within the wind ow's 
title bar. 

• Press the mouse button. 

• Move the mouse. An o utline of the window 
will follow. 

• Release the mouse button. The window will 
j ump inside the o utline. 

CHANGING THE WINDOW'S SIZE 

The size box at the window's lower right-hand corner is 
used to change its size. The proced ure for cha nging the win­
dow's size is as follows: 

• Position the pointer inside the size box. 

• Press the mouse button. 

• Expand or contract the outline of the win­
dow by moving the mouse. 

• Release the mouse button. The expanded or 
contracted window will jump into the outline. 

SCROLLING 

Scrolling can be defined as moving a document or a 
directory within the window so that its different areas can be 
examined. The scroll bar along the bottom and right-hand side 
of the window can be used to scroll. The sma ll white box along 
the scroll bar represents the current portion being displayed. 

To illustrate the use of the scroll bar, open the System 
Disk and System Folder icons. Then, rearrange the Note Pad, 
Clipboard , and Scrapbook icons so that they are directly 
beneath the System, Finder, and lmagewriter ico ns, respec­
tively. F inally, use the size box to reduce the size of the System 
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Folder window. The Deskt op sho uld resemble that de picted in 
figure 3. 16. 

The Mac a llows three methods of scroll ing. We wi ll re f er 
to these as: 

• Scroll by line 
• Scroll by window 
• D ragging the scroll box 

In the scroll by line method , scrolling ca n be acco mp­
lished slowly, line-by-line, by clicking the mouse button . T he 
po inter should be posit ioned within the scroll a rrow which 
indica tes the direct io n in which the scroll ing is to occur. As the 
mo use button is pressed , the informa tio n d isplayed in the 
window will be scro lled in the directio n indica ted . F igure 3. 17 
illustrates the scroll by line meth od. 

Fi e i t e 

System Disk 

Figure 3.16. Initial Desktop prio r to scrolling 
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Pointer positioned within scroll arrow 

File Edit Uiew Spet' - i 
System Disk 

Window contents after clicking mouse button 

Figure 3.17. Scroll by line 
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In the scroll by window method, the window ca n be 
scrolled to the end of the document or directory. The pointer 
should be positioned in the gray area on the scroll ba r. 

If the pointer is being positioned on the scroll ba r at the 
bottom of the window, a nd it is positio ned to the left o f the 
scroll box, scro lling will occu r to the left edge of the document 
or directory. Positioning the pointer to the right of the scroll 
box results in scrolling to the right edge . 

If the pointer is being positioned on the scroll bar a t the 
right-ha nd edge of the window, and it is positioned above the 
scroll box, scrolling will occur to the top edge of the directory 
or document. Positioning the pointer below the scroll box 
results in scrolling to the bottom of the directory or document. 
An example of scro lling by window is shown in figure 3. 18. 

System Disk 

Pointer positioned In gray area on scroll bar 

Figure 3.18. Scrolling by window 
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s File Edit Uiew Special 

System Disk 

Window contents after clicking the mouse button 

Figure 3.18 (cont.) Scrolling by window 

Dragging the scroll box a llows the user to scroll to a 
specific portion of the document or directo ry. In this met hod , 
the scroll ba r represents the length of the directo ry o r d ocu­
ment. By moving the scro ll box to the middle of the scroll ba r, 
the middle portion of the document will be d isplayed . T he 
scroll box is positioned by draggi ng it with the poi nter. An 
example of dragging the scroll box is conta ined in figure 3.1 9. 
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• File d" u·e 

System Disk 

Pointer positioned on scroll box 

i e E it Ui w 

System Disk 

Scroll box dragged so as to scroll to new information 

Figure 3.19. Dragging the scro ll box 
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Menus 

So far, we have learned quite a bit about the Desktop 
displayed when the System Disk is inserted. We have learned 

about icons and windows, a nd we briefly examined the File 
menu. We will conclude our examination of the System Disk 

and the Desktop by examining the various menu options 
avai lable in the menu bar. 

APPLE MENU 

The Apple menu is indicated by the -~ymbol in the menu 

bar. The Apple menu can be pulled down by pointing to the 9 
and pressing the mouse button. The Apple menu will appear as 

shown in figure 3.20. 
The first Apple menu selection, About the Finder, ca n be 

used to disp lay the version number of the Finder. The remain­
ing menu selections indicate the various Desktop Accessories. 
These will be explained in the fina l portion of this chapter. 

Scrapbook 
Alarm Clock 
Note Pad 

Figure 3.20. Apple menu 
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FILE MENU 

We have a lready see n how the File menu ca n be pulled 

down and Open a nd C lose selected from it to open a nd close 
icons. Now, we are read y to examine the o the r Fi le me nu 

comma nds. 

First of a ll , notice tha t certa in me nu comma nds are high­

lighted , while o the rs a re d immed . The highlighted co mma nd s 

ca n be selected , while the dimmed commands ca nno t be 

selected . The various combina tio ns of d immed a nd highligh­

ted comma nds will be determined by the ico n(s) currently 

highlighted . If the icons selected disallow certa in me nu com­

mands, these will be dimmed . Fo r example, if the Desktop 
a ppears as depicted in figure 3.21, t he only F ile me nu 
com ma nds ava ila ble will be: 

• Open 
• Get Info 
• Eject 

T he reason why onl y these commands ca n be selected is 
tha t the other commands will no t apply whe n the D esktop is 

configured as shown in figure 3.21 . 
The System D isk icon cannot be d upli cated. The icon 

canno t be put back. It ca nnot be closed , as it has no t yet been 
ope ned . F ina lly, t he System D isk ca nno t be print ed . There­
fore, the D upl ica te, Pu t Back, C lose, C lose All, and Print 

commands d o no t a pply in this situation a nd a re dimmed. 
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Figure 3.21. Des ktop with System Disk icon selected 

As discussed earlier, the File menu's Open and Close 

commands a re used to o pen a nd close a n icon . Du plicate 
ca uses a copy of the selected icons to be placed on the disk 
curre ntly in use. The d uplicated icons are assigned the same 
name as the original with the prefix "Copy of. " 

For exa mple, suppose that the Desktop a ppea red as 
shown a t the top of figure 3.22. Notice tha t the docu ment icon, 
Memo 4-28, has been selected . If Duplicate is executed, th is 
icon will be d uplicated as shown at the bottom of fi gure 3.22. 
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llMM 

Desktop before execution of Duplicate command 

Desktop after execution of Duplicate command 

Figure 3.22. Duplicate command 
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The Get Info command causes a window to be opened for 
the selected icon which disp lays the following information: 

• Type (disk, application, document, fo lder) 

• Size 
• Where it is located 
• Application which created it (document only) 
• Date created 
• Date last changed 
• Locked or unlocked (applies to disk only but is always 

shown) 

The Get Info window for the Memo 4-28 document icon is 
displayed in figure 3.23. 

The Put Back command is used to return any selected 
documents, applications, or folders to the disk or folder from 
which they came. We will use the following example to illus­
trate Put Back usage. 

Kind: 

Size: 

Where: 

Memo 4- 28 

MacWrite document 

1169 bytes, occounts for 2K on disk 

Misc Disk, internal driue 
c:reotea: soturaoy, Rprll 28, 1984 at 12::14 PM 

Modified: Saturday, Rpril 28, 1984 ot 12:54 PM 

D Locked 

Figure 3.23. Get Info window 
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CJ CJ ~ 
Sojsttm foldtr Empty f oldtr Moc\lnt• 

i) --
Docum•nt 

I ~ I 
RtsllM Pr090sol Homo 4-28 

~ iJ iJ ~ 
Copv of Rtsumt Copy of Proposol COP<J of Mtmo 4-28 

Figure 3.24. Original Desktop configuration 

Suppose that the Desktop resembled tha t shown in figure 
3.24. If the duplicated icons, Copy of Resume, Copy of Pro­
posal, and Copy of Memo 4-28, were placed in the Empty 
Folder, and that folder was opened , the Des ktop would resem­
ble that depicted in figure 3.25. 

If we next selected the three icons in the Empty Folder 
icon and executed the Put Back command, the Copy of 
Resume, Copy of Proposal, and Copy of Memo 4-28 docu­
ment icons would be returned to the Misc Disk icon. This is 
shown in figures 3.26 and 3.27. 



7 4 Macintosh User's Handbook 

; -. ; 
Copoj oi Resume Copoj of M•mo 4-28 

Bl 
8 

CoP\j of Proposol 

Figure 3.25. Desktop after ico ns copied to Empty 
Folder icon 

iill!D&m& 

Figure 3.26. Execution of the Put Back command 
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Document 

~ . . 
COf>ll of Proposal 

Figure 3.27. Desktop after execution of the Put Back 
command 

The Close All comma nd closes all windows to their icons, 
one by one. Suppose that both the Empty Folder and Misc 
Disk windows were open as shown in figure 3.28, a nd the Close 
All comma nd was executed as shown in figure 3.29. Both 

windows would be closed as shown in figure 3.30. 
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~ 
~ 

CopoJ of M•mo 4-28 

~ 
Cop<J of Proposal 

a. Misc Disk Window 

Figure 3.28. Desktop with Misc Disk and Empty Folder 
windows 

~ • . 
Copoi of Rtsumt 

Figure 3.29. C lose All comma nd executi on 
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Figure 3.30. Desktop after Close All command execution 

The Print command results in the contents of the se lected 
document icon being o uptut to the printer. Before a document 
is printed, the application under which it was c reated must be 
loaded. Therefore, that application must reside on a disk 

whose icon is represented on the Desktop. The same printing 
procedures required in the application must be observed when 
the Print command is executed. 

Suppose that the Desktop appeared as shown in figure 
3.31. If we selected Print from the File menu as shown in figure 
3.32, the MacWrite print specifications will be disp layed as 
shown in figure 3.33. The MacWrite print specifications 
appear because Memo 4-28 was created under MacWrite. 
After OK has been chosen in the Mac Write print specifica­
tions, the contents of Memo 4-28 will be output to the printer. 
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~ --D D ~ 
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Re sum• Proposal 

Figure 3.31. 

Close 
Close All 

S\I --------
F jec t 

Doeum•nl 

I 
llt!MIM 

Original Desktop prior to Print command 

Document 

...... 

Figure 3.32. Desktop when the Print command is 
selected 
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Figure 3.33. MacWrite print specifications 

The final File menu command, Eject, is u sed to eject the 
selected disk or the disk represented by the active window. If 
the Desktop appeared as shown in figure 3.31 , Misc Disk 
would be ejected. As shown in figu re 3.34, once a disk has been 
ejected , both the disk's icons and icons contained in that disk 
will be dimmed on the Desktop as an indication that they 

cannot be accessed . 
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II @fill ~ 
Sojs ltm Foldt r Empt~ Foldtr Moc'w'r ilt 

It 

I . 
. 

Resume 

[fil§ 
~ 

Proposal 
I 

Mtmo 4-28 

I 
Documtnt 

Figure 3.34. Deskto p after Misc Disk has been ejected 

EDIT MENU 

The selections available in the Edit me nu a llow editing of 
the following types of information: 

• Names of icons 
• Tex t portion of an information wind ow* 
• Text or pictures in a desk accessory 

• An info rmation window can be defined as the window displayed when the Fi le 
menu's Get Info comma nd is executed . 
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Whe n the Edit menu is pulled down, the following Edit 
commands will be displayed : 

• Undo 

• Cut 
• Copy 
• Paste 
• Clear 
• Select All 
• Show Clipboard 

In order to illustrate usage of the Edit menu commands, 
we will undertake an actual exercise in ed iting. Since we are 
already fam iliar with the information window, let's practice by 
editing the text portion of the information window for the 
Memo 4-28 document icon. 

Suppose that Memo 4-28's info rmation window appeared 
as depicted in figure 3.35. Notice the bli nking vertical bar in 
fro nt of "This" in the text wind ow. This is known as the 
insertion point. The inse rtion point marks the posit ion where 
text will be inserted whe n keyboard entries are made. 

Suppose we decided to delete the following phrase: 

confusion regarding the observance of the 

Our first step is to select the portio n of the text to be 
deleted . Text is selected by positioning the insertion pointer to 
the beginning point, pressing the mouse button, a nd dragging 
across the text to the ending word. Once the text to be edited 
has been selected, the Desktop should resemble that shown in 
figure 3.36. If too much text was initia lly selected, the text ca n 
be cleared by moving the pointer outside the selected area and 
pressing the mouse button. 
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Kind: 

Size: 
Where: 

crea ted: 

Modified: 

~ Lotked 

Memo 4-28 

Mat Write document 

1447 bytes. accounts for 2K on disk 
Misc Disk, internal driue 
Saturday, Ap ril 28, 1984 at 12:54 PM 

luesday, May B, 1984 at 9:21 AM 

flhis memo r elates to the confusion r egarding the 
I obseruance o f the Memorial Day holiday. We'll be 
! obsensing the holiday on Monday no t Thursday. 

Figure 3.35. Memo 4-28's info rma ti on window 

Memo 4-28 

Kind: MacWri t e document 

Size: 1447 bytes, accounts f or 2K on disk 

Where: MiH Disk. interna l driue 

Cr eated: Saturday, April 2B. 1984 at 12:54 PM 
Modified: Tuesday, May B, 1984 at 9:21 AM 

::J Locked 

confusion regarding the i Thi ~ memo relates to the I Memorial D11y holiday. We'll be 

1 obseruing the holiday on Monday no t Thursday. 

Figure 3.36. Desktop after selectio n of text for deleti on 
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The selected text can be removed by executing either the 
Cut or the Clear commands from the Edit menu. 

The Cut comma nd ca uses the selected info rmatio n to be 
removed and placed o n the Clipboa rd . Any info rma tion which 
had previously ex isted on the Clipboard will be replaced by the 
new copy. Figure 3.37 shows the Deskto p a fter Cut has been 
executed. Notice that the selected text ha s been deleted . By 
executing the Show Clipboard command from the Edit me nu , 
you will be able to verify that the selected text was placed on 
the Clipboard. The Clipboard is depicted in fi gure 3. 38. 

The Paste command can be used to place the informa tion 
in the Clipboard back at the insertion point. Suppose that we 
had moved the insert ion po int to the end of the text in Me mo 
4-28's information wind ow. If we then executed Paste fr om the 
Edit menu, the Desktop would appear as shown in figure 3.39. 

~O .............. ~ Information about Memo 4-29 

Memo 4-29 

Kind: MatWrite document 
Size: 1447 bytes, accounh for 2K on disk 
Where: Misc Disk. internol driue 

Crea ted: Satur day, April 29. 1984 at 12:54 PM 
Modified: Tuesday, May 8, 1984 at 9:2 1 AM 

O Lorked 

Bl 
~ 

This memo r elates to the Memoriol Doy holidoy. 
·be obseruing the holidoy on Mondoy not Thursday. 

Figure 3.37. Desktop a fte r execution of the Cut comma nd 
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Memo 4- 28 

Kind: MatWrite documen t 

Size: t 4·'7 bytes, accounts for 2K on disk 
Where: Misc Disk, Internal driue 
Created: Saturday, April 28. I 984 at 12:54 PM 
Modified: Tuesday, May 8, 1984 at 9:21 AM 

O Locked 

Clipboard 
confu~ion regarding the obseruance of the 

Figure 3.38. Clipboard after execution of the Cut command 

We can again delete the phrase, "confusion rega rding the 
observance of", using Clea r. Befo re d o ing so, let's first empty 
the Clipboard. Notice from figure 3.39, that the insertion point 
is at the end of the text, a nd no text is selected . Remember from 
our definition of Cut that execution of that command ca uses 
the selected text to replace the existing Clipboard contents. 
Since no text is currently selected, by executing Cut when the 
Desktop resembles that shown in figure 3.39, the Clipboard 
should be cleared. T his proced ure is depicted in figure 3.40. 

Now, Jet 's remove the phrase, "confusion regarding the 
observance of", without placing a copy on the Clipboa rd by 
selecting that text and executing the Clear command. 

The Desktop will again appear as shown in figure 3.37 
a fter Clear has been executed. By executing the Show Clip­
board command, you ca n verify that the deleted phrase was 
not copied to the Clipboard. 



lt Memo 4-28 

Kind: MacWrite document 
Size: 1447 bytes, accounts for 2K on disk 

Where: Misc Disk, internal dr iue 
Created: Saturday, Rpril 28, 1984 at 12:54 PM 
Modified: Tuesday, May 9, 1994 at 9:21 RM 

0 Locked 

This memo relat es to the Memorial Day holiday. 
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be observing the holiday on Monday not 
Thursday.confusion regarding the obseruance of the I 

Figure 3.39. Desktop after execution of the Paste command 

The Copy command places a copy of the se lected text on 
the Clipboard. Unli ke Cut , the original information will not be 
removed. However, as was the case with Cut, execution of the 
Copy comma nd resul ts in previous Clipboard informat ion 
being erased. To illustrate the use of Copy, let's select all of the 
text in Memo 4-28's informa tion window a nd execute Copy as 
shown in figure 3.41 . By executing the Show Cl ipboard com­
mand , you can verify tha t the text has been copied to the 
Clipboard. 
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c 

:0 

Memo 4-28 
Cleor 

Kin S(Jf(;( t IHI :;[:II cument 
Size ----········ .. -··---·-·--·--·-- accounts for 2K on disk 
Whe Show Clipboord t ernol clriue 
Crea ted: Saturdoy, Rpril 28, 1984 at 12:54 PM 
Modified: Tuesday, Moy 8, 1984 ot 9:21 RM 

D LOCkeCI 

This memo relates to the Memorial Day holiday. 
be obseruing the holiday on Monday not 
Jhurscloy.confusion regarding the obseruonce of the I 

Clipboard 

Figure 3.40. The clipboard is cleared after Cut is 
executed with no text selected 

'2l 
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Kin cumcnt 

Size _ accounts fo r 2K on disk 

Whe Show clipboard t ern al driue 
Createcl : Salurclay, April 28. 1984 at 12:54 PM 

Modified: Tuesclay, May 8, 1984 at 9:2 1 AM 

O Lockecl 

Clipboard 

Using the Finder 87 

mis memo relates to me Memor1a1 Day no11oay. We'll oe 
ooseruing me no11aay on Monaay not mursaay. 

Q] 

Figure 3.41. Execution of Copy results in selected text 
being copied to the clipboard 

The Edit menu's Undo command causes the reve rsal of 
the editing operation last executed in a desk accessory. The 
Select All command causes all icons in the active window to be 
selected. 
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VIEW MENU 

The View menu a llows the directories of disks and fo lders 
to be displayed in a number of different formats. These for­
mats include: 

• Icon 
• Name 
• Date 
• Size 
• Kind 

We have a lread y seen how a di sk or folder's directo ry can 
be displa yed using icons arranged in a window. This method is 
depicted aga in in figure 3.42. 

A folder or disk 's directory can a lso be displayed by name. 
In this window, the na mes of the va ri ous icons includ ed in the 
folder or disk will be displayed alphabetically by icon name. 
The directory window by name for the Misc Disk icon is 
depicted in figure 3.43. 

D Misc Disk 
290K in disk 109K available 

~ 
Moc'w'rite 

0 0 
Sy stem Folder Empty Folder Document 

.'1 Jil I 
Memo 4- 28 

Figure 3.42. Contents of Misc Disk displayed by icon 
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§0 Misc Disk 
Siu Nam• Kind Last Hodifi'd 

2K Docum,nt MocW'rite document Sot, Apr 28 , 1984 [21 
6K Emptlj Fold'r folder Tut, Moy 8, 1984 

53K Hac..,rit• application Tue, Jon 24 , 1984 

2K H'mo 4-28 MocW'rite document Tue, Moy 8, I 984 

2K Proposal MocW'rite document Sot , Apr 28, 1984 

2K R'sume Mocw'rite document Sot , Apr 28, I 984 

219K Systu11 Fold'r folder Sot, Apr 21, 1984 

i 
I 
~ fO 

12.I !Qt~ 

Figure 3.43. Directory window by name for Misc Disk icon 

The Date command displays the various icons in the order 
in which they were last modified. As shown in figure 3.44, the 
icon most recently modified is displayed first. 

§0 Misc Disk 
Siu Nam• Kind Last Modifi•d 

2K M'mo 4-28 MocW'rite document Tue, Moy 8, 1984 ,QJ 
t •K Empty Fold'r folder Tut , Moy S, I 984 

2K Document MocW'rite document Sot, Apr 28, I 984 

2K Proposal MocW'rite do,urnent Sot , Apr 28, 1984 

2K R•sume MocW'rite document Sot , Apr 28, 1984 

219K Syst'm Fold'r folder Sot , Apr 21 , 1984 

53K Mac..,rit' application Tue , , Ion 24, 1984 

~ 
21 12 '2l 

Figure 3.44. Directory window by date for Misc Disk icon 
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:o Misc Disk 
Sin Namr Kind Last Modlfird 

219K Systrm Foldrr folder So\, Apr 21, 1984 [Ql 
53K MacYrltr opplico\ion Tue, Jon 24, 1984 

6K Empty Foldrr folder Tue, Moy 8, 1984 

2K Mrmo 4-28 Moc'vr'rite document Tue, Moy 8, 1984 

2K Document MocWrite document Sot, Apr 28, 1984 

2K Proposal Moc'vr'rite document Sot, Apr 28, 1984 

2K Rrsume MocWrite document Sot , Apr 28, 1984 

~ 
QI ]Q] Q:J 

Figure 3.45. Directory window by size for Misc Disk icon 

The Size command displays the icons in the directory 
window according to size. As shown in figure 3.45, the largest 
items are listed first. 

~o Misc Disk 
Sizr Namr Kind Lost Modifird 

219K System Foldrr folder Sot, Apr 21, 1984 [Ql 
6K Empty Folder folder Tue, Moy 8 , 1984 

53K MacYritr application Tue, Jon 24, 1984 

2K Memo 4-28 Moc'vr'rite document Tue, Moy 8 , 1984 

2K Document Moc'vr'rite documeni Sot, Apr 28 , 1984 

2K Proposal MocWrite document Sot , Apr 28 , 1984 

2K Resume Moc'vr'rite document Sot, Apr 28 , 1984 

IQJ 
lQI 12 Q:J 

Figure 3.46. Directory window by kind for Misc Disk 
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The Kind command groups the items in the directory 
window by type; docume nt, folder, o r a pplicati on . The direc­
tory window by kind is depicted in figure 3.46. 

SPECIAL MENU 

The Special menu contains the following commands: 

• Clean Up 
• Empty Trash 
• Erase Disk 

The C lean Up command can only be used when the By 
Ico n option in the View me nu is active. This command rear­
ranges the icons in the active window into orderly rows a nd 
columns. Clea n Up can a lso be used without a di rectory win­
d ow being open to rearrange the Deskto p. 

The Empty Trash comma nd can be used to erase any icons 
from the Trash ico n. 

The Erase Disk comma nd can be used to erase the con­
tents of a disk. Start-up disks ca nnot be erased. 

Desk Accessories 

As mentioned earlier, the various desk accessories ca n be 
accessed from the Apple menu. These ca n be accessed while the 
Desktop is active or while a n a pplications program is in use. 

As with any other window, the des k accessory window 
can be made active by clicking the mouse. It will automatically 
be active when chosen from the Apple menu. The accessory 
window can be moved by dragging its title bar with the mouse. 
An accessory wind ow ca n be closed by click ing the close box or 
by indicating the Close comma nd from the File menu. All desk 
accessories will a utomatically be closed when a n application is 
opened or closed or when a document is opened . 
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SCRAPBOOK 

The Scrapbook accessory provides an area in which fre­
quently used text or pictures can be stored. Pictures and text 
which have been stored in the Scrapbook can la ter be copied 
back into a document. The procedure for storing pictures and 
text in the Scrapbook is provided in chapters 5 and 6. 

The Scrapbook is depicted in figure 3.47. Notice the scroll 
bar at the bottom of the Scrapbook window. This allows the 
user to scroll through the Scrapbook's available pages. 

0 Scrapbook 

Use the Scroptiook to store a >toriety of text selections and picturto::: '1thich 
may be tronsftorred between oplicotfons. From the Edit menu, Cut or Copy on 
item from the Scrapbook, then Paste into on opplicotion document. 

11 of 5 M'WRT, TEXT 

Figure 3.47. Scrapbook accessory 
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ALARM CLOCK 

This portion of the Apple menu is used as a clock , alarm 
clock, and calendar. Unlike most other personal computers, 
the Mac's clock is powered by a battery. Until the battery runs 
out, there is no need to set the system date or time. Selecting 
Alarm Clock from the menu reveals the clock portion. To view 
or set the date, time, or alarm, click the small flag symbol in the 
right corner of the box. The window appears as depicted in 
figure 3.48a. This displays the date set mode. Notice that the 
calendar symbol in the center is highlighted. Clicking the 
alarm clock on the right gives rise to figure 3.48b. This is the 
alarm set mode showing the alarm time and the set switch . 
Figure 3.48b shows the set switch in the up and set condition, 
while figure 3.48c shows it in the down and unset condition. 
The time set option appears in figure 3.48d. 

In order to set the time , date, or alarm, position the 
pointer to the digits to be changed and click the mouse button. 
The indicated digits will be highlighted , the time will freeze, 
and arrows will be displayed as shown in figure 3.48e. Press the 
up arrow to increase the value of the highlighted digit. Press 
the down arrow to decrease the value . Click the mouse button 
outside the set area to set the new values. Alternately , select the 
digits, and then enter the new ones via the keyboard . Altering 
the time or date sets the time or date for the entire computer. 
With the alarm set, the Mac will beep once per day at the 
appropriate time. 

The time or date can subsequently be copied and pasted to 
other documents. The procedure is described in chapter 5. 
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a 

b 

c 

d 

e 

Initial display •• date set 
mode 

alarm set mode 

alarm unset 

time set mode 

time selection for setting 

-
D 1 :35:45 PM f 

5/ 31 / 84 

0 IIE"I ~ 
D 1 :34:32 PM t 

~) 12:30:00 PM 

(~) ~ • 
D !:~4:51 PM f 

(ii 12:30:00 PM 

(C) ~ • 
0 1 :35: t 9 PM t 

1 :35:19 PM 

0 t:~rn:18 PM ! 

1:&Ja:l5 PM (!) 

-~l 1 i ffi 

Figure 3.48. Alarm Clock accessory 
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NOTE PAD 

The Note Pad provides an area where the Mac user can 
keep notes which are separate from the document being 
worked on. The Edit menu commands ca n be used to copy text 
to and from the Note Pad. 

The Note Pad is depicted in figure 3.49. Notice the turned­
out corner at the left edge of the page and the page number. 
The Note Pad contains eight separate pages. The current page 
number is displayed as shown in figure 3.49. You can turn to 
the previous page by clicking the area depicted in gray in figure 
3.49. You can turn to the next page by clicking the turned-out 
corner. 

D Note Pad 

1 

Figure 3.49. Note Pad accessory 
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CALCULATOR 

The Calculator accessory can be used like a standard 
desktop calculator. The Calculator results can be copied to a 
document or to another accessory. Also, numbers from a 
document or accessory can be copied to the Calculator's 
display. 

The calculator is operated either with the mouse or by 
typing the appropriate entries on the keyboard. 

KEY CAPS 

When the Key Caps accessory is selected, the window 
depicted in figure 3.50 will appear on the Desktop. When the 
Key Caps window is active, text entered via the Mac's key­
board or by clicking the keytops in the window will appear in 
the blank line at the top of the window. 

Key Cups 

Figure 3.50. Key Ca ps accessory 
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CONTROL PANEL 

The Control Panel accessory, as depicted in figure 3.5 1, 
allows the user to control the following settings on the Mac: 

• Speaker volume 
• Clock 
• Command blinking 
• Rate of repeating keys 
• Keyboard touch 
• Rate of insertion point blinking 
• Mouse tracking 
• Desktop pattern 
• Double-click speed 

The speaker volume setting controls the volume of tone 
emitted by the Mac's speaker. The setting can be dragged up 
(higher) or down (lower). 

The clock can be used to set the Mac's system date and 
time. It operates exactly as did the Alarm Clock described 
earlier. 

A 
B 
5/11/84 

a, spea ker volume: b, clock: c, command blinking: d , rate of repeating keys: 
e. keyboard touch;/. rate of inse rtion point blinking; g, mouse tracking: 
Ii. desktop pattern; i, double-click speed 

Figure 3.51. Control Panel accessory 
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Command blinking refers to the number of times a com­
mand blinks when it is chosen from a menu. This can be set to 0 
(off), 1, 2, or 3 by clicking the mouse button. 

Rate of repeating keys a ll ows the Mac operator to change 
the rate at which a key will repeat when it is pressed. The higher 
the setting, the faster the keys repeat. 

Keyboard touch refers to the length of time a key must be 
pressed before it begins repeating. A high setting causes the 
keys to repeat when pressed for only a short period of time. A 
low setting means that the keys will have to be pressed longer 
to repeat. A setting of 0 causes the repeating feature to be 
turned off. 

Rate of insertion point blinking controls the rate at which 
the insertion pointer flashes. 

Mouse tracking controls the distance the screen pointer 
will move relative to the speed with which the mouse is moved 
on the desk or table surface. A setting of 1 causes the pointer to 
move farther as the mouse is moved faster. A setting of 0 results 
in the pointer's movement remaining independent of the 
mouse speed. 

Desktop pattern a llows the Mac operator to choose the 
background pattern to be used for the Desktop. The available 
patterns can be displayed by clicking the mouse in the white 
bar on top of the miniature window to the left. By clicking the 
right side of the bar, the next pattern will be displayed . Click­
ing the left side displays the previous pattern. When the desired 
pattern is displayed , move the pointer inside of the pattern and 
click the mouse button. The Desktop pattern will change to the 
se lected pattern. 

The double-click speed setting determines the speed with 
which the mouse button must be pressed in order for it to be 
interpreted as a double-click. The higher va lues require the 
button to be pressed quickly, while the lower values allow the 
button to be pressed more slowly. 
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PUZZLE 

The final Apple menu selection , Puzzle, results in a puzzle 
game being displayed. 



4 
Disk Operations 

Introduction 

In this chapter we will discuss the vari ous operations 
which pertain to the Mac's d isks and the da ta on them. The 
Apple Macintosh was designed to use custom-designed Sony 
3 Yi inch micro floppy disks. At the time of this writi ng, the 
disks were single-sided meaning that they hold data on only 
one side of the disk. At some later date, they will be expanded 
to double-sided increasing the sto rage capacity fro m 400K t o 
800K. 

The data o rdering of the Mac disks d iffers from normal 
floppy disks in two impo rtant ways, the density of infor mation 
placed on the disk surface and the disk rotatio n speed. Most 

101 
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disks are structured by placing data in magnetic form following 
a series of concentric circles around the disk. These circles are 
called tracks and act much like the tracks around a phono­
graph record. The Mac's disks can hold 80 tpi (tracks per inch) 
as opposed to the 70 tpi for the standard Sony 3 Yi inch 
diskettes. 

When loading data on a disk, most disk drives use one 
rotation speed and one data rate. Each track on the disk is 
divided into sectors each containing 512 characters. Since the 
rotation speed and the data rate are constant, the sectors near 
the edge of the disk are longe r than those near the center of the 
disk. This essentially wastes disk space. 

The Macintosh disk drive is designed to operate at varia­
ble speeds to allow it to record data on the disk with each sector 
having the same length . Rotation speeds range from 390-600 
rpm. When operating near the rim of the disk, the drive turns at 
a slower speed. When near the center, it rotates faster. 

Although this is a great help for the Mac in terms of data 
storage efficiency, it has the disadvantage that no other compu­
ter, with the exception of the Apple Lisa, can read the Mac's 
disks. Likewise, the Mac (or the Lisa) cannot read disks 
recorded on most other computer systems. 

Since the Mac's drives have been extensively tested and 
since they require few adjustments, the disk drive should oper­
ate fo r an extended period of time without the need for repair. 

Disk ejection is under the control of the Mac's software. 
Most other floppy disk drives allow the operator to remove the 
disk at any time. Placing the disk ejection under the Mac's 
control insures that the Mac will have the opportunity to 
update the disk before it is removed. Such updating might 
include Trash file removal, storage of display formatti ng, and 
proper file closure. 

In this chapter, we will outline the commonly used disk 
operations required when working with the Mac. Although we 
will make reference to the applications available on the Mac, 
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extensive discussions of them shall appear in following chap­
ters. We will learn to copy data from disk to disk. This will 
include both copying of the entire disk and individual disk file 
copying. We will also discuss the Font Mover application and 
see how it can be used to save disk space. In addition, we will 
discuss the procedure for saving data on disks and recovering 
data from faulty disks. The hierarchy of the Mac disks will also 
be discussed along with the various possible placements of files 
on more than one disk. 

When discussing copying of va rious icons, we will use the 
terms "source" and "target." The source refers to the disk or file 
which you want to copy from, while the target refers to the 
destination of the data. 

Disk Copying 

When working with a magnetic medium such as the Mac 
disks, it is always wise to have at least one copy of important 
data on another disk in case one disk becomes unreadable. The 
disk containing the second copy of the da ta is known as the 
backup disk. There are two methods for copying an enti re 
disk's data t o another disk. The first is the normal procedure 
which requires no special software; the second is a n alternate 
method using a special application. 

DISK INITIALIZATION 

When inserting a new disk or a disk whose software has 
been irreparably damaged, the Mac will display a message 
informing the operator that the disk is unreadable a nd asking 
the operator if he or she wants to intialize the disk. All disks 
used on any computer must be initialized. Many computer 
manuals refer to this operation as formatting. 
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When instructed to initialize a disk, the computer will 
begin by reading every sector on the disk to check it for 
damaged sectors and erase any o ld data. Then it will place on 
the disk the essential information it needs to recognize the disk. 
In the Mac's case this will include the disk's name which the 
operator enters during the process. It will also include a folder 
entitled Empty Folder. This folder will be the basis fo r all 
folders on the disk. To create a fo lder for documents or other 
files, select the Empty Folder icon and select Duplicate from 
the File menu. A Copy of Empty Folder will appear. The 
operator can rename the folder as desired. 

NORMAL DISK COPY 

In order to copy the contents of one disk to another, 
simply move the source disk's icon to the target disk's icon. 
Make sure that the pointer moves to within the target disk's 
icon. At this point, the Mac will respond with a message as 
shown in figure 4. I. The purpose of this message is to allow the 
operator to change his or her mind and not perform the opera­
tion if desired. Click OK or Cancel as the case may be and the 
Mac will begin the copy sequence. The copy sequence will be 
performed by the Mac in the following manner. The Mac will 
load a portio n of the source disk's data into RAM. Then it will 
eject the disk and request the target disk. When the target disk 
is inserted, the Mac will t ra nsfer the data to the disk and then 
start the proced ure over again until the data has been copied. 

The operator should be prepared to remain at the compu­
ter for a few minutes. The Mac will request that the disk be 
switched ten or more times. When the operation is complete, 
the Mac will stop, and the Desktop will appear as before. Data 
in the source disk will also occupy the target disk. The names of 
all files, folders, and applications will remain as with the origi­
nal. The name of the target will be unaffected. 
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Completely replace contents of "Target 
Disk• (not in nny driue) with contents of 
· Source Disk• (internnl driue)? 

( Concel ) 

Figure 4.1. Copy option window 

THE DISK COPY APPLICATION 

The second method of copying disks is to use the Disk 
Copy application. If you have purchased this application, it 
will greatly increase the speed with which the procedure is 
completed. The application operates by transferring the data in 
four large chunks of data. With only 128K of RAM available, 
each JOOK chunk leaves only about 28K of extra memory. In 
chapter 1 we noted that the display requires 22K of RAM 
memory. As a result of the memory squeeze, the display will 
become garbled during the procedure. 

To operate the application, open the Disk Copy icon. The 
application will commence and a window will appear apprising 
you of the memory and display conditions described above. 
Select OK from this window, and the Mac will continue with 
the procedure. 

The instructions for the Disk Copy will appear in the 
lower part of the display. These will include requests for the 
source disk and the target disk. If the target disk is not initial­
ized, the Mac will do so automatically. If the target disk 
contains existing data, the Mac will ask permission to erase the 
disk. Each instruction or request box will contain a Cancel 
option to terminate the disk copy if desired. When the disk 
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copy is completed, the target disk will be identical to the source 
disk. With Disk Copy, the target copy's disk name will be the 
same as the source disk's name. 

No matter how you perform the data transfer procedure, 
it is more easily accomplished with the optional second disk 
drive. To utilize this capability, simply insert both disks and 
then use either of the previously described methods. 

DISK FILE COPY 

Now that we have a copy of the data disk, we can continue 
to use the original disk to change or add to the information 
upon it. When we have completed those changes, we will want 
to save the documents we have added or changed and record 
those changes on the backup disk. To do this we do not need to 
copy the entire disk. We need only to copy the files we want 
updated. 

The procedure is similar to that used with disk copying. To 
copy files, simply move the file icon or icons from the source 
disk icon to the target disk icon. The Mac will indicate the files 
remaining to be copied and will request disk switches until the 
operation is complete. If you are transferring a folder, the 
number of files remaining will equal the number of files within 
the folder. If there are files of the same name already residing 
on the target disk, the Mac will display a box asking if you want 
those files replaced. 

Be sure not to try to place the source disk's copy of a folder 
icon directly upon the target disk's copy of that same folder's 
icon. The Mac will interpret this as an attempt to place one 
folder within another folder of the same name. This action will 
be disallowed. 
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The Font Mover Application 

The Font Mover is an application which should be 
included on the Write/ Paint diskette. Its purpose is to a llow 
the operator to remove most of the font information from the 
System file. When it is not needed , the font information can be 
loaded into a special document and can be copied and held on a 
data disk. 

To use the application, copy it onto the disk from which 
you want to remove the font information. For the purpose of 
our illustration, insert a startup disk featuring the Font Mover 
into the Mac. Open the application icon. The window shown in 
figure 4.2 will appear. To move a font into the Fonts file, select 
the font by clicking on the font name in the left column. T he 
font name will become highlighted as shown in figure 4.3. T he 
font name, point size, disk memory size, and a sample of the 
font will appear in the lower portion of the window. Now select 
Copy and the font will appear in the right column. Notice that 
the arrows surrounding the word Copy point in the direction 
the copy will occur. To select more than one font , position the 
pointer on the first font in the list and drag to the last font in the 
list. The selected font names will become highlighted as shown 
in figure 4.4. Only the total disk size of the selected fonts will 
appear in the lower part of the window. When Copy is selected , 
the highlighted fonts will appear in the right column. 

To remove fonts from the System file, select the fo nt or 
fonts in the left column and select Remove. The fonts will 
disappear from the System file list. Note that the fonts which 
appear with an asterisk cannot be removed from the System 
file as they are essential to the Mac's operation. It would be 
unwise to remove a font from the System file without first 
transferring it to the Fonts file. 

The Mac will repeat these instructions when you select the 
Help option from the Font Mover window. To exit the Font 
Mover application, select Quit. The changes you have specified 
will be recorded, and the application will rewrite the System 
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file and create a Fonts document. 
To restore a font to the System file, use the same method as 

when moving a font to the Fonts file. Select the font to be 
moved, select Copy, and the font will appear on the System file. 
Note that no data transfer actually occurs until you Quit the 
application. 

Fon t Mouer 

in System file In Fonts file 

Rthens-18 \g ( Help ) 
* Chlcogo-12 

I~ *Geneuo- 9 [ ( 01>1.t ) 
Geneuo-12 
Geneuo-1 4 I ( B•~moue ) 
Geneuo- 18 
Geneun-24 Q] [ Quit ) 

Nome: 
Point size: 
Disk Space: 

• reserued for system use 

Figure 4.2. T he Font Mover window 

in System file 

Rthens-18 
*Chlcogo-12 

Font M'ouer 

in Fon ts file 
Help 

»Copy» 
··lllGelniZellluZ:nl-119•·•'1 I [ __ n_e0-:-:-tu_e~ Geneuo-14 

Geneuo-18 
Geneuo-24 

Nome: Geneuo 
Point size: 1 2 So mp le 
Disk Spoce: 2734 bytes 

• reserved f or system use 

Figure 4.3. Selecting one font name 

~ 

~ 
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Font Mouer 

In System me In Fonts file 
Rthens-18 Help 

»Copy» 

Remoue 

Geneuo-24 Quit 

Totnl spnce: 6302 bytes 

• reserued for system use 

Figure 4.4. Selecting multiple font names 

Now that you have reduced the size of the System fi le by 
removing unneeded information, you can move the Fonts doc­
ument to another disk for safekeeping. To reenter the Font 
Mover application, open either the application icon or the 
Fonts document icon. The Font Mover window will appear 
with the Fonts file information listed in the right column and 
the System file informatio n listed in the left column. 

SOME PRECAUTIONS 

There are a few precautions which you should take when 
using the Font Mover. Remember that the System file helps 
determine the overall operation of the computer. Do not inter­
fere with the Mac while the fi le is being rewritten. This opera­
tion may take a minute or more. Be sure that you have a spare 
copy of the System file on hand in case the Font Mover incor­
rectly rewrites the file. As mentioned earlier, never remove a 
font from the System file without copying it to the Fonts file. 
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When using an application such as MacWrite which is de­
scribed in the following chapter, the Font menu will display 
only those fonts which remain in the System file. 

Saving Data 

Even though the Mac's disks hold more than comparable 
disks used with many other microcomputers, they still provide 
a limitation to the file storage options available to the operator. 
For this reason the operator should develop a strategy regard­
ing the organization of information on the disks. 

DATA DISKS vs OPERATIONAL DISKS 

When utilizing the Mac's applications to create and mod­
ify numerous documents o n disk, the operator will soon find 
that one disk will not meet his or her needs. One solution to this 
problem is to determine o ne or more disks as data disks and 
keep one or two disks as operations disks. 

The term data disk refers to the information which is 
contained on the disk. A da ta disk conta ins only data files. 
Data fil es are simply applications documents. A data d isk has 
no sta rtup capabilities. It does not contain the System or 
Finder icons or any other Mini-Mac icons which the System 
file uses in its normal operation. It a lso does not contain a ny of 
the Mac's applications. T hese files can occupy the majority of 
the disk leaving little room for data files. Without the system 
information , a disk may hold 25 or more documents of various 
types and sizes. 

Operational disks contain the system startup information. 
They include the System a nd Finder icons a long with any other 
necessary Mini-Mac icons a nd the needed applications. Under 
some data handling methods, these disks may hold a few 
documents for a short period of time but the main source of 
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data is the data disk. An operations disk can hold only two or 
three documents at a time. Using the Font Mover to create 
extra disk space enables the operations disk to hold as many as 
four or five documents. 

The remaining free space on a disk is a potentially confus­
ing issue. Though a document may occupy only 10 or 12K of 
memory on the disk, the Mac may indicate insufficient disk 
space with as much as SOK or more of available free disk 
memory. This is due to the Mac's needs and the organization of 
data on the disk. 

You may define another class of disks as application disks. 
These disks hold the applications including those not presently 
in use. The applications occupy a large segment of the disk as 
do the system files. 

Using this method of file organization, normal operation 
might proceed as follows. First load the operations disk to 
startup the Mac. Then load the applications disk and copy the 
necessary applications onto the operations disk. Finally, insert 
the data disk and copy the needed documents onto the opera­
tions disk. 

When you have finished with one document or set of 
documents, copy them back onto the data disks and remove 
them from the operations disk. To remove a file from the disk, 
move its icon to the Trash icon. You may have to select Empty 
Trash fro m the Special menu to make room for the new files. 

OTHER DATA HANDLING METHODS 

Though it is always a good idea to maintain duplicates of 
each disk, it may happen that one disk appears to malfunction. 
As is so often the case, such a disk might be the only one with 
the updated version of a document. 
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The malfunctioning of a disk is usually not a physical 
issue. The Mac's disks are very sturdy and remain useful for a 
Jong time. The Mac might, however, damage the software on 
the disk through its normal disk operations. When this occurs, 
the Mac will most likely refuse the disk and display a system 
error message. When the message appears, the best option is to 
punch out the disk as described on page 300 of chapter 9, 
Troubleshooting and Operating Hints. Reinsert the startup 
disk and select Restart from the error message box. The Mac 
should restart normally. 

If you try to restart the Mac with the bad disk, the error 
will probably recur. If the disk was not a startup disk, the Mac 
will refuse it. Inserting a system disk at this point might result 
in a lockup situation. That is, the Mac will do nothing and will 
not return the disk. To cause the disk to eject, you can punch it 
out, or you can turn off the Mac. Then turn the Mac back on 
and press the mouse button. After a few seconds, the disk 
should eject. 

If the data disk software is damaged, the error will recur if 
the operator tries to reuse the disk. The procedure for accessing 
data on such a disk is outlined on pages 298-30 I of chapter 9. 
We feel that the best method is to insert the disk and press and 
hold the Command and Option keys. This command forces the 
Mac to read the disk. 

USING THE OPTIONAL SECOND DISK DRIVE 

The optional second disk drive can make data handling 
much easier.Normal operations with a second drive available 
might proceed as follows. Turn on the Mac and insert the 
operational disk into the main disk drive. Then insert the 
applications disk into the optional disk drive a nd copy the 
applications, which are appropriate to the day's work, to the 
operational disk. Then eject the applications disk, insert the 
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data disk into the second drive, and copy the necessary file to 
the operational disk. 

This last step is only a time saving measure. The Mac can 
manipulate the two disk drives to utilize both the data on the 
data disk and the operational disk to perform the required 
functions. This will take only a small amount of additional 
time. 

Data copying with the second disk drive is simplified as 
well. Simply insert the source disk into one drive and the target 
into the other drive. Perform the data copying icon manipula­
tions, and the Mac will handle the rest. 

Disk Hierarchy 

The Mac treats the disk icon on the Desktop differently 
than any other icon. This is primarily because the disk icon is 
the only one we have seen so far which represents some physi­
cal object. The other icons represent memory locations either 
on a disk or in the Mac's internal memory. In this section we 
will discuss the importance that the Mac's places upon each 
disk icon. With the Mac disks, the hierarchy is similar to the 
hierarchy within a kingdom. The Mac considers one disk to be 
the King, or System disk. All the others are the subjects, or 
Alternate disks as we will call them. As is so often the case in 
the world, we will see how a subject can overthrow the king or, 
in our terminology, how an Alternate disk can become the 
System disk. We will also see how an Alternate disk can be 
banished to the Trash icon. 
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SYSTEM AND ALTERNATE DISKS 

In order for a disk to be a System disk, it must contain the 
system information. That is, it must contain the System and 
Finder icons. When the Mac is first turned on and a startup 
disk is inserted, that disk will become the System disk for the 
computer by default, since there is no other disk to command 
the Mac's attention. We will assume that the startup disk 
features the MacWrite application. Try this on the Mac. Notice 
that the System disk icon appears at the top of the display 
directly above the Trash icon. We shall call this position the 
Controlling Slot. Its importance is to the System disk what a 
throne is to a king. 

While no other disk is inserted into the Mac, the first disk 
will remain the System disk. No matter what operations we 
perform with the System disk, it will always remain in com­
mand. Let's try some operati ons with the System disk icon. 
First, let's try dragging it to the Trash icon. As with any good 
king, the System disk icon is safeguarded against disposal. The 
Mac may display a message indicating that the startup disk 
may not be thrown away. Let's try selecting Erase Disk from 
the Special menu. Foiled again! A message appears disallowing 
the erasure. As long as the disk is the System disk, its system 
files may not be tampered with in any way. We may perform 
normal operations with the disk, utilize applications, create 
documents, and manipulate icons. We may not throw away the 
System or the Finder icons while the disk remains in charge. 

Try moving the System disk icon about the Desktop. As 
long as we do not move it to the Trash, there is no objection. In 
this case the king remains the king even though he does not 
occupy the throne. The Mac still recognizes the disk as the 
System disk even though it does not occupy the Controlling 
Slot. Return the System disk to its original position and select 
Clean up from the Special menu. 
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CHANGING THE DISK HIERARCHY 

Now we will complicate the scene. Either eject the System 
disk and insert a data disk, or insert a data disk into the second 
disk drive. This disk, like a proper subject of the k ing, can never 
be a pretender to the throne since it lacks the system informa­
tion required of the System disk. The Mac considers it to be an 
Alternate disk. We may perform any needed alterations to this 
disk with no restrictions, as long as we are prepared to accept 
the consequences of altering its files. We may even erase this 
disk if desired. The Erase Disk command will cause the Mac to 
display a message asking the operator if he or she really intends 
to erase the information on the disk, but the action will not be 
disallowed. 

One qualification to this is that no disk may be altered in 
any way as long as the red tab is moved away from the write 
protect hole in the disk casing. Figure 4.5 shows the red tab in 
the locked (a) and unlocked (b) positions. 

B 

© 

Figure 4.5. Disk write protect. a. Locked position; 
b. Unlocked position. 



116 Macintosh User's Handbook 

Let 's try another experiment with the Alternate disk. Try 
to drag its icon to the Trash icon. When the mouse is released, 
the icon outline will return to the disk icon. No disk presently in 
a disk drive may be discarded . 

Now that we have finished with the data disk, eject it.Now 
try dragging the disk's icon to the Trash. The icon disappears. 
Open the Trash icon and yo u will see that the Alternate disk's 
icon does not appear there. The subject disk has been banished 
from the kingdom and can only return if it is reinserted into the 
disk drive. The portion of the Mac's RAM which enables it to 
recognize the Alternate disk has bee n erased. In effect, the Mac 
has forgotte n about the disk. 

Insert the disk into the Mac's disk drive. This disk should 
be a sta rtup disk li ke the System disk, and it should feature the 
applications which we will need for o peration. For our demon­
stration, insure that both the System and this latest disk con­
tain the MacWrite application. The disk icon appea rs in the 
position immediately below the System disk. 

This disk has the capacity to overthrow the king and 
occupy the Controlling Slot. For now, however, it acts as did 
the previous subject disk. You can erase the system information 
on the disk if you want. Such an attempt will cause the Mac to 
display a box asking you if you really want to delete system 
information. Selecting OK in this box will a ll ow the act ion. Do 
not do so at this time. 

There are two ways in which the System disk may be 
overthrown by another qualified disk. To demonstrate the first 
method, open the M acWrite icon residing in the newest disk. 
Any Mac application would serve our purposes in this 
insta nce. We will not operate MacWrite at this time, so do not 
be concerned as t o its functions. When the M acWrite docu­
ment has appeared, select Quit from the File menu. When the 
Deskto p reappears, the second disk will now occupy the Con­
trolling Slot , and the fi rst disk will not appear. In effect, the 
newer disk has overthrown the older one a nd assumed the 
throne. The old king has been banished. 
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What probably happens when this procedure is performed 
is that the application is loaded into the Mac's RAM. Applica­
tions generally occupy a large portion of memory. The result is 
that the portion of the RAM which holds the disk recognizing 
information is written over by the application. 

If we were to open a Mac Write document from the second 
disk while it was still an Alternate disk, the Mac would load the 
MacWrite application from the System disk. In this case the 
System disk would not be replaced. In fact the Alternate disk 
would be banished when we returned to the Desktop. 

The second method of changing the disk hierarchy is to 
turn off the Mac. When that occurs, the RAM is erased. Now, 
when the Mac is turned on again, the first system disk to be 
inserted will assume the throne and become king. 

Data Placement Strategies 

Due to the limited size of our magnetic medium, we can­
not indiscriminately load data, system files, and applications 
on any disk and expect smooth, efficient operation. Develop­
ing a sound data handling strategy will greatly aid the Mac's 
efficiency. In this section we will review some of the various 
data placement options and the advantages and disadvantages 
of each. The basis for our discussion will be, as before, the 
concept of operational disks, data disks, and applications 
disks. 

SINGLE DISK OPERATION 

In one of the previously discussed scenarios, we used the 
operational disk as the working disk. Under this organizational 
strategy, we place the needed applications upon the operations 
disk and use all other disks as holding areas for unused data 
files. 
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With this placement technique, you might start the day by 
inserting the operations disk into the Mac. If you need to use 
both Mac Write and MacPaint to create a document with both 
graphics and text, copy those applications onto the operations 
disk. Since both a pplications together occupy about I 13K or 
28% of the disk space, you may wish to use the Font Mover to 
remove unneeded fonts from the System file. Let us use this 
application to remove the following fonts and point sizes and 
place them onto a Fonts file: 

• Athens 18 

• Geneva 12, 14, 18, 24 

• San Franscisco 18 

• Toronto 8, 12, 14, 18, 24 

• Venice 14 

The Fonts file for these fonts takes up about 53K of disk 
memory. Copy the Fonts onto one or two data disks, move the 
operations disk copy of the Fonts file to the Trash, and select 
Empty Trash. We have created 53K of extra disk memory on 
our operations disk. Under these conditions we have room for 
five or six documents with which we can work. 

Now use the data disk to copy any needed documents onto 
the operations disk. We have set up a situation where all 
needed information now resides on one disk. The advantage to 
this is that we do not need to worry a bout working with two or 
three separate disks when operating the Mac. When opening 
an application, the data disk and applications disk will be 
erased from RAM. When using the computer, the needed files 
will all reside on one disk. We may create documents, edit other 
documents, and print them with no need to refer to other disks. 

The disadvantages to this data handling method are 
mostly a matter of convenience. First, the operator may find it 
tedious to copy the document to the operations disk, then 
recopy updated versions back to the data disk. If the operator 
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must work with several large documents in succession, there 
may not be sufficient space on the disk for all the files. In 
addition, the operator may need the fonts which we removed 
from the System file. With the System file at normal size, 
sufficient room may not be available for the required 
documents. 

DOUBLE DISK OPERATIONS - USING THE DATA 
DISK AS A REFERENCE 

In response to the problems encountered with the pre­
vious data ordering method, the operator might consider using 
two disks in normal operation. When the Mac owner uses the 
optional second disk drive with the Mac, this provides no 
additional inconvenience. With this method , we will use o ne 
disk as the operational disk featuring the system information 
and the applicati ons. The second disk will conta in the data and 
will be the sole resource for documents. 

To use this method , start up the Mac with a System disk. 
Then insert an applications disk and copy the needed applica­
tio ns to the System disk as you did in the previous section . 
Eject the applications disk and insert the data disk. Now, 
instead of copying the data onto the System disk, open the icon 
for the des ired document. T he Mac will eject the data disk a nd 
will accept the System disk aga in to load the Mac applications. 
Then the Mac will require one or more disk switching opera­
tions while the document is loaded into memory. Now, you 
may perform the modifications upon the document. We are 
assuming that the data disk is, as described earlier in this 
chapter, void of system information and cannot become the 
System disk. The disk hierarchy should not change. 

The advantage to this technique is that the size and 
number of the documents is limited only by the available space 
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on the data disk. This can be many times the document han­
dling capabilities of the System disk. You can work with any 
number of documents on the data disk as long as they all fit on 
that disk. This method is very convenient when you only need 
to review one or two documents and will be making few if any 
revisions to a document. It is also preferred if you are using the 
optional second disk drive. Another advantage is the expan­
sion of available disk space. Since we need not copy and erase 
documents from various disks, we are not concerned about the 
limits on free space on the System disk. 

The disadvantages to this method apply primarily to the 
single-disk-drive Mac user. The tedious task of repeatedly 
switching disks to load applications and documents and to save 
revisions makes this method intolerable if you plan to make 
repeated revisions to several documents. Be careful of the disk 
hierarchy when using applications under this data handling 
scheme. Creating a new document will banish the data disk and 
put the new document on the System disk. 

Another possibility when using two disks is to place the 
applications on the data disk. There is little, if any, advantage 
to this since at least as many disk switches are required. This 
method also sacrifices a portion of the free disk space on the 
data disk with little increase in efficiency. 

USING THREE DISKS WITH A SINGLE DRIVE 
(Not Recommended) 

Adding a third disk in the operation of the Mac compli­
cates the issue tenfold. Let us set up another scenario. Startup 
the Mac with a startup disk which does not contain the Mac­
Write application. If necessary, discard the application from 
the System disk. Be certain that you have a copy of Mac Write 
on another disk.Now set up a disk with Mac Write on it. This 
disk should not contain system startup information. Thirdly, 
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select a disk with data files on it. This disk should contain 
neither MacWrite nor system files. 

We are setting up this example to show you what not to do 
when dealing with the Mac. Start up the Mac with the first 
disk , then insert the applications disk, and then insert the data 
disk. The Mac's RAM now contains information from three 

different disks. Open a MacWrite document from the third 
disk. The result of this action is a lmost as bad as opening 
Pandora's box. The Mac will swamp you with a tirade of disk 
switching requests. By the time you have loaded the document, 
you may have forgotten what you wanted to do with it. 

The problem with this method is that when loading the 
application, the Mac requires free flowing communication 
between the system files and the applications file. Most of the 
disk swaps do not involve loading the document into the 

memory but are designed to initiate the application. In short, 
do not try to perform operations with three disks. Always 
insure that the applications disk is also a system disk. 

FURTHER COMMENTS 

This chapter has concentrated on disk operations with the 
Mac. We have seen how to manage data in an orderly manner, 
and we have looked at one or two undesirable techniques as 
well . In general we would comment that the Mac makes disk 
handling a bit difficult because of its single-disk-drive design. 
The saving grace of the system is that the visual interface aides 
in the manipulation of data. The operator will probably find it 
most convenient to keep several disks dedicated as data disks 
and employ either the one disk or the two disk operational 
technique. In the following chapters, we will develop the two 
major applications which you can use with the Macintosh, 
MacWrite and MacPaint. We think that you will agree that 
they are efficient and easy to use. 



5 
Exploring MacWrite 

Introduction 

In previo us cha pte rs, our discussion of the Mac has bee n 
centered around the Desk top environme nt. Now we will lea rn 
how to operate Mac Write , Apple's o ptiona l word processor 
progra m for the Mac. Mac Write is idea l fo r compos ing, edit­
ing, a nd fo rma tting a lmost a ny written co rresponde nce fro m 
persona l le tters to fo rma l business le tters. We will include in 
this cha pte r a sho rt selectio n in o rder to illustra te the optio ns 
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available in Mac Write. A discussion of integrating Mac Write 
with MacPaint, the matching graph ics program, will appear in 
some detail in chapter 6. 

We will begin by originating a document. First we will 
specify: 

• Margins 
• Tabs 
• Headers 
• Footers 

Next we will edit the text, save the work on disk , and print 
it. Then we will access a document already on disk , either on 
the existing disk or an alternate. A short discussion on text 
storage will follow. We will then end the chapter with a review 
of the menus peculiar to Mac Write. 

Originating a Document 

Let's start by creating a document. With the Mac set up 
ready to receive a disk, insert a disk featuring the MacWrite 
application. The standard MacWrite-MacPaint disk has this 
option prerecorded , or you may w ish to use another disk with 
the application. If you are unsure whether a disk features 
Mac Write, simply check it by inserting the disk and opening its 
icon. The display window will show the Mac Write application 
icon if it is available. If not, eject the disk and try another. 

Once the proper disk has been inserted, you can easily 
create a document by opening the Mac Write icon. After about 
25 seconds, the screen will appear a s shown in figure 5.1. 
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Figure 5.1. New Mac Write document 

Notice that the window depicted in figure 5. 1 resembles 
windows dealt with in ea rlier chapters. This window includes 
the usua l features : 

• Title bar (currently unna med) 
• Close box 
• Active window lines 
• Scroll bar 
• S ize box 

A menu bar a ppears above the window. As you may have 
a lread y noticed , the MacWrite window also includes a ruler 
with several icons. We will discuss this ruler later in this 
chapter. 
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The rest of the screen resembles a blank sheet of pa per. For 
our purposes, we may think of it as such. What concerns us 
now is the flashing bar which appears in the upper left-hand 
corner. This is the insertion point ref erred to in previous sec­
tions. It indicates where characters will appear in the text. 

Before continuing, let's write a short , one page paper. 
When typing text , MacWrite automatically fits paragraphs 
between the margins, top and bottom, right and left , without 
the use of the Return key. In fa ct, use of this key will hinde r the 
editor operation giving undesired results. The Return key need 
only be used to end a paragraph or skip lines. Type the follow­
ing paragraph without hitting Return . If you make any mis­
takes, just press Backspace and keep typing. 

When reviewing the merits of the boo k, The Grapes of 
Wrath , by J ohn Steinbeck I noticed that the book may 
be enjoyed on many levels. First, school children can 
see it a s an action-packed adventure story. Second, high 
school kids often see it in the classroom where they d is­
cuss many of the underlying concepts. Third , adults 
find it good reading in its own right. Young adults often 
relate it to strife in many parts of the world today while 
older adults tend to relate it to the depression era it 
describes. 

Notice tha t as yo u type, the editor pos1t1ons words 
betwee n the two black triangles . These are known as margin 
markers. They will be discussed later. No word wi ll a ppear 
outside the margin marke rs. Each line will contai n only those 
words which can fit inside the ma rgin markers. We define a 
word as any string of characters ending in a space. The text 
should now rese mble that depicted in fi gure 5.2. 
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Figure 5.2. Typed report 

Setting the Format 
RULERS 

~~'.; 

I 

If at some point you wish to take a break and later resume 
work at the same place, the only operation necessary is to close 
the Mac Write window. A dialogue box will appear as shown in 
figure 5.3. Select Yes if you wish to save the report and No to 
remove it. The Yes entry will prompt a nother box as shown in 
figure 5.4. Enter a name in the space provided. Be sure the 
name is not assigned to another document. You might record 
the name in writing for future reference. Select Save to end this 
procedure. Select Cancel if you change your mind. 
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Saue changes before closing? 

n Yes J 
( No ) ( Cancel ) 

Figure 5.3. First dia logue box 

saue current document as Chapter 5 

( Eject ] II 

( Cancel ] 

@ Entire Document QTeHt Only 

Figure 5.4. Second dia logue box 
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If you can still access the MacWrite menus, reopen the 
document by selecting Open from the File menu. A box will 
appear with the names of all available Mac Write documents 
plus some o ptions. Select the appropriate document a long with 
Open from this box to open the document. To exit Mac Write, 
select Quit from the File menu. To return to the document, 
simply open its ico n from the appropriate window or start over 
again by creating a new document. 

Now that we have text to work with , we can go a bout 
fo rmatting it to suit our needs. Most papers or reports will be 
much longer tha n the one included here. The Mac Write editor 
divides a document into pages. Limits on the number of pages 
depend on the complexity of the document , but the maximum 
is about ten pages. If the document is too long, the Mac will 
display warning boxes and may even refuse further entry. 
Large selections should be divided into shorter documents. We 
will now set the options available in the ruler box. You can j ust 
as easily d o this before entering any text, but we will do it now 
in order to more readily see the results. 

Picture the Mac Write ruler as an actua l ruler placed on a 
sheet of paper. Measurement starts a t 1 inch a nd extends to 71,4 
inches, which will stretch to 81,4 inches using the size box. When 
printing text , the Mac uses the ruler as a reference for the 
printer. 

Suppose you had to prepa re this report with full justifica­
tio n , a I Yi inch left margin , Yi inch paragraph indention, and 2 
inch right margin. The to p and bottom margins will be dis­
cussed in the Header/ Footer section. 

We will start with the right margin. Using the mouse, 
position the pointer tip o n the rightmost ma rgin marker. Drag 
the arrow to 6Yi inches. The path taken between the two poi nts 
is not important so Jong as the button remains pressed and is 
released only when the marker is properly positioned. The 
ma rker moves in I / 16 inch graduations. Assuming 8 Yi inch 
wide paper, the report now has a 2 inch right margin. It may 
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take a bit of practice to properly select a margin pointer as the 
arrow must be precisely positioned to grab the marker. 

Notice the, 1, symbol in the left portion of the ruler. This 
is actually two overlapped markers. Position the arrow over the 
symbol and try to move it. Most likely you gra bbed a symbol 
which resembles this, 1. This is the indentation marker. This 
marker will position the first line in each paragraph. A 
paragraph is defined as any st ring of characters ending with a 
Return character. Although you cannot see the Return charac­
ter, it plays a crucial role in text editing and formatting. Thus, 
just one line can denote a paragraph if it ends in a Return. 
Position the indentation marker on the 2 inch mark. As with 
right margin adjustment, the text conforms itself to the new 
criteria. 

The remaining marker is the left margin marker. It is 
identical to the right margin marker and serves a similar func­
tion. Set the left margin at I Yi inches using the same method 
employed for the right. The result sho uld resemble that 
depicted in figure 5.5. 

Now we are ready to set the spacing and justification. 
Notice the three small blocks in the area beneath the ruler 
graduations between 2\li and 4 inches. These are the spacing 
blocks. The left , center, and right denote single, one-and -a­
half, and double spacing, respectively. They are selection 
blocks similar to those already used. 

To select an option, position the arrow on the approp riate 
block and press the mouse button. Notice the single-space 
block is inverted. In other words, it appears white on black as 
opposed to black on white. This indicates that it is set. Th is 
preset* will appear any time a document is origina ted a nd 
remains until the document is altered. Place the arrow on the 
center block and press the mouse button. The text now appears 
with I Yi line spacing as shown in figure 5.6. 

• This is the setting the Mac wi ll acco mplish on its own. 
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Figure 5.5. Report with margins set 
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Figure 5.6. Report with I Yi line spacing 
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Now select the third block for double spacing. The result is 
shown in figure 5.7. 

The screen is not large enough to displa y the entire text 
with double spacing. To view the entire text, simply scroll d own 
the screen using one of the three methods described in chapter 

3. 
Now we can set the justification of the report format. 

Notice the four additional blocks to the right of the spacing 
blocks. These are the justification blocks. They operate in a 
manner identical to the spacing blocks, and represent left, 
center, right, and full justification, respectively. Left justifica­
tion is preset as was the single-space block. It allows yo u to 
write in a normal fashion with all lines left j ustified . Select the 
second box. As the block depicts, each line is now centered 
between the margin markers. This feature is useful when for­
matting title pages. Select the right justification box. The dis­
play is now right justified. You may occasionally requi re right 
justification for special purposes such as poetry. Finally, select 
the full justification block. What you see now is the desired 
result for the assignment. All lines are full y justified to both 
margins. The completed version appears in figure 5.8. 

Notice the two smaller blocks to the left of the spacing 
blocks. These hold pictures of the regular a nd decimal tab 
markers. The Mac operator may set up to ten tabs in 1/ 16 inch 
ruler graduations. To illustrate this function, Jet's create a table 
for the report. Before entering the table , let's set the ta bs. For 
the moment , reset to single spacing. Now both the ruler and the 
end of the text appear on the screen . As you did with the 
margin markers, grab the place the tab marker at the 3 inch 
mark. Notice that the icon itself does not move, but a copy of it 
appea rs and moves with the arrow. When setting any new tab , 
a new icon copy will appear. If you decide not to set a tab or 
wish to erase one, simply move the marker away fro m the 
graduated line and release the mouse button. In a like manner, 
position a decimal tab at the 5 inch mark. To distinguish 
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When reviewing the merits of the book, The Grapes of 

Wrath, by john Steinbeck I noticed that the book may be 

enjoyed on many levels. First, school children can see it as an 

action-packed adventure story. Second, high school kids often 

see it in the classroom where they discuss many of the 

underlying concepts. Third, adults find it good reading in its 

own right. Young ~dults often relate it to strife in many parts of 

Figure 5.7. Report with double line spacing 

!;![ Untitled 

When reviewing the merits of the book, The Grapes of 

Wrath, by john Steinbeck I noticed that the book may be 

en1oyed on many levels. First, school children can see it as an 

action-packed adventure story. Second, high school kids often 

see it in the classroom where they discuss many of the 

underlying concepts. Third, adults find it good reading in its 

own right. Young adults often relate it to strife in many parts of 

Figure 5.8. Report with full justifica tio n 
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between the two sorts of tab ma rkers, the decimal marker has a 
decimal point in the center while the regular marker is bla nk. 
Notice that a regular tab appears preset at 5Yi inches for the 
operator's convenience. 

The blinking insertion point should a ppea r at the end of 
the text. If no t, position the edit bar to any point following the 
last sentence and press the mouse button. The bar sh ould 
appear in the a ppropriate place. Hit Return twice. You have 
skipped one line in the te xt. You r screen now appears as in 
figure 5.9. 

Enter the following keyst rokes . Note the instructions 
enclosed in parentheses. 

(Tab) 
(Tab) 

Hard cover 
Soft cover 

(Tab) 
(Tab) 

$24.98 
$5.99 

(Return) 
(Return) 

As shown in figure 5.10, the table is entered with the fi rst 
column a ligned to the first tab marker a nd the numbers' 
d ecima l points a ligned to the seco nd . Any number ente red 
after tabbing to a decimal tab will align along the decimal 
points, so the Mac will back type a ll characters before the point. 
This app lies not only to numbers, but to a ny c haracters 
entered. 

Finally, a tab ca nnot be placed outside of a ma rgin 
marker. If you attempt to move a tab to with in a 3/ 16 inch 
dista nce from a margin or beyond a nd release the mouse 
button, the tab wi ll disa ppear. If you attempt the reverse wit h a 
margin marker, it will stop at a 3/ 16 inch distance and move no 
further. 
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INSERTING AND REMOVING RULERS 

MacWrite a llows the user the option of inserting rulers 
and thus altering fo rmat a t any poi nt in the text. To illustra te 
this, Jet's create the same table we used when discussing tabs, 
only this time we will use rulers. 

Place the edit bar behind the word "describes" at the 
paragraph 's end a nd press the mouse button. The insertion 
point now appears between the invisible return character and 
the ending period. Next, select Insert Ruler from the Format 
menu. What appears is a copy of the ruler. When inserting any 
number of rulers, each ruler always a ppea rs as a copy of the 
one immediately a bove it. In order to loca lize the effect of the 
ruler changes, we will insert another ruler a fter the table. Scroll 
the second ruler to the to p of the wind ow. Place the insertion 
point at the end of the text as described earlier, and select Insert 
Ruler again from the Format menu. Scroll to the top of the text 
and reset double spacing as per the assignment. In a like 
manner, scro ll to the third ruler and set double spaci ng there as 
well. 

You have now isola ted the table format from the rest of the 
text. Position the edit bar before " Hard " and press the mouse 
button. Type Backspace to remove the tab character. Re peat 
for the second line. Remove the first tab marker from the 
table 's ruler and positi on the indentation marker at 3 inches. 
The table now a ppears as before. The ad va ntage to this format­
ting method is that it is not necessary to hit the Tab key before 
beginning each entry. To illustrate, place the insertion point 
a fter "$5.99" and type: 

(Return) Deluxe package (Tab) $31 .50 

The result should resemble figure 5.11. 
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Hard cover S24.9l\ 
sort cover S5.99 
Deluxe package s31 .5q 

Figure 5.11. Table format with rulers 

You may have noticed that the last operation caused the 
numbers to jump around on the display. When you removed 
the tab character, the text adjusted so that the first tab charac­
ter a ligned with the first tab marker. Any subsequent tabs and 
markers would behave in a similar manner. When you removed 
the first tab marker, the numbers returned to their origina l 
position. 

Often, while working with MacWrite , you may find the 
rulers distracting. You have the option of hiding the rulers from 
the display to more easily picture the final result. Select Hide 
Rulers from the format menu . Although the rulers are now 
invisible, their effect remains. If, at some point, you wish to 
review or change the ruler settings, you can easily redisplay the 
rulers . By pul1ing down the Format menu, you can see that the 
Hide Rulers option is now replaced by Show Rulers. Select this 
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optio n. Yo ur report now a ppears as before. It will most li kely 
scroll to the top of the text through the process, requiring a 
readjustment to the desired point. You may select Show or 
Hide Rulers as many times as desired with no effect o n the fina l 
product. 

HEADERS AND FOOTERS 

We are now read y to discuss the top a nd bottom of the 
page. Setting the top fo rma t, the Header, a nd the botto m 
format, the Footer, is accomplished in a manne r simila r to the 
operations already performed . You may want to ha ve certain 
information printed in the Header or Footer. MacWrite fea ­
tures this option as well. 

Select Show Header fro m the Fo rmat menu . The result 
appears in figure 5.12. 

What you see is a new window entitled Header featuring: 

• Insertion point 
• Ruler (assuming Sh ow Rulers is chosen) 
• Three new symbols 

The insertion point blinks a t the beginning of a page. This 
will represent the heading of each page in the text. A ny symbols 
placed there will result in the editor positioning the prescribed 
cha racters in that spot on each page. We will discuss one 
e xception, the Title Page optio n, a little later. 

The first of the three blocks co nta ins a number sign ,# , and 
represents page number. A page number will a ppear a t the 
indica ted position on each page in the text. Using the mouse, 
place this icon in the upper right-ha nd corner of the page . 
Notice tha t the block cannot be placed below the line conta in­
ing the insertion po int. No icon may a ppea r below the last line 
of the Header. 
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Figure 5.12. Unset Header window 

The page in the window behaves much as the MacWrite 
text page did except it is only seven lines long. The page can be 
extended to nearly a third of the page by altering the space 
blocks. Suppose we wish to skip three lines in the text before 
starting a page, and we wish to place the page numbe r on the 
second line . By choosing Show Header, the editor will skip one 
line. To skip the three lines for the Header, hit Return twice . 

Now that the insertion point is lower, you can replace the 
page number icon. Move it down one line. Let us fu rther 
suppose that we want the heading, "Book Report: The Grapes 
of Wrath," to appear centered on the second line. Move the 
insertion point up one line by placing the edit ba r one li ne 
above its present position and pressing the mouse button. Now 
type the heading listed above and reset to center justification. 
Do not type Return after the heading as a Return characte r is 
al ready present. 

The two remaining icons represent date,lttJ , and time, 
E!J . To illustrate their functions, position the date icon in the 
upper left-hand corner and the time icon directly below it. The 
icon position indicates the place where the first character of the 
time, date, or page number wi ll appear. The Header window 
appears as in figure 5.13. 
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Book Repor t : The Grapes of Wrath! 

Figure 5.13. Set Header window 

Position the a rrow within the report tex t a nd press the 
mouse button. The text now appears with the ne w heading. 
Note tha t with the text double spaced , spacing begins before 
each new line. Therefore , four lines a re actua lly sk ipped before 
the text is printed . There are 4Yi lines pe r inch of pa per. Each 
subsequent page in the report will have the Header repea ted 
with the a ppropriate page number, time, a nd da te inserted . The 
time will continua lly upda te while the document is open . 

Now choose Show Footer from the Fo rma t menu . The 
display now a ppea rs as shown in figure 5.14. 

The Footer a cts in a ma nner identica l to the Head er except 
tha t it a ppea rs a t the end o f each page in the text. For the sa ke 
of brevity, we sha ll not elaborate further on Footers. For this 
example, you may fa shio n the Footer in any man ner desired . 

Unl ike the Rulers, the dis play of the Head er a nd Footer 
has an effect upon the re po rt forma t. C hoose Hide Rulers a nd 
Hide Header from the Fo rma t menu . T he report now includes 
only the te xt. Whe n printing the report with the Hide Heade r 
o ption , the Header also will no t appea r on the pa pe r. The 
Footer utilizes the sa me rules. If you wish the Header o r Footer 
to appea r in the final repo rt , you must select the Show Header 
a nd Show Footer options and the n place their windows behind 
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Figure 5.14. Unset Footer window 

the text by positi oning the arrow within the text area a nd 
clicking the mouse. The Heade r a nd Footer wi ndows remain in 
pla ce. Shrinking the text sheet with the size box will revea l 
them . W ith the Heade r a nd Foote r set behind the norma l sized 
MacWrite tex t window, sma ll ga ps exist a t the ext reme right 
and left where you may carefully posi ti o n the a rro w a nd ca ll 
the two wind ows fo rwa rd one by one. If thi s is not successful 
a nd you wish to view o r a lter one, either a lter the text wind ow 
size or choose H ide Header (or Foote r) fo llowed by the reverse 
command . T he a pp ropria te wind ow will a ppear. Ho wever, in 
o rder to a lter the wind ow beyond inse rt ing characters o r m ov­
ing existing ico ns, the Show Rule rs option must be selected . 
The text with completed Header a ppears in figu re 5. 15. 

Often, when writing a pa per, the a uth or will not wa nt the 
Header to a ppear on page one . MacWrite 's Title Page com­
ma nd a llows fo r this . As implied , th is comma nd will bla nk a ll 
cha racters a ppea ring in the Heade r fo r page one. T he ed itor 
merely skips the a ppropria te lines befo re printi ng the text. 
Select the Title Page o ption from the Forma t menu . Notice the 
adj ustme nt in the text. Now pull d own the Fo rma t me nu again . 
The Title Page option a ppea rs with a check ma rk nex t to it 
indicating it is set. 
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June I, 1964 
'i: l6PM Book Report: The Grapes or Wrath 

When reviewing the merits or the book, The Grapes or 

Wrath, by john Steinbeck I noticed that the book may be 

enjoyed on many levels. First. school children can see It as an 

act.ion-packed adventure story. Second, high school kids often 

see it In the classroom where they discuss many or the 

underlying concepts. Third, adults find It good reading In its 

own right. Young adults orten relate It to strife in many parts or 

Figure 5.15. Completed Header with text 

Editing 

To this point, we have discussed entering and formatting a 
report. These discussions have entailed a small amount of 
alteration to the content of the text. To accomplish this we have 
moved the insertion point about the document and removed 
some characters using the Backspace key. These functions, 
although necessa ry to accomplish the exam ples thus far, prop­
erly belong under the heading of editing funct ions. To that end , 
we will elaborate and expand on the editing functions pre­
viously learned . 

Before proceeding, let's dete rmine a definition for editing 
characters. Quite simply, a character is any keystroke which 
causes an action in the text. This includes all keys except: 
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• Caps Lock 
• Shift 
• Option 
• Comma nd 
• Enter 

The first three keys a re included beca use, th ough they d o 
cause some action in the text , they require a nother keystroke in 
order to have an effect. The Command key is used in conjunc­
tio n with the ed it functio ns as a n a lterna t ive to the mouse. The 
last key, Enter, has no effect on the MacWrite d oc ument. 

THE INSERTION POINT 

By now you know that the flashing ba r, known a s the 
insert ion po int, determines the po int where a ll text edits are 
mad e. The sole purpose fo r the edit ba r, :X: . is to ma nipula te the 
inse rtion po int. Notice in our report tha t the edit ba r will not 
a ppea r within the Header o r Footer. This is due t o the fa ct tha t 
these ca n only be edited within their wind ows. 

Placing the inse rtion point ta kes a good deal of practice 
and requires adherence to a ve ry strict set of rules. Altho ugh 
problems ca n be avoided by placing the edit ba r in the desired 
spot , it is helpful to unde rstand the to le ra nce to tha t placeme nt. 
In norma l text, pro per placement between characters occurs 
when the ba r is situa ted be tween the centerlines of the cha rac­
ters on either side. For placeme nt a t the beginning of a pa ra­
gra ph where there is a n indenta tion , place the ba r anywhere in 
tha t line before the first character. 

To place the poi nt a t the end of the paragra ph , position it 
between the ending cha racte r a nd the end of the line. Picture 
the Ret urn cha racter as occupying the empty space a t the line's 
end . Inse rting the ba r in this space will pla ce the insertion point 
be fore the Return character. The case of a tabbed space is the 
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reverse. Placing the bar within this space will move the inser­
tion point to the spot just before the following character. With 
a text having multiple rulers, placing the point anywhere 
before a ruler wi!I extend the conditions of the preceding ruler. 
To place the point after a ruler, the edit bar must be within that 
ruler's domain. 

Practice positioning the insertion point at various places 
in the text. Once you have mastered this technique, you will 
find it much easier to use the functions we are about to explain. 

CHARACTER SELECTION FOR EDITING 

Editing tasks often include deletion of a character or 
group of characters. This may or may not be for the pupose of 
replacement with other characters. So far, the only deletion 
technique used has been backspacing through individual char­
acters. This method can be used for deleting any portion of the 
text. A more efficient method is selection of characters for 
deletion or replacement. MacWrite features three techniques 
for character selection. 

The first technique is only va lid when specifying single 
words. Again, we define a word as on page 126 without any 
ending punctuation such as a period or comma. To illustrate, 
let's select the word "school" from the third line of the text. 
Position the edit bar somewhere within the word and double­
click the mouse. The word is inverted , as depicted in figure 
5.16, showing that it is selected. Do not touch the keyboard as 
this wi ll a lter the text. 

To unselect characters, place the edit bar anywhere in the 
text , including within the selected word , and click. The inser­
tion point appears at that point. 

Secondly, the operator may use dragging in the ma nner 
described in chapter 3. Unselect the word "school." Position the 
edit bar before that word and drag across it. The word is again 
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Book Report: The Grapes or wrath 

When revleWUlg the merits or the book, rne Grapes or 

Wrath, by john Steinbeck I noticed that the book may be 

enjoyed on many levels. first, II children can see It as an 
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own right. Young adults often relate It to strife In many parts or 

Figure 5.16. Word selected for ed iting 

,1 
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se lected as shown in figure 5.16. This method is useful when 
selecting any number of characters from one to the entire text. 

To select more than one line , place the edit bar at the 
beginning point and drag to the ending point. The path taken 
between start and fi nish is not important a s long as the mouse 
button remains pressed during the operation . 

Character groups extending beyond the display can be 
easily se lected as will be shown in the following example. To 
begin , make sure that the text is scro lled to the top. Select the 
last two se ntences in the text by dragging from the word "third " 
in the sixth line to the extreme bottom of the page. The text will 
scroll until the edit bar is raised. Then place the edit bar at the 
end of the last sentence a nd release. The result is shown in 
figure 5.17. 
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ilO Untitled 

action-packed adventure story . Second, high school kids often 

see it in the classroom where they discuss many of the 

Hard cover 
Soft cover 
Deluxe package 

$24.98 
$5.99 

$31.50 

Figure 5.17. Multiple lines selected 

The third selection method has the sa me scope as the 
preceding method but is easier to use. To illust ra te this method, 
unselect the lines and place the insertion point before the word 
"third." You should be able to do this in one step. Now place 
the edit bar after the period in the last line. Press the Shift key 
on the keyboard and click the mouse. The lines are se lected as 

before. 

DELETION AND INSERTION 

To delete a selected character string, simply press Backs­
pace. If you wish to replace one word with a nothe r, select the 
word to be replaced and type the new one. At the fi rst keys­
troke, the old word will disappear. The new characters will 
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appear as they are keyed in. To illustrate this concept, select the 
word "kids" in the fourth line. Now type "children." Notice 
that the editor adjusts the text for the new word. 

When polishing a report, you may decide to move words 
around within the text or from one text to another. To accom­
modate this, Mac Write has three options under the Edit menu: 

• Cut 
• Copy 
• Paste 

These allow Mac Write to utilize the Clipboard mentioned 
in previous chapters. Any characters transferred to the Clip­
board will replace previously existing characters. 

Let's start by cutting the word "school" in the third line. 
Select the word and choose Cut from the Edit menu. Now 
choose Show Clipboard. Notice the word appears the re. Close 
the Clipboard window or choose Hide Clipboard. 

Place the insertion point before the word "classroom" in 
the fifth line and choose Paste from the Edit menu. The word is 
inserted in that spot. Notice that the word remains on the 
Clipboard and is copied to the text. 

The Copy command is better suited for copying or 
transferring characte rs to another spot in the text. It operates 
the same as the Cut command, except that the selection is not 
removed from the text. The Copy command is useful when 
copying a catchy phrase or word that is difficult to spell. 

Any part of the text may be cut, copied, or pasted as long 
as sufficient memory is available. Since rulers are parts of the 
text, they may be deleted or transferred as well. 

Since the Clipboard is a separa te file , yo u ma y use it to 
transfer characters between windows. For example, to transfer 
from one document to another, simply cut or copy to the 
Clipboard , open the new document, and paste. Other sources 
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of information fora document incl ude the Scra pbook, Notepad , 
Calculator, and Alarm C lock. To cut or copy infor mation from 
any of these sources, open the desired wind ow and choose the 
option. The Cut and Copy comma nd s have the sa me effect on 
the Alarm Clock since that informa tion cannot be deleted . A 
copy from the alarm clock will copy both time and date in that 
order. 

A common editing phenomenon occurs when the user 
edits a portion of text and the n decides that the origi na 1 versio n 
was better. To reverse the previo us action , Mac Write features 
the Undo command . Pulling d own the Edit menu revea ls e ither 
Can't Undo or Undo followed by one of severa l possib le 
options . These options include Undo: 

• Typing 
• Cut 
• Copy 
• Paste 
• Insert Rulers 

These are the most commonly used options. Nearly every 
text change ca n be undone. After a n Undo o ptio n has been 
performed , Redo will replace Undo in the Ed it me nu. This 
command will reverse a ny Und o. Undo Typing will remove a ll 
text entered since the last insertio n point repositioning. Any 
action executed a fter the o ne undone will re move the Undo 
option as well as the Redo optio n. The Edit me nu will indicate 
whether the option is avai la ble in each case. 
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Saving the Document 

In most cases, the operator will need to save.the Mac Write 
docume nt for future reference. Several methods are ava ilable 
for saving a document. The most simple of these is to ch oose 
Save from the File menu. After about te n seco nd s, the new 
document will a ppear on the disk replaci ng the old ve rsion. 
You ma y wish to save documents a t regular intervals to avoid 
losing work due to a power interruption. 

In addition , severa l other commands will initiate the Save 
procedure. If a MacWrite document has been altered in any 
way, or if it isa new document, the Close command will init iate 
the window shown in figure 5.3. You may have used this 
window when taking breaks. A new d ocument will then give 
rise to figure 5.4 as well. Choose Text Only to save the text 
without formatting, pictures, and special menu options such a s 
fonts. You can open a text-only d ocument only from the finde r. 
Certain Mac a pplications only accept the text-only form of a 
MacWrite document. Follow the instructions and give the 
appropriate respo nses to obtain the desi red results. 

In a like manner, the Quit command will give rise to the 
box shown in figure 5. 18. 

saue changes before quitting? 

( Yes ) 

( No ) ( Cancel ) 

Figure 5.18. Dia logue box for Quit comma nd 
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One other Save operation is the temporary Save used 
when printing a document. If a document has been altered, and 
you wish to print it before any Save operation, the Mac will 
display a box telling you that it is saving the text during the 
print sequence. This is removed from disk after printing. 

Sometimes, you will want to save both the new and old 
versions of a document. Since the Mac does not allow two files 
of the same name on the same disk, MacWrite features the 
Save As command. Selecting this option will prompt the box 
depicted in figure 5.4 with the present document name dis­
played in the space, highlighted for editing. Substitute a differ­
ent name in its place and select Save to complete the sequence. 

Printing the MacWrlte Document 

This section is intended for readers using a Macintosh 
with the lmagewriter printer. 

Before printing the Mac Write document, you may need to 
specify the paper size being used and the orientation of the 
printer. With the Sample document displayed, select Page 
Setup from the File menu. The window shown in figure 5. 19 
will appear. 

Preset options are US Letter, which is normal 8Yi x 11 
inch paper, and Tall orientation. The latter option is for print­
ing the text in standard fashion from top to bottom. The 
optional paper types are: 

• US Legal -- 8Yz x 14 inches 
• A4 Letter -- 8 V4 x l l 2/ 3 inches 
• International Fanfold -- 8 V4 x 12 inches 
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P11per: @ us Letter O R4 Letter OK 
O US Leg11I O lntern11tion11I F11nrold 

Orlent11t1on: @ T11ll O T11ll Adjusted 0 Wide [ C11ntel ) 

Figure 5.19. Page Setup window 

The optiona l orientations are: 

• Tall adjusted -- to print correctly propor­
tio ned pic tures 

• Wide -- to print sideways (top line d own the 
right margin) 

Normally, these options need no adj ustment, but are pro­
vided for special applications. Ma ke the selections and select 
OK to set them or Ca ncel to negate the changes. 

Now we are read y to print the report. Select Print from the 
File me nu. The box appears as shown in figure 5.20. 

auallty: 
P11ge R11nge: 

Coples: 

Paper Feed: 

0 Hlgh 

@Rll 

D 
® Continuous 

@ Standard O orart 

O From: D To: D 
0 Cut Sheet 

Figure 5.20. Print option wind ow 

OK 

[ C11ncel J 
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Set the appropriate options as needed. 

Quality • High -- all lines printed twice as displayed on 
the screen 

• Standard -- all lines printed once 
• Draft -- all lines printed once in small print 

Speed of printing increases from High to Draft qua lity. 

Page Range • All -- the entire text 
• Selected pages 

Paper Feed • Continuous -- form feed computer paper 
• Cut Sheet -- individual shee ts 

Select OK or Cancel after selecting the o ption. 
The Mac may then sa ve the document. Afterwards , it will 

display a box indicating that the print sequence has begun . 
Press Command and Period to terminate printing. If Cut Sheet 
is selected , the Mac will ask for a new sheet of paper, stop, and 
wait until OK has been selected before continuing to a nother 
page. This message may appear before the printer is fini shed 
with a page. This is due to the fact that the Macintos h opera tes 
faster tha n the lmagewriter. Wa it for the page to be completed 
and inse rt the new page before a llowing the Mac to co ntinue. 
The lmagewriter will print the text page, and then return to 
print the Header and Footer. 
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Disk Storage 

When using MacWrite, the operator may wish to review 
or change a document existing on the disk. To do this, exit the 
present document and select Open from the File menu. A 
window appears accompanied by three option boxes: 

• Open 
• Cancel 
• Eject 

To open a file, se lect its name with the pointe r and then 
se lect Open. Alternately, the operator can open a file by double 
clicking with the arrow on the file name. 

The Cancel option has appeared with other windows. It 
serves to negate the selection process. 

If the desired document is not present but appears on 
another disk, select the Eject option, and the disk will eject. 
Insert the proper disk, and the window will appear displaying 
the new disk's Mac Write documents. The scroll bar becomes 
active should there be more titles than can fit in the box 
provided . Selecting a document will ca use the disk to eject, and 
the Mac will request the initia l disk. Follow this and any other 
disk-switching instructions to obtain the desired results. 

When dealing with the Finder, the documents will appear 
as document icons. The operator may wish to organize files o n 
disk by moving documents to folder areas. If a document is 
within a folder, open the disk icon, then the applicable fo lder 
icon to display the document icon. Open the document by 
simply opening its icon. The document will appear as it was 
saved including insertion point placement. 
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Menus 

The MacWrite menus feature several opti ons which a re 
peculia r to MacWrite. We will di scuss the m here. 

APPLE MENU 

The Apple menu fo r Mac Write o perates exactly as it d id 
under the system di sk with the exceptio n tha t "About the 
System Disk" is replaced by " About Mac Write. " 

FILE MENU 

The File menu features comma nds which you have used 
extensively to this point. 

• New -- creates a new document 
• Open -- accesses the O pen wind ow 
• Close -- closes a document 
• Sa ve -- saves on d isk replacing the o ld version 
• Sa ve As -- saves a second document with a new 

name 
• Page Setup -- accommodates specia l pa per needs 
• Print -- starts the p rint seq uence 
• Quit -- used to exit Mac Write 

EDIT MENU 

T his menu a lso includes options covered in detai l in pre­
vious sections. 
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• Undo/ Redo -- used to negate or restore recent 
act io ns 

• Cut -- to remove select io ns to the Clipboard 
• Copy -- to copy select ions to the Clipboard 
• Paste -- to insert selections from the Clipboard to 

the document 
• Show/ Hide Clipboard -- di splays or h ides the 

Clipboard 

SEARCH MENU 

This menu features two commands not disc ussed thus far. 
These are the Find command and the Change command. 

The Find command will search out and highlight any 
group of characters for editing. To illustrate, access the Sample 
report a nd scroll to the top of the page . The Search function 
will start at the insertion point, so place it a t the beginning of 
the text. Select Find from the Search menu. The window 
appears as shown in figure 5.21. 

Type "the" into the box. Notice th a t the Find Next block 
becomes active at the first keystroke . In this case, we are 
looking for a word isolated by space characters, so keep Whole 
Word selected. This keeps the Finderfrom finding " the" as a 
sub-part of another word such as "they." 

iL fi nd 

find Whllt ~"-'---------------'I 
[ rind Ne11l ] ®Whole Word O P11rt111l Word 

Figure 5.21. Find window 



156 Macintosh User's Handbook 

Select the Find Next bloc k. The first occurrence of the 
word after the insertion point is highlighted. To ed it the word, 
place the document window on top and follow normal ed it 
procedures. Return to the Find window by reselect ing Find , or 
move the document wind ow out of the way and access it. 

Continue to search through the document unti l the end is 
reached. If the characters do not appear betwee n the insertion 
point and the end, the Mac will disp lay a box to that effect. 
Select OK from it and proceed to the next operation. The Find 
box can be altered at any time. Notice that the form of the word 
is not important. It can be capitalized or not, and it can appea r 
in any font, or style with the sa me results. 

The Change comma nd gives rise to the box shown in 
figure 5.22. 

The first blank , Find what, se rves the same purpose that it 
did for the Find command. The second blank, Change to, will 
ho ld the characters for substi tutio n. Once the proper charac­
ters have been inserted , the boxes will operate much as the Find 
box did. The Find Next option operates in the same manner. 
Change All will ma ke the changes in a ll cases found in the text. 
However, this option is not Undo-able. These two options 
immediately become active once characters appear in the 
boxes. 

!!L Change 

Find what ~ 
:==~~~~~~~~~~~~~~=ti 

Change to r 
,'--;::=======~-;:::::~-;:::====;--'I 

[ f' in1! :-<mil J [ t: h111u.11~. thPn Hnd ) [ t: hn1u1•~ ) [ [ hnn1.11~ Ill!) 

® Whole Word O Partial Word 

Figure 5.22. Change window 
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The second box , Change, then Find, will change a found 
case and then sea rch out the next. The third option, Change, 
will perform the change and wait for furthe r instructi ons. The 
center two boxes beco me active once the case has been high­
lighted . These options a re designed for se lective changing of 
on ly certain cases in the text. 

FORMAT MENU 

This me nu has bee n discussed extensively with two excep­
tions, Set Page# ... and Insert Page Break. 

The Set Page# ... command is useful when incorporating 
selections covering more than one d ocument. Suppose one 
docume nt contained nine pages of a fifteen page report. The 
second document should start with page ten , but MacWrite 
documents are normally sequenced starting a t page one. To 
remedy this , displa y the second document and choose Set Page 
# ... from the Fo rma t menu . The box appears as shown in fig ure 
5.23. 

The present first page number appears in the box. En ter 
the new pa ge number in the box and se lect OK or Cance l as 
desired . The first page of the document now a ppea rs with the 
new numbering. All successive pages are numbered accordingly. 

New poge number? II I 
--~ 

OK [ Concel ) 

Figure 5.23. Set Page # ... box 
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The final Format option is Insert Page Brea k. This is 
useful when writing selections with multiple parts or chapters 
where the a uthor wants to begin a chapter with a new page. 
Selecting this option , the Mac Write editor will end the page at 
the insertion point and move the point to the top of the ne xt 
page. This can also be used to insert a break at any point in an 
existing text. 

Many dialogue bo xes fea ture a response al ready highligh ­
ted. These include figures 5.3 and 5.1 8. When such a box 
appears, the operator has the option of either using the mouse 
to respond or selecting the highlighted option alternate ly by 
pressing either the Enter o r Return keys. 

FONTS 

The Mac Write word processo r allows output of custom­
ized writing that is professional in appearance. To better facili­
tate artistic style, the Font and Style menus are provided. 

The font me nu fea tures severa l font s indicative of man y 
locations around the world. Because these fonts tend to be 
identified with cities arou nd the world , they bear the ir names. 
The first font , New York, is preset any time yo u use Mac Write. 
To use any other, simply select that font and begin typing. The 
check mark will move to indicate the selected font. To c hange 
the font of existing text , first select the characters, then se lect 
the font. The change will appear. A selection follows which 
illustrates different fonts. 

STYLES 

S tylistic options a re a lso ava ilable within each font under 
the Style menu . The author may write: 

• Bold 
• !ta lie 
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• Underline 
• Outline 
• Shadow 

These are a lterna ti ves to plain text writing. The author 
may choose a ny o.ne of these or any combination whic h best 
suits his or her need s. 

Often, the writte n word is best expressed in a differe nt 
size. The second ha lf of the style me nu provides for this. 
Examples of style options appear in New York fo nt in figure 
5.25 . Twelve point is the standa rd size. One point equa ls I / 72 
of an inch . Therefo re, a 12 point character is I / 6th of a n inch 
high. 

When alt else fails use the New York font. 

But, you may like to use the Geneva font. 

The Toronto font may be easier to read. 

The Monaco font may appear more international, 

Howeuer, the Chicago font is bolder. 

111£ 1Jen.ioi font is n.U:e for informal co;a.si.ons. 

3IUti tfJt ~Oft ~ttt 1U! Jock 1tort •fJOJat)~. 

When in Breece, yw u1e the B1hm1 lmt. 

Iha 9an Franetleo font II the mo&t 1Ultlnettve. 

Figure 5.24. Font examples 
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Any font may appear in any combination of styles at any 
size. To change the style of a selection from a document, select 
plain text and then set the proper style. 

Plain text may do in most cases. 

Some words may best be typed Bold. 

l!s~ Jt'"'Jk: sty/~ tt? t':Lftt-:h st>.me.t?.fle. s ~y~. 
You may_~rfer to Underline some words. 

~~~R\-111\WC. 

.. ,_, lbMJMll .. _, e. •WIS. 
0 1 llJOQ olNI .,, --
Small words appear itt 9 Poittt text. 

Most use 12 Point text. 

14 Point makes it a bit bigger. 

But, not as big is 18 Point. 

24 Point is the biggest. 

Figure 5.25. Style sample 
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Exploring MacPa int 

Introduction 

Apple's Mac Paint p rogram allows the output of sophisti­
cated graphic designs using the Mac. The stre ngth of MacPaint 
lies in its simplicity. As with MacWrite, MacPaint does not 
require tha t the operato r enter special characters. The mouse 
can perfo rm nea rly every manipulation needed to create a rtis­
tic drawings, elect ro nic schematic diagrams, cha rts, a nd gra phs. 
The o utp ut that can be created with MacPaint is limited a lmost 
solely by the ope rator 's imaginat ion. 

161 
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This chapter is devoted to th e stud y of Mac Pa int. It wi ll 
begin with a discussion on how to access the MacPaint d ocu­
me nt. Next, we will di sc uss the d rawing tools used to create the 
illustrations, fo llo wed by a discuss ion o f sha pes and patterns 
which are not drawn, but which a re g uided into the prope r 
proportions. The cha pter will continue wit h a sect ion on 
manipulations bo th of the images o n the page and of thei r 
contents. Then we will cover the specia l menu options availa ble 
a nd the special functions a ugmenting those menus. 

Originating the MacPaint Document 

The operator can originate a Mac Pa int d ocument in one 
of two different ways: 

• From the Desktop 
• From Mac Paint 

These techniques as well as those used to access a n existing 
document are exactly the sa me as th ose used when dealing with 
Mac Write. 

To originate a MacPaint docume nt from the Desk top, 
simply open the Mac Pa int application icon. The document wi ll 
ope n revealing th e Mac Paint display shown in figure 6. 1. T he 
displa y includes six parts: 

• MacPa int document title bar 
• Drawing surface 
• MacPa int tools 
• Bo rder width select ion box 
• Pa ttern boxes 
• MacPaint menu ba r 
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Figure 6.1 . a, Title bar; b, D rawing surface; c, Tools; 
d, Border wid th selectio n box; e, Pa ttern boxes;/, Menu ba r 

The dra wing surface represents the user's access point to 
the MacPai nt d ocument. All d rawing will occur within this 
a rea. T he too ls are used to draw images a nd to man ipula te 
them. The border width se lectio n box a llows the user to c hoose 
the borde r wid ths whe n d rawing sha pes or to choose no bo rder 
a t a ll in certa in cases. The patte rn boxes a re fo r filli ng in the 
va ri ous sha pes with se lected pa tterns. For the most part, t he 
menu ba r du plicates those used in Mac Write. However, several 
other options appear which a re essentia l to MacPa int o pe rati on. 

To ex pla in the seco nd method of o rigina ting a Mac Pa int 
document, close the new document by click ing the c lose box in 
the left corner of the tit le bar. Now select New from the Fi le 
menu. The new MacPai nt window wi ll then a ppear. 
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Accessing an Existing MacPaint Document 

There are two differe nt sources which the opera tor can use 
to access a n ex isting MacPa int document: 

• From the existing disk 
• From an alternate disk 

To ca ll up a n existing document from t he present d isk, use 
the sa me method used for MacWri te. Ei ther ope n the docu­
ment 's icon from the Finder, or choose Open from MacPaint's 
File menu a nd open the a ppropria te docume nt. 

The method for opening a document from a n a lterna te 
di sk is also the same as for MacWrite. From the Finder eject 
the startup di s k and insert the di sk contain ing the MacPaint 
document. Either the startup disk or th e alterna te must conta in 
the MacPaint application . If it does not a ppea r, the Mac will 
not access MacPaint documents. Since two disks are involved, 
the Mac will need to refer to both of the m. This invo lves a 
number of disk-switching operations w hich soon beco me quite 
t ireso me. Perhaps a future addition to t he Mac's memory will 
help this proble m, but in the meantime the owner may wish to 
use the optional second disk drive. 

To a void disk-switching, insu re that the a lternate disk is 
a lso a startup disk* and tha t it fea tures Mac Paint. Eject t he 
first dis k and turn off the Mac. T his erases the co ntents in 
RAM mem ory. Now that the Mac's me mory is c lea red , restart 
the Mac and inse rt the a lterna te dis k. If th is disk conta ins the 
Syste m icon but not the Fi nd er, th e Mac will stop but wi ll not 
eject the disk. To ret rieve the disk, t u rn the machi ne off a nd 
then on. Then press the mouse butto n. Assuming the a lte rna te 
disk is a sta tup dis k, access the document fro m t he Desktop as 
you wou ld no rmally. 

• A startup di sk must contain both the System and Finde r Mini-Mac icons. 
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The Drawing Tools 

THE DRAWING SURFACE 

The MacPaint drawing surface is a portion of an entire 
page measuring 8 x 10 inches. The surface is composed of 
severa l thousand sq ua re segments (or pixels) which a re selec­
tively turned black o r a llowed to remain wh ite to create the 
image. The drawing surface measures 416 x 240 pixels for a 
total of 99 ,840. Due to this large number of dots, each one 
blends in with its neighbors to give the impression of a contin­
uous image. The entire page contains 720 x 576 points totalling 
414,720 altogether. The printer will print each pixel in an area 
of .00019 square inches. 

THE PENCIL 

There are five drawing tools available with MacPaint: 

• The pencil 
• The paint brush 
• The spray can 
• The paint can 
• The eraser 

The pencil is used to draw lines on the drawing su rface. To 
illustrate the different tools, let's draw the picture shown in 

figure 6.2. 
After following these instructions, the Mac operator 

shou ld begin to understand MacPaint operation and shou ld be 
able to draw a reasonable facsimile of the drawing. Let's begin 
by drawing the tree trunk. Use the mouse to insu re that the 
pencil symbol is selected by clicking it. Now move the pointer 
onto the drawing surface where it is transformed into a pencil. 
Lines will appear at the tip of the pencil a s it is clicked and 
dragged. Draw the tree trunk as s hown in figure 6.2. If yo ur 
rendition is unacceptable, read ahead lo the section on the 
eraser and change it, or leave it for now. Your drawing might 
resemble that shown in figure 6.3. 
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Untitled 

Figure 6.2. MacPaint picture 
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Figure 6.3. Use of the pencil 
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THE PAINT BRUSH 

The next drawing too l, the paint brush , is used to create 
wide strokes o n the drawing surface in a ny pattern d esired. 
Since patterns will be discussed later, for now, we will use the 
paint brush with its preset pattern, black. 

Select the pa int brush and move the pointer to the d rawing 
surface. The pointer switches to a small dot as it enters the 
drawing surface. This represents the width o f the line tha t will 
appear. Practice using the pa int brush by drawing the branches 
in the tree. The result appears in figure 6.4. 

THE SPRAY CAN 

The next tool, the spray can, works much like a real spray 
can. It allows cove rage of a wide area, and as the can is 
repeatedly moved over the sa me area, that coverage becomes 
more dense. 

Select the spray can. Notice, as the pointer moves onto the 
drawing surface, tha t the tool symbol swi tches to a circle filled 
with d ots. When a dot passes over a block of the drawing 
surface, this block turns black resulting in a pa th designed with 
the spray can's intermittent effect. Fill in the leaves of the tree 
by swirling the spray ca n around the branches. The result 
sho uld resemble that depicted in figu re 6.5. 

THE ERASER 

This tool is used to undo parts of the drawing. C lick th e 
eraser symbol a nd move the pointer o nto the drawing surface. 
The arrow switches into a white box. While the mouse button is 
pressed , any dot over which the eraser passes will turn white. 
Practice by erasing a n unsa tisfactory portion of your drawing, 
or erase the who le picture a nd start again. Figure 6.6 sh ows the 
eraser in action. 
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untitled --- - - --- -- -------
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Figure 6.4. The paint brush 

untitled 

Figure 6.5. The spray can 
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Untitled -------

Figure 6.6. The eraser 

MACPAINT AND MEMORY OF EVENTS 

The MacPaint document can be visualized as having two 
storage areas for informa tion . These areas are the perma nent 
image and the memory of the most recent event. 

The pe rmanent image is the area h olding a ll picture 
informatio n. The me mory of the most recent eve nt ho lds the 
information for the most recent action taken with the picture. 
Since the Mac remembers the preced ing action, it can reverse 
that action. The ope ra tor ca n use the Undo comma nd in the 
Edit menu to exploit this feat ure. Assuming no action was 
taken since the erasure, the act io n is reve rsible. Selecting Undo 
from the Edit menu will restore the act ion. Selecting Undo 
again will reerase that portion o f the drawing. To erase further 
now would make it impossib le to und o the first action. Only 
the most recent action taken with the drawing is reversible. 
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Erasing a section by erasing a portion, the n releasi ng the 
mouse, and then erasi ng the rest would make the first part of 
the erasure irreversible. This applies to all actions taken with 
MacPaint. 

Lines and Shapes 

Now that we have discussed the rudimentary techniques 
of drawing and erasing, and have witnessed the versatility of 
alternately doing, undoing, and redoing an action, we can 
move on to m ore complex shapes. 

THE LINE 

Notice the line symbol to the left of the eraser. This feature 
allows the operator to draw a straight line between any two 
points. 

To help provide a reference basis for our drawing, use the 
paint brush to create the outline of the hill. Since the pai nt 
brush will paint over the tree, you will need to break up the line. 
Now draw the kite string as shown in figure 6.2. Select the line, 
and place the cross hairs a t the line 's beginning point. Drag the 
line to the point in the sky where the kite is positioned. Notice 
that the line originates at the point where the mouse button was 
pressed and extends to the cross hairs until the button is 
released . Since the line is now in recent memory, you can undo 
it if it is incorrect. The latest version now appears in figure 6.7. 
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~o Untitled 

Figure 6.7. The line 

OPEN SHAPES 

Five open shape options a re available to MacPaint. They 
appear as the last fi ve se lecti ons in the left column of the tools 
boxes. They represent: 

• The rectang le 
• The rounded rectangle 
• The elli pse 
• The irregula r curved shape 
• The irregular straight-sided shape 

To illustrate these sha pes, we will draw some of the objects in 
the scene. It does not matter whe re they appea r on the surface. 
We will move them into proper posi tion late r. 

Select the rectangle block and move th e cross hairs to the 
drawing su rface. Now, ex periment with the rectangle. A rec­
tangle will appear extending from the starting point to the 
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cross hairs as they are dragged across the drawing surface. Try 
to draw the body for the thermos on the picnic table. Undo the 
drawing or erase any mistakes. 

The rounded rectangle is not a part of the diagram. How­
ever, we can easily experiment with it without damaging the 
picture. Choose the rounded rectangle option, and move the 
cross hairs to a clear area on the surface. As you draw the 
image, notice that the cross hairs do not coincide with the 
corner of the box. This is because the image appears within an 
imaginary rectangle extending from the origin to the cross 
hairs. The image is not squared , so it appears to not coincide. 
This can result in problems when attempting to center one 
image within another or when attempting to achieve exact 
positioning. 

The ellipse operates as do the previous two shapes. Select 
this option and draw the sun over the hill. Notice the much 
increased problem with the coincidence of the cross hairs with 
the image. This can cause many positional problems. 

One solution to the problem might be to draw a reference 
rectangle for the ellipse. Erase the sun and draw a long ellipse in 
the empty space as shown in figure 6.8. 

Now try to draw a different ellipse within the first. It 
should be as wide but shorter than the first e llipse. It should 
touch the edges of the first one at the middle much like a cat's 
eye turned on its side. This example illustrates the difficulty of 
precise placement. Your results may have bee n s imilar to those 
depicted in figure 6.9. 

You may have successfully drawn the ellipse on your first 
or second attempt, but doing so requires a keen eye and a bit of 
luck. 
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Untitled 

Figure 6.8. Elo ngated elli pse 

:o Untitled ----- -- --- - ----------
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Figure 6.9. Attempted do uble ellipse 
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Now, let's create the ellipse using a reference rectangle. 
Erase the two ellipses just created a nd draw a rectangle with the 
sa me width and height. We will begin a nd end a ll ellipses 
somewhere o n the pe rimeter of this rectangle. Draw an ellipse 
by placing the cross hairs exact ly a t the upper left corner of the 
recta ngle, and drag to the lowe r right corner. The exact posi­
tioning of the sta rt a nd finish points is easy. Notice that the 
cross hairs turn white as they pass ove r the black portions of 
the scree n. To posit ion them on the upper left corner, insure 
that the lowe r and right a rms of the cross hairs turn white 
indicati ng that they exactly outline the upper left corner of the 
recta ngle . This is call the dot inversion technique. Now, draw 
the e llipse from that poin t to the opposite corner. It will exactly 
fit within the rectangle. The refere nce recta ngle has enabled 
exact placement of the ellipse. 

To place another ellipse within the first ellipse, place the 
cross hairs exactly on the left s ide of the reference rectangle a nd 
drag to the o pposite side. It is sim ple to j udge center placement 
s ince there is no questi on that the new ellipse will fit. The result 
is depicted in figure 6. 10. 

Though it may be possible to judge o ne concentric ellipse 
without the refere nce recta ngle, it is much mo re difficult to 
j ud ge mult iple ellipses. A sa mple using thi s meth od is shown in 
figure 6. 11. 
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Untitled 

Figure 6.10. Concentric ellipses 

Untitled 

Figure 6.11. Multiple concentric ellipses 
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When the rectangle is no longer needed , simply erase it 
leaving the finished product. This erasure may be a bit tricky. 
Deta iled work will a ppear later in this cha pter. 

The next sha pe to be dra wn is the irregu lar curved sha pe. 
To make room for experi mentation, erase the e ll ipses and 
select the next symbol. 

Moving the cross hairs across the surface leaves a line 
fo llowing the pat h. These shapes are a rbitra ry a nd need not be 
closed. Though this procedure may see m to perform the sa me 
function as the pencil, this option has so me important differ­
ences as we will see when discussing border wid ths. Doodle on 
the scree n for a while to get the feel for creat ing irregular 
curved shapes usi ng the cross hai rs. Then erase the doodling 
a nd draw the cloud outline. 

The last open shape is the irregu la r st ra ight-s ided shape 
which is used to create arbitrarily shaped polygons. Select this 
o ption a nd positi on the cross hairs. C lick a nd move the mouse. 
Notice that a line ex te nds from the poi nt of the last click to the 
cross hai rs. Click again and notice that the a nchored point is 
now moved . Create seve ral sides to the sha pe. The sides may 
cross one another with no ill effect. To terminate the figure, 
ei ther double-click a t any position or return the cross hairs to 
the origin and cl ick . The line will no lo nger follow the cross 
hairs. Use this feature to draw in the kite on the end of the 
string. The d rawing should now resemble that depicted in 
figure 6. 12. 
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~D Untitled 

Figure 6.12. The irregular straight-sided and curved shapes 

PATTERNS AND FILLED-IN SHAPES 

A series of multi-patterned boxes are positioned along the 
bottom of the MacPaint display. These are the series of prede­
termined patte rns available for use o n the MacPa int docu­
ment. Notice the larger block on the left. This is the current 
pattern block. It indicates the pattern prese ntly selected. To 
select another pa ttern, simply place the arrow on the des ired 
choice and click. Notice that the current pa tte rn block reflects 
the change. 

Patterns are available for three drawing tools: 

• Paint can 
• Spray can 
• Paint brush 

in addition to the fi ve filled shape blocks which are located next 
to the open shape blocks. 
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The paint can is designed for use when filling white areas 
with a specific pattern. Be careful when using the paint can to 
fill a figure whose outline is not completely enclosed. If an 
attempt is made to use the paint can to fill such a figure , the 
paint will "spill" a ll over the drawing surface. 

To illustrate, use the eraser to nick a sma ll gap in the 
outline of the kite. Then, select the paint can and move to the 
drawing surface. The arrow becomes a replica of the pa int can. 
The paint spilling out of the can indicates the sensing point for 
the tool. Placing the end of the spill on the space will color that 
space. 
Kjg Try to fill in the kite. Select an appropriate pattern such as , 
~'the third from th'e bottom right on the display. Place the 
can in the kite and click. As explained earlier, the entire sky 
assumes the pattern. Select Undo from the edit menu to reverse 
this action. 

Now use the pencil to close the gap in the kite's outline. Try 
filling the space again. If you properly closed the gap , the kite 
should fill in with no trouble. If not, select Undo and try again. 
Use the line option again to draw in the crossbars on the kite 
using the dot inversion technique. 

Use the eight h selection in the top row of patterns, [fill, to 
fill in the thermos. The drawing should now resemble that 
depicted in figure 6. 13. 

One other problem with the paint can is tha t the artist 
needs to be certain that the area to be filled in is not sectioned 
off by any lines. Had we tried drawing the crossbars before 
filling in the kite , we would have had to perform four separate 
operations to fill the kite. 
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Untitled 

Figure 6.13. Using the paint can 

Drawing patterns with the spray can is quite useful. If, for 
example, you desired a very light dusting of color, the sp ray 
can would be best used with a lighter pattern . Choose the tenth 
pattern in the top row and choose t he spray can. Use these to 
give the cloud a s peckled a ppearance. Place the spray can tool 
on the cloud and drag it in a swirling motion. The cloud now 
appears more substantial. Using the black pattern would have 
resulted in the clo ud being too dark. 

The last drawing too l a ffected by the patterns is the paint 
brush. As described earlier, the paint brush is used to ma ke 
broad brush strokes on the drawing surface. T hese brush 
strokes will be created using the pattern currently selected. 

Select the line and dra w the lightning bolt from the cloud 
to the ground. Do not be concerned about the line wid th as this 
will be changed later. Now select the seco nd pattern, Ill • in 
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the top row of patterns, and select the paint brush. Draw the 
hole in the ground where the lightning strikes . Now choose the 
ninth pattern in the top row, ~ , and draw the debris flying 
away from the hole . Notice that the new brush strokes com­
pletely cover the previous pattern. The latest version appears in 
figure 6.14. 

In order to create filled shapes more easily, MacPaint 
features a second set of shapes which complement the open 
shapes. They operate in the sa me manner as the open shapes 
except that they fill in as they appear. 

The rectangle, rounded rectangle, and ellipse all fill during 
their formations. The irregular shapes do not fill until they are 
complete. If the shape is open, MacPaint wi ll close it by draw­
ing a straight line from the beginning to the ending points. 

Use the filled ellipse with the six th pattern in the bottom 
row, Ii , to draw the watermelon. Experiment with the two 
rectangular filled shapes as well. 

Use the irregular filled polygo n, a long with the fourth 
pattern from the right in the top row, Ill) , to draw the picnic 
basket. A straight horizontal or vertical line is one with no 
small zig-zag breaks in it. D raw the basket with a straight top 
and bottom. For the sides, insure that the zig-zagging is the 
same on either side so as to create a symmetric appearance. Use 
the line or pencil to draw the handle of the basket. Erase e rrors 
and repeat if necessa ry. 

T he drawing should resemble that shown in figure 6. 15. 
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Untitled 

Figure 6.14. The spray can and paint b rush 

Untitled 

Figure 6.15. Filled shapes 
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LINE AND BORDER WIDTHS 

Our discussion thus far has been limited in that we have 
used only one line or border width in our drawings. A variety of 
line widths is necessa ry for precise graphics. 

MacPaint offers several line width options. The border 
width selection box, located in the lower left-hand side of the 
MacPaint display allows the use r to select the line width 
d esired. Notice the seco nd line width choice in this box. This is 
the standard line width. This is designated when a MacPaint 
document is opened or created. To utilize other widths, simply 
position the pointer on the desired width and click. The line 
and the borders of all future shapes will be altered to reflect the 
new line width . 

Let's choose the heavier fourth line width , to make the 
lightning bolt appear more forceful. Retrace the bolt and 
notice the effect on the scene. Experiment with different bo rder 
widths and shapes. Notice that the cross hairs reflect the border 
thickness in each case. In terms of d ots on the screen, the 
widths are eight, four, two, one, and zero. 

ADDING TEXT WITH MACPAINT 

Generally, text of so me sort is required with a graphics 
di splay. MacPaint would , therefore, be rem iss in not including 
provisions for lettering its images.Notice the large "A" occupy­
ing the second box down the right side of the tools options . 
Select this box and move the arrow to the drawing surface. The 
familiar edit bar a ppea rs. M ove the ba r to the desired location, 
such as the lower left corner of the drawing surface, and click. 
The flashing insert ion point appears as it did with Ma c Write. 

The keyboard is now completely active as with Mac Write. 
Enter a caption for the picture . Choose whatever font, size, or 
style seems best from the a ppropriate menu. These may be 
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changed as desired while the inserti on point is in p lace. When 
the insertion po int is moved us ing the ed it bar, the text po rtion 
becomes fixed, the actions becomes undo-able, a nd MacPaint 
no longer recognizes the letters as such. They a re me rely 
a nother set of dots comprising part of the who le drawing. 

Figure 6.16 reflects the previous two changes to the draw­
ing. Further exam ples of text entry will appear in the next 
chapter. 

Manipulations 

Our drawing, so far, has been a collection of images, some 
of which are misplaced on the screen. To avoid the difficulty 
with having to precisely place each portion of the picture, 
MacPaint features three manipulation tools: 

• Selection rectangle 
• Lasso 
• Hand 

=o Un tit led 

Figure 6.16. Line width and text examples 
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THE SELECTION RECTANGLE 

The selectio n recta ng le is designed to move rectangular 
shaped portions of the Mac Paint document. After select ing 
this option, which appea rs in the upper right corner of t he tools 
boxes, the arrow changes into dashed cross hairs on the draw­
ing surface. T his feature functi ~ns in a manner identica l to the 
selection a nd movement of multi ple ico ns on the desk top. 
Pos ition the cross ha irs a bove and to the left of the picnic 
basket , a nd drag across it. The moving, das hed rectangle 
appears as with the Desktop case. Releasing the mouse com­
pletes the rectangle. Every portion of the block, whethe r black 
o r white, is now selected . The cross hai rs are reconverted into 
an a rrow when moved into the selection recta ngle. To move the 
selection, drag with the arrow across the surface. Notice that 
the rectangle's white portions supersede the su rrou nd ingdraw­
ing over which it passes. Figure 6. 17 shows the selection rec­
tangle a fter it has bee n moved to another position. 

Figure 6.17. The se lecti on rectangle 
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Movement with the selection rectangle is undo-able under 
the Edit menu. Selecting Undo will cause the rectangle to 
return to its previous position. 

THE LASSO 

For our purposes, it is often more convenient to move only 
those portions of a specified area which have been drawn 
rather than an entire rectangle. 

The lasso is best used for this purpose. The lasso is located 
in the upper left-hand corner of the MacPaint window. After 
lasso has been selected , the arrow will replicate the lasso on the 
drawing surface. 

The lasso 's sense point is the bottom tip of the rope. Place 
and drag the lasso around the thermos. It is not necessary to 
completely surround the thermos s ince the Mac will complete 
any unfinished circle with a straight line. Release the mouse 
and the area becomes selected. The selected area is not the 
outline created by the lasso, but the drawing within. 

Place the lasso's sense point on the selection. As with the 
selection rectangle, it is transfigured into an arrow. In the sa me 
manner, drag the selected object across the surface. Notice in 
this case, that the white area around the selection does not 
supersede the surroundings. The lasso option is ideal for merg­
ing two separate portions of a drawing. 

Figure 6. 18 shows the thermos after it has been moved . 
This action is undo-a ble. 
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Figure 6.18. The lasso 

THE HAND 

The last manipulation to ol is the hand . When discussing 
the MacPaint document, we mentioned that the drawing sur­
face was part of an entire 8 x 10 inch page. The hand, which is 
located beneath the lasso, is used to move the drawing su rface 
about that page. 

Once the hand symbol has been selected, the arrow­
shaped pointer will be transfo rmed into a hand when it is 
moved into the drawing surface. Drag the hand upwa rd s on the 
drawing surface until the tree is located at the top of the page. 
Notice that this action does not cause the images to move on 
the page. Instead , the drawing surface merely moves down the 
page. The Mac requires approximately four seconds to recom­
pute the new placement. This option allows the user to create 
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graphics on the entire MacPaint page. However, when reopen­
ing the MacPaint document, the drawing surface will appear in 
its original position regard less of its position when the docu­
ment was closed. Figure 6. 19 d epicts the hand action. 

The MacPaint Menus 

Although MacPa int's menus are genera lly identica l to 
those included with Mac Write, they include severa l important 
additions. Also , several of the commands that are identica l to 
those found with Mac Write have new applicatio ns with Mac­
Pa int. The Apple, Font, FontSize, and Style menus will not be 
discussed here as they a re analogous to those included with 
Mac Write. 

Figure 6.19. The hand 
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THE EDIT MENU 

Most of the MacPaint Edit menu commands are similar to 
those found with MacWrite. However, their functions differ. 

The Undo command has been explained previously. It is 
used to reverse the last MacPaint action using MacPaint's 
memory of the most recent event. 

The next three options, Cut, Copy, and Paste, perform the 
same functions as with Mac Write. However, they operate a bit 
differently. To illustrate , let's copy the watermelon and paste 
that copy below the tree. Normally, these commands are only 
useful when transferring images. MacPaint includes a special 
function (explained on page 207) which copies images more 
easily within a document than Cut, Copy, and Paste. In our 
example, however, we will use the Copy and Paste commands 
within the same document. 

Using either the Jasso or the selection rectangle, select the 
watermelon. Next, select Copy from the Edit menu to dupli­
cate the watermelon on the Clipboard. This procedure requires 
approximately six seconds. 

Now choose Paste to copy from the Clipboard to the 
drawing surface. Since the watermelon is automatically selected, 
it will not affect the surroundings over which it moves. If the 
Jasso was used to select the watermelon, the copy a ppea rs 
adjacent to the origina l. If the selection rectangle was used , the 
copy appears on top of the original. In th is case, it appears as if 
no copy had been created. In either case, position the selected 
copy as desired using the pointer. The original remains behind. 

The Cut command functions as does Copy except that the 
original is erased. 

In some instances, the artist may wish the copy's propor­
tions to differ from the original. To accomplish this, simply cut 
or copy the selection. Then, draw a selection rectangle of the 
new size and select Paste. The object will be redimensioned 
accordingly. Figure 6.20 illustrates an object that has been 
pasted with both original and altered proportions. 
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Figure 6.20. Copy a nd Paste comma nd s 

The Clear co ma nd works the same as it did unde r the 
Finde r (see chap ter 3). Select a port ion o f the drawi ng su rface 
a nd then select Clear. T he selected area will d isa ppear. This 
action can be reversed using t he Undo command. 

The remaining edi t commands a re peculiar to MacPa int 
and will req uire more stud y. Most of the m, however, a re 
self-expla nato ry. 

The Invert com mand is used to invert the co loring of a 
selected a rea. Note that none of the lowe r five options of the 
Edi t menu a re availab le until a n a rea has been selected. The 
Jasso can be used to select a n area in which o nly the Invert 
comma nd is va lid . T he selecti on rectangle a llows the use of all 
five options. 

Select the copy of the wa te rmelo n. The n, select Invert. 
T he white portions of the selection t urn black while t he black 
portio ns turn white. Reselecting I overt , or selecting Und o, will 
reverse the comma nd . 
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The Trace Edges command will invert the o bject within 
the selection and trace its outline in black. If executed again, 
Trace Edges will reinvert and retrace the object. Each succes­
sive repetition of Trace Edges causes the object within the 
rectangle to be reinverted a nd retraced. 

The tracings will ex tend to the borders of the selection 
rectangle. The tracings disappea r as they pass through the 
borders of the selection rectangle. T hi s feature is suitable for 
retracing a word or covering the entire drawing surface with an 
intricate pattern. 

The two flip commands are essentially self-explanatory. 
Flip Horizontal exchanges the selection rectangle horizontally, 
while Flip Vertical exchanges it vertically. 

The Rotate command rotates the selection rectangle and 
its contents 90° counter-clockwise. Note that a Flip Horizontal 
is not equivalent to two Rotates. With a flip, the item is 
mirrored about an axis. This contrasts with Rotate where the 
image rotates in a single plane. Examples of the Invert, Trace 
Edges, Flip Horizontal , Flip Vertica l, and Rotate commands 
appear in figure 6.21. Note the positions of the small line drawn 
through the shape compared with the original. 

THE GOODIES MENU 

This menu is unique to MacPaint. It contains many 
options which are useful w hen creating graphi cs, or when a 
display must conform to so me required set of specifications . 

The first option is Grid. Imagine a grid pattern li ke that 
shown in figure 6.22a superimposed upon the MacPaint Doc­
ument. The intersection of any two grid lines is defi ned as a grid 
coordinate. The vertica l or horizontal dista nce between any 
two grid coordinates is eight pixe ls. Selecting the Grid opti on 
will constrain the cross hairs to move from grid coordinate to 
grid coordinate. They may not appea r in any o ther location. 
Notice, by dot inversion, that the cross hairs appear within the 
grid example. 
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Figure 6.21 . Edit menu options 

Untitled 

b. Grid drawing 

a. The Grid 

Figure 6.22. The Grid option 
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The Grid optio n a pplies to a ll shapes exce pt the irregular 
curved shape (fi lled o r open). In addition , it affects the selec­
tion rectangle, alpha-numerics, a nd the line. This a llows the 
artist to draw more accurately in graduated distances. F igure 
6.22b shows a n example of graduated drawing using the irregu­
lar straight-sided shape. Each corner of the drawing is a grid 
coordinate. Use the hand and eraser to make room and work 
the exa mple shown. 

The standard drawing surface is sufficient for most draw­
ing need s. However, when outputting more deta iled graphics, 
the artist will require more exact control of the placement of 
each d ot on the screen. The creators of MacPa int d esigned the 
FatBits option to satisfy this need. Much of our example 
diagram could have been created more easily if we had used 
this option. 

To use Fat Bits, simply select that option from the Goodies 
menu . The a rea where the mouse button was last pressed will 
expand by a factor of 64 to cover the entire wind ow. A copy of 
the figure at its original size will appear in a block in the 
drawing surface's upper left-ha nd corner. Figure 6.23 shows 
the Fat Bits version of the watermelo n. If the mouse was not last 
clicked a t the figure to be magnified , use a no n-drawing tool, 
such as the ha nd , to click in the desired spot. Then select 
Fat Bits. 

Any tool or shape can be used within the Fat Bits window. 
The pencil can be used in a more versatile fas hion within tha t 
window. The penci l was firs t described as a line d rawing tool. 
More accurately, it is a dot inversion tool. Normally, the pencil 
draws a black line on a white background by invert ing the d ots 
as it moves. When drawing on a black background , however, 
the pencil creates a line by turning every dot in its path white. 
As suc h, the pencil acts as both a fine drawing and e rasing too l. 
In fact, the pencil co uld be used in this manner to draw the line 
th rough the wate rmelon . Notice t ha t we have done so in our 
exa mples. You can draw this line by using the pencil. 



Exploring MacPaint 193 

. · ------ - - - _-
Untitled 

......... ... . ... ................. • • • ••••••••••••••••••••• • • • ..................... • • • ............... ... . ... 
••••••••• 

Figure 6.23. The FatBits option 

While in the FatBits window, select the pencil and move 
the tool to the drawing surface. Now, press the Option key. 
Notice that the pencil switches to a hand. This method allows 
the artist to use the pencil and the hand while only selecting the 
former option. 

To exit FatBits, either click in the block containing the 
original figure in the upper left-hand corner of the drawing 
surface, or reselect FatBits from the menu. 

The next option, Show Page, is used to view the entire 
MacPaint document. The dotted line depicted in figure 6.24 
indicates the location of the drawing surface within the 
document. 

The Show Page option is useful in a number of circum­
s tances. First of all , Show Page allows the user to view the 
entire page. Though the figures are shrunk so as to a llow the 
display of the entire page , the proportions of the images within 
the page remain the same. 
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Show Page allows a repositioning of the drawing surface. 
First, place the arrow within that area . Now, drag the drawing 
surface around the page. The drawing surface box moves with 
the arrow within the boundaries of the page. A change will not 
be made unti l OK is selected. Select Cancel to redisplay the 
drawing surface in its original position. Practice by moving the 
drawing surface so that the picture is centered within it. 

The operator can also move images about the page within 
the Show Page window using the pointer. Position the arrow 
on the page but outside of the drawing surface. Now, drag the 
example drawing around the page. Notice that the image will 
move partially or completely off the page. The lost portions of 
the image can be retrieved by pulling them back onto the page. 
However, if OK is selected, any portions of the document not 
appearing on the page will be permanently erased. This appli­
cation of Show Page is useful when erasing a large section of 
the page. 

The Show Page window appears in figure 6.24 with a 
portion of the original drawing slid off the page. Move the 
image to a position below the drawing surface rectangle, and 
select OK. The drawing surface now displays a blank portion 
of the page. 

The next option under the Goodies menu is Edit Pattern. 
This option is used to custom design a pattern for use in 
drawing. Selecting this option will reveal a window containing 
two boxes suc h as the one shown in figure 6.25. 

To alter the pattern, use the arrow to click in and click out 
the blocks in the left-hand box. The box on the right will show 
the effect of the change. Select 0 K to set the change a nd Cancel 
to negate it. 
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Figure 6.24. Show Page window 

( OK ) ( Cancel ) 

Figure 6.25. The Ed it Pattern wind ow 
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Any pattern change will be made permanent for that 
document. The change will not affect patterns for other docu­
ments. Avoid altering a preset pattern unless you ha ve 
recorded the original for future reference. Creating new pat­
terns from the pure white or black choices may be the safest 
option in this case. 

The Brush Shape command gives rise to the window 
shown in figure 6.26. 

The heavy box within the window indicates the present 
brush shape. To alter it, simply position th e arrow on the 
desired brush shape and click. The window will van ish leaving 
behind the drawing surface and the new brush shape . The 
brush now operates normally except that it creates graphics 
using the new shape. The dotted sha pes do not operate like the 
spray can as you might expect. Instead , they draw continuous 
figures. Figure 6.27 depicts a figure created with the slanted 
brush shape. 

II e / " • • / ' 
• • / ' 
• D , 

Figure 6.26. The Brush Shape window 
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Figure 6.27. Brush shape example 

The fina l drawing option availab le with the Goodies menu 
is Brush Mirrors. Selecting this choice will reveal the box 
shown in figure 6.28. 

OK None 

Figure 6.28. The Brush Mirrors window 
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Let's begin our discussion of Brush Mirrors by e rasi ng the 
last drawing we created and selecting Brush Mirrors. The 
crossed lines indicate the axes about which the drawing will be 
created. To select one, a few, or all axes for drawing, place the 
pointer on the line representing the desired axis and click. The 
selected line will thicken. To remove the Brush Mirrors option, 
choose None from the Brush Mirrors window or unselect all 
axes from the window and se lect OK. 

The vertical axis represents an imaginary vertical line 
drawn down the center of the drawing surface. Any figure 
drawn with the paint brush on one side of this line will be 
duplicated in a mirror image on the other side as shown in 
figure 6.29a. With the horizontal axis selected, figure 6.29b 
shows that any drawing created in the upper portion of the 
drawing surface will likewise be mirrored on the bottom part of 
the surface. The diagona l axes operate the same as the horizon­
tal and vertical. Picture an imaginary diagonal line appearing 
at 45 degrees through the center of the drawing surface. Since 
the drawing surface is rectangular and not square, the diagonal 
will not extend from corner to corner on the surface . Because 
of this, there is a region on the drawing surface on which there 
is no corresponding mirroring area across the diagonal. Figure 
6.29c shows this effect. Figure 6.29d shows the artistic poten­
tial of using all mirrors at once. 

T he next two options in the Goodies menu are informa­
tional in nature. The first, Introduction , is a quick reference 
guide to the basic operation of MacPaint. The window is 
repeated in figure 6.30. 
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Figure 6.29. a, Vertical mirror 

untitled 

Figure 6.29. b, Horizontal mirror 
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Figure 6.29. c, Diagonal mirror 

Figure 6.29. d, All mirrors selected 
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Figure 6.30. Introduction window 

The last option, Short Cuts, illust rates many of the specia l 
commands available with MacPaint. Further discussion of this 
feature appears on page 203. 

THE FILE MENU 

The File menu features many of the sa me comma nds 
ava ilable to Mac Write. The following commands operate iden­
tically to MacWrite: 

• New 
• Open 
• Close 
• Save 
• Save As 
• Print 
• Quit 
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The rema ining options a re: 

• Revert 
• Print Cata log 

The Revert com mand a llows the artist to ca ncel cha nges 
to a d ocument a nd recall the saved version witho ut the need for 
closing and reopening the document. When Revert is specified, 
the dialogue box shown in figure 6.31 will be displayed. 

Reuert to the last uersion 
snued? 

~n iiiiiiiiiiOKiiiiiiiiiiilllJ ( Cance I J 

Figure 6.31. The Revert box 

Select OK, o r press either the Return or Ente r keys to 
recall the saved version . Select Ca ncel to red isplay the present 
version. 

The Print Catalog comma nd results in min iature version 
of a ll M ac Paint d ocu ments res iding o n a disk being o utput to 
the p rinter. The d ocument ti tle will be d isplayed underneath 
each miniature illustra ti on as d epicted in figure 6.32. 
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Figure 6.32. The Print Catalog option 

Constraints and Special Functions 

Untitled 

We will now discuss the optiona l comma nds availa ble in 
the Short Cuts window. These serve as productivity aids for the 
experienced MacPaint artist. Figure 6.33 depicts the Short 
Cuts window. 
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Figure 6.33. The S ho rt Cuts window 

In the fo llowing sections we will use the terms constrain or 
const raint several times to describe several diffe rent functions. 
In this context we re fer to const rai ning the direction of move­
ment. This means tha t the constraints will limit the movement 
of the too l bei ng used to a specific direct ion . T his d irecti on 
might be horizo nta l, vert ical, or, in some cases, diagona l. 
There a re two sections dealing with const raints. First we will 
d iscuss const rained ma nipula tio n, t hen we wi ll cover con­
st rained d rawing. 

For our purposes, we ref er to specia l functions as a series 
of keyboa rd combi nations which o perate in co njunction with 
the mo use to perfo rm certain specia l o perations. We a lso 
include here a series of optio ns which can be accessed by 
d ouble-clicki ng the mouse. 
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CONSTRAINED MANIPULATIONS 

Constrained manipulation of objects upon the drawing 
surface is restricted to either the horizonta l or vertical direc­
tions. This means that if the mouse is moved in a general left or 
right direction when using the lasso or selection rectangle with 
the Shift key, the Mac will interpret the movement as horizon­
tal. If the mouse progresses in a general up or down direction, 
this is interpreted as a vertical constraint. 

To illustrate constrained movement, we will move the 
various picnic foods about the surface in constrained horizon­
tal and vertical directions. Return the picnic scene to the draw­
ing surface using the Show Page option. Use the selection 
rectangle to select the picnic basket. Then, press Shift and drag 
the picnic basket. Notice tha t a general up or down movement 
of the mouse, with an e levation greater than 45 degrees, results 
in a vertical constraint. A general left or right mouse move­
ment, less than 45 degrees, causes a horizontal constraint. 
When the mouse is released, the Mac considers the movement 
to be complete. 

Use constrained movement to maneuver the picnic basket 
about the page. Position the basket in the open space to the left 
of the tree. Once you have pressed the mouse button and Shift 
key, the Shift key can be released without affecting the con­
strained manipulation of the object on the drawing surface. 

The lasso is constrained in the same manner. Use the lasso 
to move the thermos near the picnic basket using constraints. 
Do the same with the watermelon. 

CONSTRAINED DRAWING 

Now that we have cleared a working area, we can use 
constraints to draw the picnic table. The movement of the 
following tools is constrained when used with the Shift key 
depressed : 
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• Pencil 
• Paint brush 
• Spray can 
• Line 

We will now use the paint brush in conjunction with 
constraints to draw the table top for the picnic scene. Select the 
paint brush and position it on the drawing surface. Depress the 
Shift key and drag horizo ntally to draw a line. This line should 
be long enough to hold the picnic basket, thermos, and water­
melon upon it. 

The pencil and spray can operate with constraints in 
exactly the same manner as the paint brush. We will not 
elaborate further on these tools. 

The line operates somewhat differently than the pencil, 
paint brush, or spray can when used with constraints. We will 
use the constrained feature of the line to draw the legs for the 
picnic table. When used in conjunction with the Shift key, the 
operator may draw using the line horizontally, vertically, or at 
a 45 degree angle. Experiment by drawing a line using con­
straints. Notice that the line jumps in graduations of 45 degrees 
as the cross hairs pass the half way points between angles. With 
the line thickness set to the fourth line and the Shift key 
pressed , drag the cross hairs so a s to draw the table legs at a 45 
degree angle. To make both legs symmetrical, draw one, then 
select, copy, and paste it. Then flip the copy horizontally and 
reposition it on the table. 

Pos ition the table so that all of the items will fit on it. Use 
the lasso to place each item on the table. Then use Fat Bits and 
the pencil to patch the drawing if necessary. 

We have nearly completed the scene. The next constraint 
subject will help finish it. The rectangle , rounded rectangle, 
and ellipse can be used to constrain squares, rounded squares, 
and circles, respectively. Here we use the term constrain in that 
we limit the shape of the figure . Use the constrained ellipse to 
draw a circular sun over the hill. Now, add the finishing 
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touches, and the masterpiece is complete. Ref er back to figure 
6.2 on page 166 for the finished prod uct. 

Constraints also apply to the irregular polygon shapes. 
They follow the same guidelines as did the line. Any shape 
whose angles a re multiples of 45 degrees can be created using 
these constraints. 

SPECIAL FUNCTIONS 

The remaining special functions available with the key­
boa rd are illustrated in figure 6.33. In this section we will 
discuss these specia l functions and illustrate their uses. 

The Option key is used to copy a portion of the document. 
We will show this function by using the Option key to manipu­
la te a copy of the kite a bout the page. First select the kite a nd 
then press and hold the Option key. The selected po rtion of the 
document will be copied as soon as we attempt to use the 
pointer to move the selection. Use the pointer to drag the 
selection away from the original. This feature is quite useful 
when repeated versions of a drawing are required. To create 
another copy, sim ply release the mouse, repress the button, 
and continue to drag the object. We will use this feature exten­
sively in the examples in the next chapter. 

To create a copy which is aligned vertically or horizontally 
with the original, use Option and Shift together. An example of 
horizontally a ligned copying is shown in figu re 6.34. 
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Figure 6.34. The Copy function 

The a rtist can create echoed images using the Optio n and 
Command keys simultaneously. To ill ustra te this featu re, we 
will spread echoed copies of the sun in the picture across the 
d rawing surface . Select the sun in the sky. Now drag the su n 
quickly while both the Option and Command keys a re pressed. 
A path of echoed images will be created . The more rapidly the 
drawing is d ragged , the greater the nu mber of images tha t are 
gene rated with grea ter separatio n . After you have pract iced 
crea ting echoed images, be sure to Undo this acti on to avoid 
litte ring the d rawing surface. An example of echoed images 
a ppears in figure 6.35. 

A n additional use of the O ption key is in conjunct ion with 
the line a nd the sha pes. When drawing a line or sha pe while 
dep ress ing the Option key, it will a ppear with the pattern 
currently selected. 
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Figure 6.35. Echoed copies 

The Command and> keys can be used to change the Font 
size to the next ava ilable option on the FontSize menu . Press­
ing the Command key with the < key results in the selection of 
the preceding option in the FontSize menu. The Command, 
Shift, and > or < keys can be used in a similar fashion to 
change the Font selection. 

Certain MacPai nt selections function diffe rently when 
they are double-clicked. The double-click applications are des­
cribed below: 

Selection recta ngle • Select the enti re window (This works 
in an identica l manner for the Fat Bits 
window) 

Hand • Enter the Show Page option 

Paint brush • Enter the Brush Shape option 

Pencil • Enter and leave FatBits 

Eraser • Erase the entire window (This applies 
to the Fat Bits window as well) 

Selected pattern • Enter the Edit Pattern option 
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An alternate method of selecting the Undo command is 
the use of the' key on the keyboard. The Backspace key can be 
used to erase images which appear within a selected portion of 
the drawing surface. 

STRETCHING AND SHRINKING IMAGES 

The dimensions of a selected portion of a MacPaint doc­
ument can be altered using the Command key. We will illus­
trate this technique by altering the size of the picnic table. Use 
the hand to move the scene up on the drawing surface so as to 
free space for maneuvering. Don 't move the table off the 
drawing surface. If you are unable to move the images up far 
enough, the problem may be that the drawing surface lies at the 
lower limit of the page. Execute the Show Page command and 
maneuver the images and the drawing surface as desired. 

Select the table and move a copy of it to the clea red area. 
Now, move the rest of the images off the surface and center the 
copy of the table. Place the pointer in the selection rectangle 
and drag while pressing the Command key. The image 
stretches and shrinks with the movement. The alterations are 
delayed a split second while the Mac recomputes the dimensions. 

The placement of the arrow within the selection rectangle 
plays a crucial role in determining the direction of movement. 
Placing the pointer near the middle of the right or left side of 
the rectangle will constrain the alteration to horizontal move­
ment. The opposite sides remain anchored. Similarly, place­
ment near the top or bottom constrains the movement to the 
vertical direction. If the pointer is in a corner, the image 
stretches in both direct ions. Notice that the image can be 
reversed across the anchored point. The image can be stretched 
off the surface, but if the mouse is released , the portion will be 
lost unless Undo is selected . A possible stretch of the picnic 
table appears in figure 6.36. 
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Figure 6.36. The stretch function 

The distortio n in figure 6.36 becomes apparent as the 
image is pulled la rger. This is because each dot in the original is 
expanded to spread the image. There are no smoothing marks 
inserted to make the image appear more continuous. This 
distortion becomes worse when stretching occurs in only one 
direction. It may become unaccepta bly great when expanding 
intricate patterns. 

Alternately, shrinking may cause an image's fine details to 
disappear. The artist may, in some cases, be able to draw 
compensatory markings to reduce this distortion, or he or she 
may decide simply to redraw the original on a la rger or smaller 
scale. 



1 
More On MacPaint 

Introduction 

This chapter is intended to provide further examples of 
the techniques which may be used to exploit the versatility of 
MacPa int. It is recomme nded tha t the reade r be familia r with 
the gene ral ope ra ti ons of MacPa int a s discussed in the pre­
vious chapter. M ost MacPaint functio ns will not be ex pla ined 
in depth here to avoid encumbering the reade r with need less 
deta ils. 

213 
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The techniques used here are not exclusive in their scope. 
The reader may prefer to use more bas ic methods or deve lop 
new ones to suit his or her needs. Each example is self­
contained and not re lated to a ny of the o thers . The reader may 
wish to browse through the cha pter and pick those exam ples 
which best exemplify his or her specific a pplications. 

The emphasis here is not on artistic talent. No freehand 
drawing skills are required. Anyone can draw diagrams with a 
professional appearance using the shapes and special functions 
available with MacPaint. 

Each section begins with a short overview illustrating the 
specific skills covered. A detailed instructive narrative follows 
to aid the reader in recreating each diagra m. Finally, each 
section contains a short conclusion with comments on alternate 
methods and a brief review. 

The Organizational Chart 

The organizational chart is commonly used to illustrate 
levels of responsibility and authority within a business. Very 
often, such a chart will be used in a briefing or tour through a 
company. 

This example is designed to provide further practice in the 
use of reference points as discussed in chapter 6. The diagra m 
will also entail the use of the copy function as well as con­
strained movement a bout the drawing surface . It will illustrate 
methods of entering text into a diagram as well. 

INSTRUCTIONS 

Figure 7.1 shows the diagra m to be developed in this 
section. This orga nizat iona l chart is only a small sa mple of a 
possible extensive illust ra tion of a business's hierarchy. 
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Figure 7.1 . Organizational chart 

Let's begin by creating the basic figure we will need 
repeatedly in the diagram. In order to create the shadowing 
effect for the boxes, we will superimpose two filled , rounded 
rectangles slightly offset from one another. The first rectangle 
is solid black. Draw this figure in the appropriate size. 

A precise method of referencing the placement of the 
shape is the use of a reference point similar to the reference 
rectangle developed in the previous chapter. Use the hand and 
click on the upper left-hand corner of the shape. Do not drag 
the image. Now choose FatBits using one of the methods 
illust rated previously. Use the line or pencil to extend the sides 
of the shape to cross at the corner. The inte rsection is the 
reference point. Figure 7.2 shows the place ment of the refer­
ence point. 
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Figure 7.2. Reference point placement 

Now, place a reference poi nt at the opposite corner of the 
box. Do not use lines this time as we want that corner unda m­
aged. Judge the point placeme nt from t he FatBits image. 

Using these two refere nce points, draw two more fo r the 
overlaying figure. Move the new references up three dots a nd 
left two dots from the first. Choose the solid wh ite pa ttern wi th 
the filled , rounded rectangle a nd resto re the drawing surface. 
Draw the new shape using the d ot inversion techn ique devel­
oped in chapter 6. For easier referenci ng, draw the shape from 
the bottom right corner to the top left. Erase the reference dots 
and return the box corners to their origi nal condit ion . This is 
the basic shadowed box which will const itu te t he majority of 
the diagram. T he result a ppears in figure 7.3. 
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Figure 7.3. The shadowed box 

Since the creation of this figure was somewhat trouble­
some, we will use copies of it to complete the diagram. Move 
the box to a center position high on the drawing surface. Use 
the lasso together with constrained movement and the copy 
function (Shift+ Option keys) to move a copy of the box about 
~ of a n inch below the original. Then , use the same meth od to 
place a copy to the left and right of the newly created box. The 
result a ppears in figure 7.4. 

The lines connecting the boxes can be easily drawn. Use 
the line with horizonta l a nd vertical constraints to draw each 
line. The irregular polygon could also serve our purposes in 
this case. The diagram is now depicted in figure 7.5. 
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Figure 7.4. P roperly placed boxes 
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Figure 7.5. Boxes co nnected with lines 
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Now we are ready to enter the text portion of the diagram. 
Select alpha-numerics, set the Font to London, and set the 
Style to Underli ne . Also select A lign Midd le since we wa nt to 
center the lettering in each box. Now, place the edit bar in the 
upper middle of the top box and click. The insertion point 
flashes at that position. Type in : 

President 

The le tters will be displayed cente r justified with the selected 
Font and Style. Unti l the insertion point is moved , the text may 
be changed or ed ited. We will need to reset t he insertion point 
for the name since it is displayed with a different Style. Center 
the point below the title and type the name. The result is 
depicted in figure 7.6. 
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Figure 7.6. Text entry 
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Using the sa me technique, enter the remaining text in the 
boxes. Notice that if the text runs over another part of the 
drawing, the text will supersede the background. The diagram 
is now complete. A more extensive chart would entail a piece­
meal construction by moving the drawing surface from place to 
place concentrating on one area at a time. The limits to the 
chart lie solely with the size of the page. 

CONCLUSION 

Creating this diagram has shown the proper use of refer­
ence points to create preci se diagrams. More importantly, 
however, it has demonstrated the role of constraints and spe­
cial functions in creating presentable illustrations. 

The shadowing method detailed here can quickly become 
tedious and time consuming. The next illustration shows an 
easier method which is every bit as precise as the one shown 
here. 

The Pie Chart 

The pie chart is used to graphically depict proportional 
divisions of a specific quantity such as a budget as is the case in 
this example. It should be noted that th e data used in this and 
the next example have no basis in fact. The values were simply 
invented for the purpose of illustrating text entry methods. 

The important techniques used are alternate uses for ref­
erence points and lines to achieve shadowing, partitioning of a 
figure , moveme nt of detai led portions of a diagram, and 
decorative coloring. Also , we will illustrate data transfer 
betwee n MacPaint a nd MacWrite documents. 
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INSTRUCTIONS 

The first step in drawing the basic figure is to determine 
the reference square. Draw a square whose width is equa l to the 
diameter of the des ired circle. Then draw a circle exactly within 
the square using the dot inversion technique. Now, use the 
eraser and Fat Bits to erase all but the upper left-hand corner of 
the square. Draw a line at 45° away from the corner. We will 
move a copy of this figure a long this line. The diagram should 
appear as depicted in figure 7.7. 

Use the copy function (Option key) and move a copy of 
the circle up the line until an adequa te shadow image re mains. 
This is best accomplished by using the lasso to select the circle 
plus the square corner a nd a portion of the line. Figure 7.8 
shows the result. 

Figure 7.7. Circle with reference line 
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Figure 7.8. Circle with shadow 

Since the reference lines are no longer needed , we can 
erase them. Now we are ready to partition the graph. Since 
Taxes, Food, and Entertainment co nstitute fifty percent of the 
total, we can accurately draw a line splitting the graph in half. 
First , let 's find th e center of th e circle. Use the Fat Bits window 
to focus on the extreme left port ion of the circle whe re the arc 
becomes a straight line. Count the number of dots along the 
st raight section. If there is an odd numbe r of dots, start a line 
from the center point. If there is a n even number, start the line 
from the dot a bove the center po int. Resto re the drawing 
surface and extend the line just past the center o f the circle. For 
the right side, place the line from the dot a t or just below the 
ce nter point. Extend this line just past the cente r of the circle. 
Use the same method to draw lines from the top a nd botto m. 
The drawing shou ld now a ppea r a s shown in figure 7.9. 
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Figure 7.9. Finding the center of the circle 

Notice that the example case contained an even number of 
dots on the sides. The lines bisecting the circle will not intersect 
at a si ngle dot but instead form a box cluster of four dots. Erase 
all of the line but this point or cluster (as you r case may be). We 
have determined the exact center of the circle. 

To cut the circle in ha lf, use the line to draw from one edge 
through the center to the ot her edge. Be careful not to lose 
track of the center point. Perhaps it would help to erase the 
portion of the line residing at the center. Draw in the remaining 
pie cuts with the proper proportions. You will need to estimate 
them since MacPaint does not provide an analytical method of 
calculating the proper sizes. The partitioned graph appears in 
figure 7.10. 
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Figure 7.10. Partitioning the graph 

Moving the shifted pie cut is accomplished using the lasso 
with the copy function . Select the lasso and carefully trace 
around the pie cut. Then, use the copy functi on to shift a co py 
of the pie cut away from the center. The result shou ld resemble 
that shown in figure 7. 11. 

We have completed the most difficult portion of the dia­
gram. The remaining parts are coloring and tex t ent ry. Use 
lines to sketch in the shadow outline of the shifted pie cut and 
color each section with a different pa ttern. One possible com­
bination appears in figure 7 . 12. 
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Figure 7.11. Shifting the pie cut 

Figure 7.12. Coloring the graph 
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To enter the data portions shown in figure 7 .13, select "A," 
position the edit bar, and enter the info rmation. Use the line to 
draw from 5% to its pie cut, and use FatBits to detail the 
inverted part of the line through the shadow area. Use Align 
Left for the word "Enterta inment," Align Right for "Cloth­
ing," and Align Middle for the other portions. The title is 
underlined and shadowed. Notice that there is no need to make 
room for the lettering on the patterns. 

There is also a text portion of the graph which needs to be 
added. We would normally add text as we did when labeling 
the graph, but for this example we will illustrate integration 
with MacWrite. 

Save the MacPaint document, close it, and quit Mac­
Paint. Now, open a Mac Write document. Select the portion to 
be copied and select Copy or Cut. Close the MacWrite docu­
ment and reopen the MacPain t document. Position the draw­
ing surface to display the area where the text will appear and 
select Paste. The box will appear as shown in figure 7.14. 

5:g Entertainment 

Figure 7.13. Labeling the graph 
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Figure 7.14. Text Pasting 

Clearly, the text is not in a shape which will be convenient 
for our purposes. This selection rectangle wo rks much as oth­
ers except that it has a special sizing function. When changing 
its size, the text conforms, as in Mac Write, to the box dimen­
sions. If the box becomes too small for the text, then the excess 
will be hidden. When the box is terminated (by clicking else­
where), the text is fixed and becomes part of the document. 
Any unshown portions become lost. Shape the text to fit the 
block next to the graph. The final versio n appears in figure 
7. 15. 
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a The graph clearly snows the 
various expenses that tne 
average househol<l incurs. With 
many families, however. savings 
can be as low as 5:g_ 

Figure 7.15. Comple ted drawing 

It is also valid to predetermine the selection rectangle of 
the appropriate size, then select Paste. The text wi ll appear 
conformed to the box. 

In order to transfer images from MacPaint to MacWrite 
documents, use the selection rectangle or lasso to select a part 
of the picture . The n se lect Cut or Copy, close the MacPaint 
document and open the Mac Write document. Place the inser­
tion point just before the diagram 's intended position and 
select Paste. The diagram will begin at the next line a fte r the 
insertion point. An exam ple is depicted in figure 7.16. Use of 
the Tall Adjusted mode under the Page Setup window is 
recomme nded when printing such a document. Otherwise, 
elongated drawings are printed . 

To move the diagram or alter its size, click in it. The box 
will appear as shown in figure 7.17. 
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The graph clearly shows tlle various expenses that tlle average 
household Incurs. With many families, however, savings can be as low as 
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Figure 7.16. MacWrite document w ith a MacPa int 
drawing 

Untitled 
Tne graph clearly snows tlle various expenses that the average 

nousehold Incurs. Wltll many tamilles. however. savings can be as low as 
S:t. 

Figure 7.17. MacWrite diagram ed iting box 
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To move the box right or left, place the arrow on the right 
or left side of the box a nd drag. To move up or down, simply 
insert o r delete line spacing. The sma ll boxes along the bottom 
of the box are used to a lte r the dimensions of the fi gure. The 
right a nd left boxes are used to stretch or shrink horizo nta lly 
and vertically, whereas the center box is only used to change 
shape vert ically. 

A s ize altered version appears in figure 7. 18. Note the 
magnified distortion in the graph. 

The graph clearly shows the various expenses that the average 
household incurs. With many families, however, savings can be as low as 
5~. 

E:n. t.e-r t.a..:tri.m eri. t 

Figure 7.18. Stretc hed drawing 
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CONCLUSIONS 

T his exa mp le has demo nst rated a nother method fo r 
achieving a shad owing effect in figures. T he reference line ca n 
be drawn at any angle fro m the square o r, if such precision is 
superfluous, the reference need not be d rawn at al l. S imply 
drag the copy as required, accord ing to your own judgment. 
Text transfer betwee n Mac Write and MacPa int is a lso possible 
using the Note Pad o r Scrapbook. These med ia a re more 
permanent tha n the Clipboa rd . Exact p roport ions o n the 
graph might be accomplished using a protracto r on the screen . 
It should be noted , however, that t he same d isto rti on evident 
while printing a Mac Write document conta ining graphics not 
using the Tall Adjusted mode is a lso apparent on the Mac 
screen. 

The Bar Graph 

Bar graphs a re another widely used type of grap h. These 
a re often used in briefings to illustrate trends or projections 
over an extended time peri od . 

This section will concentrate ma inly o n duplicat io n of 
dimensions using the specia l fun ctions. Gra phs of this nature 
a re no rmally graduated in unifo rm lengths. The ba rs fo r this 
graph should be uniform as well. 

INSTRUCTIONS 

We will begin this gra ph by d rawing the axes. Choose the 
pa int brush a nd select the extreme bottom left brush shape. 
This will d raw the blocked lines fo r the axes. Use constrained 
movement to d raw the graph's axes. The result appears in 
figure 7.19. 
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Figure 7.19. G raph axes 

T he horizonta l axis will represent the eig ht years fr om 
1983 to 1990. Place a mark o n the axis for the first two yea rs so 
tha t a ll will fit on the line a s shown in figu re 7.20. Place the 
pa int brush o n the spot a nd c lic k without moving it. 

To complete the graduat ions unifo rmly, use the lasso to 
o utl ine the sma ll pa rt of the ax is fro m just befo re the fi rst ma rk 
to j ust after the second . Now, use constra ined horizontal 
m ovement with the copy funct ion to m ove the selection copy 
right until the fi rst ma rk of the copy exactly superimposes the 
second ma rk of the o rigina l. Release the mouse a nd repeat the 
p rocess aga in until the re a re eight precisely placed ma rks. 
Figure 7 .21 shows the gradua ti ons a nd the creat ion of the fina l 
ma rk . 
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Figure 7.20. First two graduations 
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Figure 7.21. The grad uated axis 
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The vertical axis will contain th ree divisions. Use the 
method described previously to create uniform markings. 
Label the graduations of the graph by selecting alpha­
numerics. Enter the numbers shown in figure 7.22. The years 
are center justified , and the vertica l axis num bers are right 
justified. 

To label the vertical ax is, use the hand to make room for 
three lines above the vertical axis. The la bel appearing in figure 
7.23 is Bold and Underlined. Similarly, use the hand to position 
and place " Fiscal Year" below the end of the horizontal axis. 

We are read y to enter the bar graph data. Create a refer­
ence recta ngle of the width desired for each bar. The height 
should be about a third of the graph height. Use the open 
rectangle. A good example appears in figure 7.24. 
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Figure 7.22. La beling the gradua tions 



~[ 

Projected 
Profit 

(Millions of Dollars)_ 
15 ~ 

10 ~ 

More on MacPaint 235 

f"tilnt I 

Figure 7.23. Labeling the graph axis 
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Figure 7.24. The ref ere nee rectangle 
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Now, use the copy function to place one copy of the 
rectangle on each graduation as shown in figure 7.25. 

Since the first reference rectangle is no longer needed , 
erase it. The series of copies made on the graph axis will 
determine the wid th of each bar. Use the fill ed rectangle to 
draw the bars at the proper size. Ensure that each one is as wide 
as the reference. Begin each recta ngle just below the surface of 
the ax is so the bottom outline of the rectangle will blend with 
the axis. Choose a different pattern for each bar. The result 
appears in figure 7.26. T he bar heights will have to be 
approximated. 

To complete the graph, label the bars and erase the excess 
from the reference rectangles if necessary. The fina l prod uct 
appears in figure 7.27. 
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Figure 7.25. Placing reference rectangles 
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Figure 7.26. Drawing the bars 
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CONCLUSION 

This exam ple illustrates a simple method of drawing a 
uniform and professiona l looking illustration. We also moved 
the drawing surface about the page to accommodate a larger 
diagram. 

A Dimensional Illustration 

Another application for MacPaint is the physical dia­
gramming of some machine, tool, or like object. In this exam­
ple, we will draw an ax with labeled dimensions. 

The example will illustrate the use of size alterations to 
achieve proper proportions. We will also get further practice in 
d rawing a large figure by moving the drawing surface about the 
page. The use of customized patterns will also appear here 
a long with a discussion of lettering methods to improve 
presentability. 

INSTRUCTIONS 

We will begin by creating the ax head. This will cover most 
of the drawing surface. Rather than drawing the parts free­
hand , we will use portions of other shapes. 

For the upper a nd lower arcs, we will use a flat ellipse. 
Draw an ellipse with the prope r arc. Then copy it and move the 
copy vertically below the first as shown in figure 7.28. If the arc 
is not correct , you can adjust its size with the selection rectangle 
and the sizing function. 

Now, cut off the top portion of the upper ellipse and the 
bottom portion of the lower ellipse. Then create a long ellipse 
to the right s ide of the drawing surface. The left and right arcs 
of the ellipse should be appropriate for the cutting ed ge of the 
ax. Erase the right half of the ellipse . The n select it and move a 
copy of it away from the origi nal using the lasso. Position the 
copy a t the left edges of the first two a rcs. Select the original of 
the long e llipse a nd flip it horizontally. As with the first, place it 
at the right edges of the firs t two arcs as shown in figure 7.29. 
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Figure 7.29. Assem bling the individ ual shapes 
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To complete the ax head sha pe , erase the excess of the two 
a rcs on either sid e. Choose two places about the center of the 
ax for the handle. D ra w st raight li nes to t he bottom of the 
page. Draw to the bottom of the d rawing surface . Then use the 
ha nd to push the image up, and conti nue d rawing u ntil you 
reach the botto m. 

At the bottom, we will d raw the nub of the ha nd le. Use 
Fat Bits in a bla nk area and d raw one half of the shape as shown 
in figure 7.30. 

Select a copy of the shape a nd fl ip it horizo nta lly. M ove 
the origina l a nd the copy into place at the end of the ha ndle. 
Draw in the gaps in the lines. T he res ult a ppears in figure 7.3 1. 
This completes the ax dra wing. The next step is to d raw the 
dimensions. 

Use FatBits to crea te the sha pe shown in figure 7.32. This 
will form the end of each dimension line. 

~J 
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Figure 7.30. Detailing the nub of the a x handle 
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Figure 7.32. Dime nsion li ne end 
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Figure 7.33. Placement of d imens ion li nes 

By now you should be adept at co nst ra ints, manipula­
tions, a nd special functio ns. P lace a copy of the line end in the 
a ppropriate places . Then connect the end s with lines. A por­
tion of the figure a ppears in figure 7.33 . 

To add cla rity to th e fi gure, we will d raw d otted li nes to 
some of the line ends. To d o this we will c usto mize one of the 
pa tte rn blocks. Select the Edit Pa ttern wind ow and set the 
pa ttern to tha t shown in fi gure 7.34a for horizo ntal dots or 
figu re 7.34b for vertica l dots. Set the Brush shape as shown in 
figure 7.34c. 

Position the pa int brush d ot a nd draw t he applica ble lines. 
Refer to fig ure 7.35. 
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Figure 7.34. Setup for d rawing dotted lines. a, 
Horizontal dotted line pattern; b, Vertical dotted line 
pattern; c, Brush shape for d otted lines 
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Figure 7.35. Drawing d otted lines 

Some of the preset patterns would d raw dots more fre­
quently. There are several opt ions avai lable fo r customized 
dotted or dashed lines as well. 

To enter dimensio ns in vertical lines, place the edit bar 
exactly on the line using the dot inversion place ment tech­
nique. Click , then enter the numbers ce nter j ustified. For the 
horizontal lines, ensure that the ed it bar is bisected by the line, 
click, the n enter the values. To complete the figure, enter a title, 
centered above the ax. The one shown in figure 7.36 is 24 point , 
Bold , and Underlined. 
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Build a Better Ax 
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Figure 7.36. Com pleted diagram 
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CONCLUSIONS 

The major difficulty with this example was properly pro­
portioning the ellipses. Sizing helped alleviate the problem. 
Several attempts may, however, be required to achieve the 
desired results. 

The beauty of the MacPaint software package is in the 
detailed work which is possible using the FatBits option and 
the dot inversion posi tioning technique. Although there were 
some difficulties with drawing the ellipses, these are far out­
weighed by the benefits of not having to draw the diagram 
freehand. 

We have illustra ted here the use of MacPaint to create an 
image from simpler constituent parts. This versati lity greatly 
expands the possible figures that can be created. 

The Electrical Circuit 

The following example is a schematic diagram for an 
electrical circuit. No knowledge of such circuits is required in 
order to create the drawing. It is offered simply as a nother 
example of piecemeal construct ion of a di agra m from simpler 
parts. 

We will rely o n a n extens ive use of constraints, ma nipula­
tions, a nd special functions to accomplish the exa mple. We will 
also deal with labeling using mixed font sizes, and we will 
continue to use the FatBits option for detailed drawing. 

INSTRUCTIONS 

Let 's begin by creating the detailed parts of the diagram. 
Though we wi ll a ssign a name to each symbol, do not be 
concerned as to its function . Figure 7.37 shows the FatBits 
images of the symbols for the resistor, ground, capacitor, 
transistor, and contact point. 
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Figure 7.37. Electrical component parts. a, resistor; b, 
ground; c, capacitor; d, transistor; e, con­
tact point 

When building circuits from scratch , it is not often conve­
nient to be as neat and precise as we will be here. However, 
most techniques used here are quite timely. 
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Arra nge the fo ur resistors in a box connected as shown in 
figure 7.38. When selecting the resistors, rotate and flip the 
copies to the desired orientations. 

Use the selection rectangle t o position a copy of the tran­
sistor a nd draw the lines as shown in figure 7.39. Use Fat Bits to 
patch or position the figures if necessary. 

Position and connect the remaining components as shown 
in figure 7.40. Notice that lasso manipulation of the ca pacitors 
leaves the background line crossi ng it. Patch it or use the 
selectio n rectangle. Some detailed work is necessary in either 
case. Also a ttach the contact points and position the grounds 
directly below the contact points. Use reference lines if neces­
sary to judge placements. 
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Figure 7.38. Resistor array 
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Figure 7.40. Compo nent placement 
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The cross connection in the center shou ld be bypassed. In 
order to repair this, draw a small circle slightly larger than the 
contact point and center it over the crossed connection. Erase 
the left half of it and red raw the lines as shown in figure 7.4 1 to 
give the "jumping over" impression. 

The labels are drawn in two parts. The main symbol 
designation appears in 12 point while a ll subscripts but those 
for Vi and V 0 are 9 point. Since a ll subscripts are slightly below 
the main symbol, they will require separate insertion point 
placements. For C2 and Rbs' it may be necessary to create the 
labels in a more open area and then use the lasso to move them 
into place. Refer to figu re 7.42 for the final version. Inciden­
tally, this circuit is called a bootstrap biased common emitter 
amplifier. 

CONCLUSIONS 

This example relied heavily on copying and manipulating 
component parts of the diagram. The task could have been 
quite tedious without those functions , but it was a lmost trivia l 
with them. This concludes the examples using text. The fina l 
example discusses a simple method of artistic drawing. 
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An Artistic Example 

This exam ple req uires no free ha nd d rawing sk ills as it 
uti lizes the G rid functio n to steady the opera tor 's ha nd. T he 
p rima ry functions illustrated he re are the use of the Grid 
functi on a nd the pa int can. 

INSTRUCTIONS 

With the Grid funct io n, d raw the foll owing picture. Use 
the line, open p olygon , a nd / o r filled po lygon t o d raw the 
images. Note tha t li nes may no t ex tend to th e ex treme borde r 
of the drawing surface. They may have to be penc iled to the 
edges. Make sure that the floor a nd sta ircase a re closed so we 
ca n use the paint ca n without spilling over. All corners of the 
diagram are grid loca tions with the exceptions of the flag in the 
picture and the circle in the iron . Use FatBits for these pa rts . 
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Figure 7.43. Init ia l drawing 
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The stair rai ling is created using the line with the th ird 
thickness. 

To draw the lamp shade , follow the arrows depicted in 
figure 7.44. Each corner is a grid position. 

To complete the example, use the paint can to fill the 
areas. If there are leaks and the paint spi lls over, undo the 
action and plug the holes. Refer to figure 7.45. 

One advantage to the Grid function is that movement of 
portions of patterned areas does not involve problems with 
matching patterns. One grid block is the size of one Edit 
Pattern block. 

Paint II I 

Figure 7.44. Drawing the lamp shade 
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Figure 7.45. Using the pa int can 

CONCLUSIONS 

~c: 

rmrn 

This example has introduced a practica l use for the Grid 
func tio n of the G oodies me nu . It a lso explored further uses fo r 
the pa int ca n in drawing deco ra ti o ns. 



8 
Macintosh Communications 

Introduction 

With a modem a nd a communications software package, 
the Mac is capa ble of communicating with other computers. 
The term "modem" is an acronym meaning modula tor/ de­
modulato r. The purpose o f the modem is to interface between 
the Mac and the teleph one system. The Mac processes data 
formatted in 1 's a nd O's as we discussed in chapter one. The 
telephone system deals in audible so unds. The modem's job is 
twofold. First , the mode m must accept instructions from the 
Mac tell ing it what to d o. These instructions inc lude com­
ma nds to set data format , a nswer the telephone, a nd dial a 
phone number. 

255 
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The seco nd tas k which a modem must perform is to 
trans mit and receive data. In order to accomplish this, the 
modem must have so me scheme for changing the bits into 
audible tones. This sc heme must be mutually agreed upon by 
both the loca l modem and the remote modem. If one mode m 
was speaki ng in one way and the o ther was speaking another 
way, each would receive meaningless noise from the other. It 
would be like an American speakng to a Frenchman. If neither 
knew the othe r 's language, communicatio n would be po intless. 

Most modems use a technique known as Tone Modulation. 
Here, the modem will send one predetermined tone when 
sending a "O" and a different tone when se nding a" 1." On the 
receive side, the modem will relay a "O" to the computer when it 
receives one specific tone and a " I" when it receives anothe r 
specific tone. As long as there is mutual agree ment between the 
two modems as to the interpreta ti on of each tone, communica ­
tion shou ld run smoothly. 

There are two types of modems which have been used 
extensively for computer communicati ons. These a re acoustic 
and direct connect modems. Acoustic mode ms are designed to 
connect with a standard telephone. An acoustic modem incor­
porates a crad le which is designed to hold a telephone handset 
securely. The modem's speaking and receiving units use the 
telephone as a person does. Signals are sent through the talking 
portion of the phone and received through its listening portion . 
An acoustic modem is depicted in figure 8. 1. 
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Figure 8.1. Acoustic modem 

The disadvantages to an acoustic modem are that it is 
susceptible to noise interference both from within the room in 
which it is used and from the telephone handset itself. Also, the 
modem cannot be instructed to pick up the phone on its own. 
An operator must be present to transfer the handset to the 
modem. The modem will require use of a dedicated telephone 
when it is in use. This may cause inconvenience for the opera­
tor. If the operator's telephone handset is incompatible with 
the modem, the connection may be impossible. For these rea­
sons, the acoustic modem is generally considered obsolete. 

Many of the difficulties encountered with acoustic 
modems can be avoided by using a direct connect modem. This 
sort of modem was designed to be a stand-alone unit. The 
modem which we will use in this chapter for our examples is a 
direct connect modem made by Hayes Microcomputer Pro­
ducts, Inc. This modem is compatible with many computer 
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systems including the Mac. Figure 8.2 depicts a Hayes direct 
connect modem. The unit contains its own microprocessor so 
tha t it can operate the telephone line according to the instruc­
tions received from the computer. Since the modem does not 
rely upon the operator to lift the phone when making or 
receiving a call, the modem can perform these actions itself 
electronically. 

Direct connect modems solve many of the problems 
encountered with acoustic modems. They are not as suscepti­
ble to interference as their predecessors. They can operate the 
telephone without assistance. This means that the modem can 
be operated remotely with no operator present as long as the 
modem is left on and the computer is set up in advance. The 
direct connect modem can remain permanently connected to 
the phone line. This eliminates the need to dedicate another 
telephone for the modem's use. The modem also does not 
require a physically compatible telephone receiver. 

~-
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Figure 8.2. Direct connect modem 
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One disadvantage of the direct connect modem is that 
many business telephone systems do not a llow for extensions 
with modular receptacles. Installing a modem in this situation 
may require special wiring considerations. 

As with all other computer functions, the Mac must be 
told exactly what to do to establish communications and relay 
data. This requires a program generally known as an emulator. 
To emulate is to mimic so met hing in every way. A terminal 
emulator will cause the computer to act as if it were a computer 
terminal. The program w hich the Mac uses to link with other 
information systems is ca lled MacTerminar". This software, 
released by Apple in the summer of 1984, was designed to take 
advantage of the Mac's vis ual interface ideology. 

In many cases, MacTerminal removes the need for the 
operator to actually deal with the specia l instructions to the 
modem. Instead, the operat or simply sets the system parame­
ters from the various menu options. MacTerminal will inter­
pret the options a nd send the a ppropriate commands to the 
modem. The p rogra m will a lso see that the data gets to the 
modem through the proper interface port. 

OVERVIEW 

In thi s chapter we will discuss the eq uipme nt and softwa re 
needed to set up a communications lin k between the Mac and 
various other information sources. We will begin with a discus­
sion of the hardware in volved. There are severa l modems 
which may be used wi th the Mac fo r communications. We will 
explore the MacTerminal program a nd see how to use the 
menu options. 

Then, we wi ll continue with a discussion of communica­
tions with the vario us ava ilab le data base services, fo ll owed by 
an example of modem communications with the IBM PC X'T®. 
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Communications Equipment 

Most modems used in compute r communications require 
a se rial interface to connect to the computer. This fits in well 
with the Mac since it is des igned to use seria l interface equip­
ment exclusivly. The mode m which Apple distributes for the 
Mac comes in two mode ls. The first model operates at 300 
baud. The baud rate is an indication of the speed at which the 
modem transmits data. One baud is about one bit per second of 
data transfer. The other, more advanced Apple modem can 
operate a t 300 and 1200 baud. The 1200 ba ud rate is usually 
advantageous when transfe rring large quantities of informa­
tion. Due to lack o f availability, we will not utilize the Apple 
modem for our examples. The Apple modem should operate 
much the sa me as the Hayes mode m which we will use here. 

THE HA YES MODEM 

As noted above, the modem which we will use for thi s 
chapter is the Hayes direct connect modem. It operates as the 
Apple modem d oes a nd is offered in 300 or 300 / 1200 baud 
m ode ls. We will use the 300 baud mode l. The Hayes modem 
requires a separate electrica l connection a nd uses a power 
converter to change the norma l 120 VAC from the wa ll socket 
to 3.5 VAC needed to power the modem. The modem also 
requires a cable adapter to co nnect with the Mac. The cable 
ada pter is availa ble at most computer and electronics stores. It 
is d esigned to mate the Mac's 9-pin con nections with the Hayes 
modem's 27 pin connection. Although the latter connector is 
much larger, the Ha yes m ode m uses only 6 pins. The refore, no 
special wiring is necessary to connect the modem. 

Follow the installa ti on instructions accompa nying the 
modem a nd co nnect it to the Mac. The instruction ma nua l for 



Macintosh Communications 261 

the modem lists the various settings fo r the Dual lnline Package 
(DIP) switches which a re located behind the modem's front 
panel. Adjust these se ttings as they pertai n to your needs. To 
activate the Ha yes modem, locate the small toggle switch in the 
bac k of the modem. Flip it to the up or "on" pos ition, and the 
modem's LED display lights should shine. These lights indicate 
the following conditions: 

• MR - Modem ready 
• TR - Terminal ready 
• SD - Send data 
• RD - Receive data 
• OH - Off hook condition 
• CD - Carrier detected 
• AA - Auto answer mode 

The MR lamp is a lways lit when the modem is turned on. 
If it is not lit , either the la mp is burned o ut, or the modem is not 
functioning properly. The TR lamp is norma lly a lways lit 
except under special conditions which are described in the 
operatio ns ma nual for the modem. 

The SD a nd RD lamps indicate similar conditions. T hey 
light whenever the modem is sending (S D) or receiving (RD) 
da ta. These lamps become important when you wish to moni­
tor the data t ransfer process. 

When making or receiving a call , the modem must set the 
telephone in the off hook condition. You do this ma nual ly 
whenever you lift the telephone receiver. When the modem sets 
the phone to the off hook condition, the OH la mp will light. 

When the mod em makes a communicatio ns link with 
a nother modem, it send s a constant signa l through the tele­
phone line. The opposing modem does the same. This constant 
signa l is called a carrier. When the modem receives the ca rrier 
from the other side, the C D lamp will light ind icating that a 
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link has been made. The carrier is the basis for all telecommun­
ications. In o rder to relay info rma tion, the carrier is modu­
lated . That is, it is a lte red in some predetermined pattern . In 
our case thi s modulation is v ia a series of tones as described 
previously. 

The Auto Answer light could be lit for one of two reasons. 
Of course, it will be on when the mod em is in a uto answer 
mode. T ha t is, the modem will a nswer the te le phone without 
any specific instructi ons. To enter this mode, eithe r set DIP 
switch number 5 to the up positi on or enter the command AT 
SO= I . 

The lamp will a lso light momentarily when the phone is 
ringing to indicate a n incoming call. 

Mac Terminal 

The MacTermina l softwa re package enables the Mac to 
uti lize a modem a nd communicate with a nothe r co mpute r. The 
na me describes its primary function. The a pplicatio n is 
designed to turn the Mac into a computer termina l. At the time 
of this writing, the official ve rsion of the MacTe rminal a pplica­
ti o n had no t yet been released . Our examples a re based upon a 
prerelea se version which is very c lose to the final product. For 
th is reaso n, the fo llowing discussion may vary s lightly from 
your experience with the MacTerminal app lication. 

Basica ll y, MacTerminal operates in a manner s imilar to 
o ther applications used on the Mac. When the appl icat ion is 
opened , the software will c rea te a d ocumen t. In the case of 
MacTe rminal, the document is a place whe re informa tion will 
appear as it is received from the modem and , in most cases, as it 
is ente red into the computer fo r transmission . When und er the 
a pplica tion, all characters en tered o nto the MacTe rmina l doc­
ument will be se nt to the modem via the seria l communications 
port on the Mac's back panel. 
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In general, information is sent out as strings of characters 
in the sta ndard ASCII format. The American Standard Code 
for Informa tion Interchange (ASCII) is the standa rd info rma­
tion coding format used throughout the commun ications 
industry. A listing of the standard ASC II codes appears in 
Appendix A. When communica ting in this manner, the Mac 
may speak to nearly any other computer. 

THE MACTERMINAL DOCUMENT 

Before continuing our discussion of MacTerminal, let's 
access the application. Locate the diskette which conta ins the 
d esired application and insert it into the Mac. Open the disk's 
icon a nd find the Mac Terminal applications icon as depicted in 
figure 8.3. 

~ 
Moc T erminol 

Figure 8.3. The MacTerminal icon 

Open the icon. After a bout 25 second s, the display 
appears as show n in figure 8.4. The display includes the ite ms 
which should be quite fami liar to you by now: 

• Menu bar 
• Close box 
• Title bar 
• Scroll bar 
• Size box 
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~ flie Edit Commands Settings Phone Keypad 

iD Untitled 

I 

Figure 8.4. ew MacTerminal document 

ESTABLISHING A COMMUNICATIONS LINK 

For the communications example, we will assume that you 
have access to a Ha yes 300 baud mod em and the Mac Termi nal 
softwa re, and that you can access the tele phone system. It is 
also necessary that you have a list of the phone numbers for any 
remote computers which you wish to contact. We will a lso 
assume that the Mac is configured with the modem connected 
and turned on, a nd that the MacTerminal document appears 
on the Mac screen. 
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THE SETTINGS MENU - TERMINAL SETTINGS 

The first step is to set the various parame ters within the 
Setting menu. Select Terminal from the Settings window. The 
window, shown in figure 8.5, appears on the Mac display. The 
window shows the defa ult settings which will appear when the 
new M acTerminal docume nt is created. Any settings made 
through the Settings windows will be saved along with the 
MacTerminal document. 

The first item in the window, Terminal, sets the type of 
te rmina l which the Mac will emulate. Normally, all characters 
sent by any type of terminal are in the ASCII code. The special 
characters , however, may not be sent by a certain terminal 
type. These characters might include commands sent using the 
Command, Option, E nter, Tab, or Shift keys. VT I 00™ nor­
mally deals with all of these characters. Teletype (TTY) emula­
tion, on the other hand , deals in few, if any, of these. The 
proper choice for your application of Mac Terminal depends 
solely upon the requirements and capabilities of the remote computer. 

The next setting, Compatibility, determines the other 
types of terminals with which the Mac will communicate. 
Many of the various da ta coding formats a re compatible with 
those te rminal format s which the Mac can emulate. The Amer­
ican National Standards Institute (ANSI) data format and the 
VT52™ format are both compatible with the VTIOO format. 
That is, when MacTerminal is se t for VTIOO e mulation, the 
Mac can communicate with a computer which recognizes the 
VTIOO, VT52, or ANSI format. The othe r options with the 
Termina l item have different compatibilities. The compatibili­
ties which are not available in each case will be dimmed whe n 
that option is selected . 
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Terminnl Settings 

Terminal @UTIOO Q TTY 

Compatibility @ANSI 

Cursor Shape ®Underline 

Character Set ®United States 

Line Width ® 80 Columns 

Protocol conu. O H1>1>h'lirrn 

181 On Line O Local Echo 

0 IBM 3278 

QUT52 

0 Block 

0 United Kingdom 

O 132 Columns 

0 [ IUS1 er C1 Ir. 

0 Status Lights 

181 Auto Repeat O Ruto Wraparound O New Line 

O Repeat Ctrls. O lr<m~pon~o t 
( DK ) (cancel) 

Figure 8.5. The Terminal Settings window 

When the MacTerminal d ocument first appeared, it was 
empty except for the flashing line in the upper left-hand corner. 
This line is the cursor. Although the cursor is not norma lly 
used with the Mac, its co unterpa rt , the insertion point, should 
be fam iliar to you. When typing on the MacTermina l docu­
ment, all cha racters will a ppear at the cursor's position. Like­
wise, characters received from the remote computer wi ll 
appea r at the cursor. To c hange the cursor from an underline to 
a flashing block , select the Block option under the Cursor 
Shape item. 

Certain characters a re often used exclusively by one 
nation. For example the French la nguage uses accents in writ­
ing which are not used in English. The United Kingdom char­
acter set is an avai la ble a lterna tive to the United Sta tes charac­
ter set under the Character Set item. With this cha racter set , the 
#character is replaced with the£ symbol. 
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With the Line Width option, the operator has the capabil­
it y of expanding the MacTerminal document to a width of 132 
columns or leaving the width at the d efa ult va lue of 80 
columns. With the 132 columns choice, the horizonta l scroll 
bar becomes active so that the ope rato r can view the entire 
MacTermina l document. 

The Protocol Converter item is used when the Mac is 
communicating with other data processing devices through the 
Apple Line® or Apple Cluster Controller®. These devices a re 
designed to a llow the Apple equipment to communicate with 

IBM main frame compatible computers. 
The remaining selections of the Te rminal Settings menu 

address the format of the MacTermina l document. When the 
" X" a ppears in the box next to the selection, the item is 
selected . When the box is empty, the item is unselected. When 
the first item, On Line, is unselected , the Mac will be opera ting 
in a Local mode. That is, the computer will not be in communi­
catio n with the modem. C haracters typed into the keyboard 
will appear on the local Macintosh display only. 

When the Local Echo ite m is se lected, the docume nt will 
be in Local mode whether it is On Line or not. Thus, the 
c haracters will a ppea r o n the Mac display as they are typed in. 
If the re mote co mputer does not echo characters back to the 
Mac, this item will need to be used . 

T he Status Lights item refe rs to the indica tor lights which 
can be displayed above the MacTermina l document. C heck 
this item and se lect OK in the Termina l Settings window. 
Immed iately below the title ba r a ppea rs a group of indicato rs 
which provides pertinent informa tion to the operator. When 
the circle to the right of the indicato r title is black, the indica­
ti on is true. When the circle is hollow, the indication is false. 
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Figure 8.6. Status Lights* 

Notice in figure 8.6 that the On Line indication is true. 
This tells the operator that the Mac is passing information to 
the modem. When off line (On Line is false) , the terminal is not 
communicating with the remote computer. The communica­
tions link will be broken. This is useful when a llowing a first­
time MacTerminal user to experiment with the document. 

The Local indication can refer to the Local Echo mode of 
the document. When the modem is sending data, it does not 
normally repeat the characters back to the user. T herefore, 
when sending data, the user will not see what he or she types on 
the MacTerminal document unless the remote computer can 
echo the characters it receives back to the Mac. When the 
application is in Local Echo mode, the Local indicator will 
become true, a nd characters will appear on the document as 
they are typed. 

When the modem is not tra nsmitting data but is accepting 
instructions, it will repeat those instructions back to the user. If 
the document is in the Loca l Echo mode during these periods, 
each character will appear twice on the document. 

The Local indicator will also change to true when the On 
Line setting has been disabled. When this occurs, the On Line 
indicator will be false. 

• We have condensed this display due to size limitations. 
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At some time during operation under the Handshake 
protocol, the Keyboard may become locked. That is, charac­
ters typed into it will be ignored. If this occurs, the Kbd Locked 
indicator will revert to true. If you wish to enter characters into 
the MacTerminal document and the keyboard is locked, 
unlock the keyboard by selecting Unlock Keyboard from the 
Commands menu. 

The indicators LI thru L4 a re used when the Mac is 
emulating the popula r Digital Equipment Corporation (DEC,.) 
VT! 00 terminal type. They indicate information concerning 
the status of the terminal. 

Return to the Terminal Settings window at this time so 
that we may review the rest of the items within. Normally, 
when typing onto the document for any Mac application, the 
Mac will repeat characters if a key is pressed and held. With the 
MacTerminal document, this feature is controlled by the Auto 
Repeat item. When it is turned off, characters will not repeat if 
a key is held down. 

One important feature with the Mac Write document was 
the Wraparound function. When a line extended to the right 
margin of the document, the characters were wrapped around 
to the next line. Although the Mac Write Wraparound function 
placed an entire word on the next li ne, the MacTerminal 
document will Wraparound the characters individually when 
the Auto Wraparound item is selected . When unselected , the 
characters past the right ma rgin of the document will overwrite 
the last character in the line. 

When the New Line item is selected, the cursor will line 
feed to the next line in the document when the Retu rn key is 
pressed. In other wo rds, with New Line selected , pressing the 
Return key will generate both a Return and a Line Feed 
character. Otherwise, the cursor will return to the first column 
of the same line it was o n. 
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The Repeat (Rpt.) Controls item allows you to d etermine 
whether the control characters will repeat if the keys are 
pressed and held. This option is not available if Auto R epeat is 
not selected. Control characters are non-printing characters 
such as R eturn and Tab. 

Notice, in figure 8.5 , that the Transparent item is dimmed. 
This item is only ava ilable with the TTY terminal mode. When 
it is selected , the non-printing characters such as Backspace 
(BS), Carriage R eturn (CR), and Line Feed (LF) will appear as 
printed characters upon the MacTerminal document. 

When a ll Termina l Settings have been made to the desired 
specifications, select OK and the window will disappear with 
the new conditions saved. Selecting Cancel here will remove 
the window with the new conditions not saved. 

COMPATIBILITY 

The next item in the Settings menu is Compatibility. The 
window shown in figure 8.7 will appear when the Compatibil­
ity item is selected from the Setting menu. These settings 
determine the format of the data stream flowing to and from 
the modem. Each one of these settings should be mutua lly 
agreed upon by both the local a nd remote computer in order to 
insure coherent communications. 

The term Baud Rate has a ppeared before in this chapter. 
The baud rate which shou ld be selected for each application 
depends upon the needs and capabilities of the modems and the 
computers involved in the communications link. Select 300 
baud for ou r application with the Hayes modem. The 1200 
baud choice is the default value. 
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Compatibility Settings 

Baud Rate 0 50 075 0 110 0 134.5 

0150 0200 0300 0600 

® 1200 01800 0 2000 02400 

03600 0 4800 0 9600 0 19200 

Bits per Character O 7 Bits @ 8 Bits 

Parity O Euen O Odd ® None 

Handshake ® HOn/HOff O None 

Connection ®Modem O Another Computer 

Connection Port ® l~I O IAI 0 (conce1) 

Figure 8.7. The Compatibi lity Settings window 

The MacTerminal a pplication can dea l with either seven 
or eight bits per character. The proper cho ice depends upon the 
remote computer. 

Handshaking is a more advanced co ncept which many 
computers are using today. With this communicati ons method, 
the computer on either end of the link will not transmit data 
until the o ther unit signals that it is ready to receive data. The 
Mac can a lso tell the remote computer to temporarily cease 
data transmission with this technique. Without this feature, the 
computer assumes that the other computer is always ready to 
receive data. Thus, data may be lost if the remote computer is 
not ready to receive. Select XOn/ XOff for the Handshake 
option for the Mac. Select None if the remote computer does 
not use this feature. Handshaking is unnecessary at data rates 
less than 1200 baud. 
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The MacTerminal emulator may be used with the Mac 
under many configurations. These do not necessari ly involve 
the use of the modem or the telephone system. If you are 
connecting the Mac to another data source via direct cable 
connection, select Another Computer under the Connection 
item. If you use a modem, allow the setting to remain Modem. 
Selecting Another Computer will cause the Phone menu to be 
dimmed as it is not needed under this application. 

Since both the Phone Port, ~ , a nd the Printer 

Port, l~I , on the Mac's back panel use the standard RS-232 
specification, they are both equipped to handle the modem. To 
direct the Mac's attention to the printer port for the modem 

connection, select IAI from the Connection Point option. 
At the time of this writing, the use of the printer port was not 
yet implemented into the software. Although we cannot 
comment from direct experience, Apple Corp. has recom­
mended that you refrain from using the printer port for 
communications. It is not designed for extensive, bi-directional 
data transfe r and will not function at data rates exceeding 1200 
baud. 

When all Communications settings are correct, select OK 
from the window. Select Cancel to negate the new settings. 

FILE TRANSFER 

Selecting File Transfer from the Settings window will 
cause the window, shown in figure 8.8, to appear. Through this 
window the operator may set the parameters of the file transfer 
conditions. 
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File Transfer Settings 

Transfer Method @HModem Q TeHt 

Remote System @ MocTerminal O Other 

Deloy Between Chars I / 60th Second 

Deloy Between lines 

~ Retoin Line Breoks 

.__ _____ _,I / 60th Second 

~ Word Wrop Outgoing TeHt 

Figure 8.8. File Transfer window 

With XM Modem set in this window, the Mac can transfer 
any sort of file to the remote computer. The Text choice will 
al low on ly text file s, i.e. MacWrite or MacTerminal docu­
ments, to be se nt. The Text mode will not allow drawings to be 
se nt. Through this window the operato r may indicate whether 
commu nications are with a MacTe rmina l equipped computer 
or not. MacTerminal may be used e ither with the Mac o r wit h a 
Lisa using the Mac Works adaptation software. On ly ASCl 1 
strings may be se nt to any computer not usi ng the XModem 
transfer method. 

The operator may specify a delay between transmission of 
characters or lines in this window as required by the remote 
computer. This might be required if the remote computer 
cannot accept la rge amounts of consecutive data. 

The last two ite ms in this window refer to the format of the 
transferred data. When Retain Line Breaks is selected, the Mac 
will record the Return characters at the ends of the text lines 
received from the remote computer. When the data is to be 
transferred into a MacWrite or similar document which does 
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no t normally end each line with a Return cha racter, this option 
sho uld not be selected . 

Whe n the next item, Word Wrap Outgoing Text, is 
selected, the outgoing text will fo llow the MacW rite word 
wra paround protocol.Words which fall at the end of a line will 
be repos itioned so as to not split them. With this option not 
se lected , individua l characters will wra p aro und to the next 
line. 

When the settings within the window a re proper, select 
OK. The window will disap pea r with the changes recorded . 
Otherwise, select Cancel to remove the window with the 
cha nges not reta ined. 

ANSWERBACK MESSAGE 

Some computers request a message when another compu­
ter esta blishes a communications link. This message often is 
used by private computer services to identify the user or the 
user's computer. To enter a message into the M ac, select 
Answerback Message fro m the Settings menu. The window 
shown in figure 8.9 will a ppear. 

Most computers requiring this feature specify tha t the 
message in the wind ow must be entered with the same begin­
ning and ending character. A greeti ng message might be: xH el­
lox . Select OK from this box to set the message. 

Answerbock Message OK 

( Can cel ) 

Figure 8.9. Answerback Message window 
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SHOW TAB RULER 

When dealing with the MacTerminal document, locally 
entered data or data coming from the remote computer will 
often contain tab characters. This might occur when tranfer­
ring tables of numbers over the communications link. The 
designers of MacTerminal included a Show Tab Ruler item in 
the Settings menu. This enables MacTerminal to use the tab 
characters to properly format tables. Selecting this option will 
cause the ruler shown in figure 8.10 to a ppea r. 

10 20 30 40 50 60 70 80 
1 1 1 1 l11 11l1111l11 11 l1111l11 1 1 l 1 111l1 1 11l111 1 l1111l11 11l 1111l1111l 1 1 1 1 l1 1 11 l11 11l 1 • • • • • • • • 

Figure 8.10. The Tab ruler 

Normally, the tabs are preset every eight columns begin­
ning at the ninth column. This setting is a standard used by 
most computers. For other situations, the tabs may be reset on 
this ruler. To remove a tab, click on its marker. To create a new 
tab, place the pointer over the d esired position on the Tab ruler 
and click. 

To return to the MacTerminal document, pull down the 
Settings menu again and select Hide Tab Ruler. The ruler will 
disappea r and the Mac will remember the new settings of the 
tab markers. 
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PHONE MENU - PHONE SETTINGS 

Now that a ll communications settings have been properly 
made, we are ready to make contact with the outside world. 
The Phone menu is depicted in figure 8.11. Pull down the 
Phone menu and select Phone Settings. The window, depicted 
in figure 8. 12, will appear. The purpose of this window is to 
record the telephone number which the modem will call to 
contact the remote computer. It is also used to set the dialing 
conditions for the modem. 

Enter the number of a computer service into the blank. As 
with many other Mac menu windows, the blank will appear 
with the previous number highlighted if it already contains an 
entry. The majority of the telephone systems today have been 
converted to touch tone service. To instruct the modem to dial 
the phone number using tones, select Tone from the Dial item. 
If you are in an area which uses the rotary dial pulse system, 
select Pulse. These two will be the most prevalent cases. 

If, however, you are in an area where a mixture of tones 
and pulses is required , MacTerminal can accommodate this as 
well. Entering a Tinto the phone number sequence will instruct 
the modem to use tones. A P will indicate rotary pulses. To 
enter a mixed dial instruction into the Phone Settings window, 
simply insert a Tor Pin the appropriate position in the number 
sequence. The modem will change modes at the specified point. 

Diol. .. 
Hang Up ... 
Woit For Call ... 
Phone Settings ... 

Figure 8.11. Phone menu 
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Phone Settings 

Phone Number 

Diel @Tone QPulse OMiHed 

Number of Rings Before Rnswer 

Modem O Rpple 300 @Apple 1200 O Other 

OK ) (cancel) 

Figure 8.12. Phone Settings 

A mixed sequence might appear like this: T9,P(812)555-1212. 
The comma indicates a pause in the dialing sequence. This is 
useful when using a business phone where you need to dial for 
an outside line and then pause before entering the rest of the 
number. The parentheses and dash are ignored by the modem. 
You may enter them for convenience. 

Since the modem will change modes as many times as 
instructed, the Mixed choice in the Dial item is optional. If you 
do not choose Mixed, the Mac will send a mode instruction, 
either Tone or Pulse, to the modem before beginning the 
operator-entered sequence. This may be changed, as discussed 
earlier, by including the T or P character in the number 
sequence. 

The next item in the Phone Settings window determines 
the number of times which the phone will be allowed to ring 
before the modem will answer an incoming call. It is normally 
set to three rings. Setting it to zero will disable the modem's 
answer function. 

The last item identifies the modem type which the Mac is 
using. Select Apple 300 if the Mac uses the A pp le or Hayes 300 



278 Macintosh User's Handbook 

ba ud mod em. Select Apple 1200 if the Mac uses the Apple or 
the H ayes 1200 ba ud modem. With a ny other type of modem, 
select Other. 

Let's try a n example. We will assume that you are con­
tacting the computer installation at a local college. Enter the 
number into the Phone Settings window and select OK. Pull 
d own the Phone menu a nd select Dial. 

The speaker on the Hayes modem should beco me active, 
and yo u should be able to hear the modem dial the number. 
The speaker will remain active while the telephone rings. When 
the pho ne is picked up by the rem ote computer, you will hear a 
high pitched tone. This is one of the tones which computers use 
to identify themse lves over telepho ne lines. Then, if a ll goes 
well, there will be a nother tone. The speaker should become 
inactive at this point and the Mac should display a message 
indicat ing tha t it has contacted another modem. The message 
"Connect" should a ppear on the document. The last message 
was sent to you by your Hayes modem indica ting that it had 
contacted another modem and is ready to relay data. 

What you have contacted at this point may or may not be 
another computer. It is entirely possible that you have only 
contacted a network relay center which handles several compu­
ters. Although the exact entry procedures may vary from case 
to case, you will first have to enter an identifier for the specific 
computer which you wish to con tact. Then you will have to 
enter an identification code into the computer along with a 
password. These codes are intended to protect both your files 
in the remote computer a nd that computer from illegal entry. 

We have yet to discuss the remaining two items which 
appear in the Phone menu. When we have completed the 
communications sessio n, we will select Hang Up. T he Mac will 
instruct the modem to hang up the phone and terminate the 
link. 
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S electing Wait For Call causes the Mac to display a win­
dow indicating that it expects an incoming call. This window 
will remain on the display until it senses the phone ringing or 
until you select Cancel from the window. 

EDIT MENU 

At this point you may have enough text on the screen to 
cover about half of the display. If not, you may have had 
trouble with one of the Settings menu ite ms. For instance, the 
New Line setting may not be set properly. Once you have some 
text to wo rk with, you can try out the Edit menu items. Since 
all data on the document appears on both the local a nd remote 
computer displays, there can be no Cut or Clear options for the 
document. The Cut a nd Clear command will remain inactive 
unless you use the Edit menu with the D esk Accessories. The 
Edit menu ite ms a ppear in figure 8.13. 

[ ut 
Copy 
Copy Table 
Paste 
r h~nr 
Select Rll 

Show Clipboard 

Figure 8.13. Edit menu 
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To select a portion of the MacTerminal document, use the 
same method used with the Mac Write document. Place the edit 
bar at the beginning of the text you wish to select and drag to 
the end of the section. The text will become highlighted. You 
may now select Copy from the Edit menu.Now that the text is 
on the Clipboard, you may paste it onto the Apple menu fi le or 
an application's file. Closing the MacTerminal document will 
not terminate the communications link. When you return to 
the document, everything will be as before, if you have saved 
the docu ment. 

The Copy Table item is used when transferring a table 
from the MacTerminal document to another application's 
document. The Mac will subst itute a tab characte r for the 
spaces between columns when copying the table to the 
Clipboard. 

You may a lso use the Paste command to place the text 
upon the document. Copy a portion of text from another file to 
the Clipboard. Now return to the MacTerminal document and 
select Paste from the Edit menu. The Paste command will 
result in the text being placed upon the document and sen t to 
the remote computer. 

If you wish to transfer the entire document to the Clip­
board, choose the Select All item. Then select Copy to place the 
text upon the Clipboard . Choosing the Show Clipboard item 
will cause the Clipboard to appear displaying the text copied 
there. Se lect Hide Clipboard to return to the MacTerminal 
document. The Select All item is also used when printing the 
entire MacTerminal document using the Print Selection item 
under the File menu. This will appear in detail later in the 
chapter. 

As always, the Undo command can be used in many cases 
to negate the action last taken with the document. 
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COMMANDS MENU 

The Commands menu contains several items which con­
trol the MacTerminal document and the local computer. Pull 
down the Commands menu. The first item listed should be 
Don't Record Lines Off Top. When this item is se lected, the 
entries onto the MacTerminal document will disappear as they 
scroll off the top of the display. Pulling down the Commands 
menu again will reveal the command Record Lines Off Top. 
Selecting this item will return the document to the initial mode. 
The Mac will retain the lines which scrol l off the top of the 
display. 

We will assume at this point that you have been communi­
cating with the remote computer. You will notice that the 
document scrolls upward beyond the top of the Mac's display. 
The portion which is remembered beyond the top of the display 
is called the "Off Top" portion of the document. The Off Top 
portion of the document is delineated from the display portion 
by the dotted line which appears at the top of the display (see 
figure 8.4). 

To remove the lines stored Off Top, select the Clear Lines 
Off Top item in the Commands menu. This may be necessary 
when communicating for extended periods of time where the 
document becomes too large to hold within the Mac's RAM. 
The Mac will display the window, shown in figure 8.14. Select 
Yes to complete the operation. Pressing the Return or Enter 
keys substitutes for se lecting No in this window. You may wish 
to save this document before erasing the Off Top portion. 

The next item in the Commands menu is Reset. Selecting 
this option will clear the display portion of the document. It 
will also cause the Settings menu items to return to the settings 
held when the document was opened or last saved. The Off Top 
portion of the document will remain intact. The Mac will 
display another message which is depicted in figure 8.15. 
Selecting Yes will instruct the Mac to complete the operation. 
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Are you sure you want to Yes 
clear all lines off top? 

No 

Figure 8.14. Affirmation wind ow fo r Clear Line O ff Top 

When we d iscussed the H andshake co ncept, we sa id that 
the Mac can send a signal to the remote computer to stop it 
fro m sending da ta. When Handsha king is in effect , the Stop 
Scro lli ng command wi ll send that message. To continue send­
ing da ta, pull down the C ommands menu and select Sta rt 
Scrolling. 

If the Mac receives a Stop Scrolling instructi on from the 
remote computer, the keyboard will beco me inactive. That is, 
the keyboard will become locked. The K bd Locked status light 
will become t rue if the status lights a re displayed. To release the 
keyboa rd, select Unlock Keyboard from the Commands menu. 

Rre you sure you want to 
reset the terminal? 

Yes ) 

No ) 

Figure 8.15. Affirmation window for Reset 
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FILE MENU 

For the most part, the F ile menu for the MacT ermina l 
d ocu ment behaves as it has fo r every other M ac application. 
F igure 8. 16 shows the F ile menu items. The operator can create 
a new d ocument with the New comma nd and can open an 
ex isting document with the Open command. The Close, Save, 
Save As, and Quit commands also work as you have come to 
expect. 

If yo u wish to have a selected po rti on o f the MacTermina l 
document output to the printer, use the Print Selection item in 
the F ile menu. To print the entire M acT ermina l document, use 
the Select All item in the Edit menu before selecting Print 
Selection. Try this with the document you have created . 

N (1l.P 

OiH~H- -­
Close 
Saue 
Saue Rs ... 

Send File ... 
fb~C(1il~e f"ih~"' 

Puge Setup ... 
Print SehH tion __ , 

Quit 

Figure 8.16. F ile menu 
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Selecting the Send File item will cause the window shown 
in figure 8.17 to appear. This window is similar to the Open 
window used with the MacWrite and MacPaint applications. 
This window will display the files of the type listed in the File 
Transfer settings window which are available on the present 
disk. Select one for transfer by double clicking the file name or 
by clicking the file name and then clicking Open. If the file 
appears on another disk, select Eject and insert the proper disk. 
To return to the document with no action taken, select the 
Cancel option. 

The Receive File item instructs the Mac to prepare to 
receive a document from the remote computer. This option is 
only available when the Transfer Method in the File Transfer 
Settings window is set to XModem and the Remote System is 
set to Other. W hen Receive File is selected, the box, depicted in 
figure 8. 18, will appear. 

The received file will not appear on the MacTerminal 
document. Instead, it will be directly written to the disk. Enter 
the name which the file will assume on disk into the blank and 
select Receive. The Mac will display a message box informing 
you that it is waiting for incoming data. When the data begins 
to flow, the Mac will display the number of blocks of data 
which have been received at each point in the transfer. 

B-Port I Com ... g 
Clipboard File 

~ 
( ">~~nd ) Terminal 

Disk Copy 
Finder ( Eje~ 
lmagewriter I 

' 

Mac- to - Mac [ Cancel l 
MacTerminal 

Figure 8.17. Send File window 
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File Name: Terminal 

II Eject 

( Cancel 

Figure 8.18. Receive File box 

KEYPAD MENU 

The final MacTerminal menu, Keypad , differs from the 
others in that it is used to enter characters onto the document 
rather than give commands or set parameters. Pull down the 
Keypad menu. The result appears in figure 8.19. What you see 
here is an image of a keypad like the numeric keypad which you 
may have attached to your Mac. Drag the pointer to a button 
on this keypad and release the mouse button. This action is the 
same as if you had actually pressed that button on the numeric 
keypad . Although this may not seem more convenient than 
pressing the actual buttons, if you do not have the numeric 
keypad, you may need the Keypad menu to use the special 
functions PFl thru PF4. 

Now, press the Command key and pull down the Keypad 
menu. Figure 8.20 shows that the keys PF3, PF4, dash, and 
comma have been replaced by cursor control keys. Selecting 
one of these arrows will allow you to move the cursor about the 
MacTerminal document. Consequently, it also controls the 
cursor on the remote computer's screen. If you do not have the 
numeric keypad, this is the only means by which you can 
manipulate the cursor on the document. 



286 Macintosh User's Handbook 

KeypmJ 

Figure 8.19. Keypad menu 

Keyµdtl 

Figure 8.20. Keypad menu with Command key pressed 
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I n order to illustrate the final keypad menu d isplay, we 
will need to alter the Term inal Settings w indow. Access this 
window and select IBM 3278. With this mode, the Mac emu­
lates a standard IBM main frame terminal. Select OK from this 
window and pull down the Keypad menu again. Figure 8.2 1 
sh ows the result. These functions a re availab le for use with the 
IB M compatible computer. 

-PF1 PF2 Pf3 PF4 PfS PF6 PF7 PFS PF9 PF10 PF11 PF12 

PF 13 Pf 14 PF1S Pf 16 PF17 PF 18 PF19 PF20 PF21 PF22 PF23 PF24 

PAI Pfl2 Attn Pr in t Holle 
Erase P., lete Erase Insert Reset ~ Clear EDF ·~t 

Figure 8.21. Keypad menu with Terminal IBM 3278 

For now, we have finished using the computer link. With 
most la rge computer facilities, when you log off the computer, 
it will terminate the communications link for you. If this does 
not occur though, select Hangup from the Pho ne menu. The 
Mac will instruct the modem to terminate the telephone link. 

KEYBOARD EQUIVALENTS 

Most standard computer keyboards feature special func­
t ion keys which a re not used on the Mac. When using Mac­
T erminal, the following keys a re used to subst itute for the 
s pecial functions: 

Control = Command 
Escape = - (tilde) 
Break = Enter 
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Data Base Communications 

Another popular use for telephone communications be­
tween computers is data base access. A data base is composed 
of one or more computers, usually large main frames, which 
can be accessed by multiple subscribers who use the data base 
service to obtain various sorts of information. This includes 
information on stock prices, journals and periodical articles, 
scientific abstracts, credit information, and current and past 
news. Virtually any type of information can be obtained from 
data base services. Data bases are also used by their subscribers 
to contact each other through a computer network. 

Once you have subscribed to a data base service, the data 
base company will open an account for you on their computer 
system and send you the access codes needed to utilize your 
account. They also will send information on how to use the 
various services which are available. 

We will illustrate using a data base service to write the 
current news on the Mac display. The procedure for accessing 
an account may vary from case to case, but in general it 
proceeds as follows. Configure the Mac with the modem and 
open the MacTerminal document. Be certain that the Settings 
menu items are set up in accordance with the requirements for 
the data base computer. 

Select Dial from the Phone menu. The modem will make 
the connection as it did the previous example. Usually your 
access is not directly with a computer but with a network 
facility such as Tymnet or Telenet. These services act as clear­
ing houses to connect thousands of subscribers with their 
intended computer services. 

Next enter the identifier for the computer service you wish 
to contract. That data base service will give you the proper 
code. Once yo u have connected with the proper computer, 
enter your account ID code and your password. The password 
is important since it protects your account from illegal entry. 
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An example of the entry procedures for a data base appears in 
figure 8.22. 

@ATDT555- 1212 
CONNECT 

TELENET 
216 13U 

TERMINAL=d 1 

@C 30147 

30 1 4 7 CONNECTED 
Connected to THE SOURCE 
>id c99999 
Password? 
CL9999 (user 51) logged in Tuesday, 10 Jul M 16:44:20. 
Welcome, you are connected to THE SOURCE. 
Last login Tuesday, 10 Jul 84 15:52:56. 

(C) COPYRIGHT SOURCE TELECOMPUTING CORPORATION 1984. 

Figure 8.22. Access ing a data base 

Once you have accessed your account, you can utilize the 
services available to you through the data base. To access the 
daily news, you would follow the procedures outlined by the 
data base service. The Mac can be thought of as a terminal 
connected to the computer. The commands you type into the 
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Mac's keyboard will be entered into the da ta base computer. 
The da ta base computer will treat those commands as if you 
had entered t hem d irectly. 

One impo rta nt functi on offe red by most data base services 
is the keyword search. Once the search is initiated, the co mpu­
ter will search the files you specify for t he occurre nce of some 
keyword which yo u a lso specify. Then the computer will report 
o n the number of files in which it fo und the word . You the n 
have the option o f displaying one or more of those files (news­
pa per art icles, magazine articles, o r a bstracts) o n the M ac 
scree n. Since the Mac stores the entire d ocument, you can save 
the information on the MacTermina l d ocument or transfer it 
to a nother a pplicati on's d ocume nt. With the Ha ndshake func­
tion, you can use the Stop Scrolling comma nd to instruct the 
da ta base computer to wa it, if you need to copy information, 
befo re it completes the file tra nsfer. T his applies only if the data 
base computer uses Ha nd sha king. 

O nce yo u have finished with the da ta base, yo u will ex it 
the account by ente ring a terminating comma nd. The " Orr· 
ent ry is a prevalent comma nd fo r exiting a computer account. 
U pon logging out of the co mputer, yo u will be returned to the 
co mputer network facility . From there you may access a nother 
computer if yo u wish, or you may ha ng up. Select Ha ngup 
fro m the Pho ne menu. T he link will be bro ken, a nd the modem 
will be returned to the comma nd mode of operation. 

Communication with the IBM PC XT 

Communicati on links betwee n indiv idua l persona l com­
puters a re widely used. In o ur exa mple, we will illustrate a link 
between the M ac a nd a n IBM PC XT. S ince most termina l 
e mula tors use the ASC II communicat ions fo rmat, the M ac 
may be conn ected with a ny computer which conta ins the 
proper hardwa re a nd so ftwa re. 
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For this example, we will assume that the remote compu­
ter is calling the Mac. This situation is the reverse of our 
previous two examples. We will also assume that the IBM PC 
XT utilizes an emulator for which we have configured the Mac. 
Set up the Mac as before and select Wait For Call from the 
Commands menu. The modem will wait for an incoming call. 
The modem will answer the phone and send out the tones 
required to establish the connection. 

Once the Connect message has appeared on the Mac 
display, the IBM PC XT is on line with the Mac. Any charac­
ters entered on the MacTerminal document will also appear on 
the IBM PC XT's display. Conversely, any characters entered 
into the PC XT will appear on the MacTerminal document. 
Normally, this sort of communications link is only capable of 
data transfer. The remote computer usually controls only the 
displayed characters of the local computer. You probably will 
not be able to open and edit the remote computer's files 

through such a link. 
Let's transfer a file to the remote computer. There are two 

methods which may be used to transfer data files. The first is to 
write the file on the MacTerminal document; the second is to 
use the Send File item in the File menu. To use the first method, 
save and close the MacTerminal document. Open a document 
which you wish to transfer, a Mac Write document for instance. 
Use the Copy command of the Edit menu to put the desired 
text on the Clipboard. This allows you to transfer only a part of 
a file instead of the entire file. Reopen the MacTerminal docu­
ment and select Paste from the Edit menu. The text should 
appear on both the local and remote computers' screens. 

The second file transfer method involves using the Send 
File item of the File menu. Select this item, and the available 
documents will appear. Select the desired file, and the Mac will 
accomplish the transfer. The file will not appear upon the 
MacTerminal document. Instead, the Mac will display a box, 
such as the one depicted in figure 8.23, informing you of the 
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progress of the data transfer. You may terminate the transfer at 
any point. The data will be lost, however, if the remote compu­
ter is not prepared to accept it. The availability of the docu­
ments which may be transferred depends on the settings of the 
File Transfer window under the Settings menu. 

Sending the File • 1 BM PC HT". Size is I 900 characters. 
To Cancel, hold down the :IC key and type a period(.). 

Percentage Complete: 

lt111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111111 l 
0 25 50 75 1001 

Figure 8.23. Sending a file 

You may wish to connect The Mac with another personal 
computer such as the IBM PC XT using the modem but not the 
telephone. The Hayes modem is capable of this configuration. 
Connect the modems back to back as shown in the Hayes 
modem manual. As an example, instruct the Mac to dial the 
PC XT. The modem will dial the number and wait for an 
answer. Since there is no ringing, the IBM PC XT's modem will 
not automatically answer. Enter" AT A" into the PC XT. This is 
a direct modem command forcing it to answer the telephone. 
The modems will connect normally. 
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Conclusion 

In this chapter we have discussed Macintosh communica­
tions. We defined the term and reviewed some examples of it. 
We have used the Hayes 300 baud modem to connect the Mac 
with two large computers and another personal computer. In 
the process of doing this, we have learned about the MacTer­
minal emulator application. Since the final version of Mac­
Terminal was not completed at the time of this writing, there 
may be some slight discrepancies between our discussion and 
your experience. However, the general principle is the same. 
The application is designed to enable the Mac to mimic a 
standard computer terminal. 

There are many other uses for communications with other 
computers. Some banks allow you to do business with them 
over this type of link, for instance. You can access airline ticket 
reservation computers to inquire about and book flights. As 
the communications industry grows, you will be able to access 
more and more information from your home or office through 
this powerful medium. 



9 
Troubleshooting 
and Operation Hints 

Introduction 

This chapter will provide some basic troubleshooting 
hints which the Mac operator ma y find useful. For the most 
part, the Mac will di splay messages when something goes 
wrong with the hardware or software. Most system error mes­
sages allow the operator to restart the system or allow the 
operator to correct the problem, if it is simple, before continu­
ing operation. 

Malfunctions with the Mac can be broken down into two 
categories: 

• Hardwa re problems 
• Software problems 

295 
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The solution to the first category is simple. Either the Mac is 
not connected together correctly, or some inte rnal part is 
broke n. Of course, if the former problem occurs, you ca n solve 
it easily. If a n interna l Mac part is broken, the owner should 
take it to an authorized dealer and have it repaired. We do not 
recommend that you a ttempt to repair the Mac. 

This chapter includes hints on troub les hooting Macintosh 
hardware a nd software problems. This will include prob le ms 
with the: 

• Display 

• Disks and disk drive 

• Keyboard 

• Mouse 

• Printer 

The Mac computer hard ware is quite durable so many of 
these problems may never occur. The software within the sys­
tem may be the source of problems during normal operation . 
Since the software must manage a ll of the computer 's re­
sources, it is ve ry complex. Such complex it y is difficu lt or even 
impossible to perfect. 

The system programming which is included with your 
Mac is the end result of many man-yea rs of programming time. 
The resulting work has unde rgone extensive testing and should 
operate with no trouble. H owever, Apple computer engineers 
are constan tly working to improve the software. As a result , 
updated versions a re released on a fair ly regular basis. Be 
certain tha t a ll software included in your system was created 
under the sa me version of the operating system. Mixing files 
from one version to another may cause undo problems. 

To determine the ve rsion fo r the system, return to the 
F inder and select About the Fi nd er from the Apple menu. This 
information can be determined for an application by choosing 
the same option from the same menu afte r the application has 
been chosen. 
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The Mac Display 

By far the largest single component in the Macintosh is the 
display. The rectangular display on the front of the Mac main 
system unit is in reality the face of a large vacuum tube. In this 
age of high technology where most vacuum tubes are obsolete, 
we have yet to find an adequate replacement for the standard 
picture tube. 

In order to create a display, the tube shoots a beam of 
electrons at the display screen which is covered with a phos­
phorous material. To aim this beam, the tube uses a cluster of 
magnets which steer the electrons as they pass through their 
magnetic fields. All this hardware requires a variety of high 
voltages which the Mac generates from the electricity it 
receives. The circuitry for these voltages resides a long the left 
side of the Mac system unit. We recommend that you refrain 
from placing anything containing liquid upon the main unit. 
Any leakage through the vents in the top cou ld cause extensive 
damage to the Mac. 

Once the Mac has been properly installed, turn on the 
main unit. The power switch is located on the right side of the 
back of the main console. The switch is labeled with a" I" and a 
"O" tha t represents the conditions of "on" and "off," respec­
tively. 

When the Mac is first powered on , it should emit a short 
tone. The screen will remain blank while the picture tube 
warms up. After a few seco nds, a display will appear. If not, 
check to see that the unit is properly plugged into a wall socket. 
The intensity control may be set too low for a display. The 
control is located on the left side-of the Mac's face immedia tely 
below the Apple logo. To turn up the intensity, turn the dial 
clockwise. If there is still no display, the owner should contact 
a n authorized repair service. 



298 Macintosh User's Handbook 

Disks and Disk Drives 

The Mac uses diskettes to store and recall large amounts 
of information. This technique is required because the compu­
ter has only a limited amount of built-in memory. In addition, 
each time the compu ter is turned off, the major portion of the 
memory is erased . Only about one third of the system's 
memory is "permanent," but this portion is reserved for the use 
of th e computer. This situation requires the use of diskettes to 
esta blish a stable means of storing informatio n. 

The Macintosh is des igned to operate with a custom ver­
s ion of the Sony 3Yi inch diskette. Each diskette is housed 
within a hard plastic covering. The disk drive records as well as 
reads information from the surface of the di skette. These types 
of diskettes differ from the more commonly used "floppy 
disks" in three major ways . First of all , Mac diskettes are more 
efficie nt since they offer more tha n twice the data storage on a 
smaller surface. Also, the plastic cover on Mac diskettes makes 
them more dura ble. Finally, Mac diskettes a re more accurate 
beca use they have a metal center that allows the drive to hold 
the diskettes securely. Each diskette is capable of storing about 
e nough information to fill 150 doub le spaced , typed pages. 

Since the disks are essentially a magnetic means of record ­
ing information, disks ca n be erased by magnetic field s. The re­
fore, diskettes should a lwa ys be stored in a safe place. Virtually 
a ll e lect rical equipment (including the Mac) generates stray 
magnetic fi eld s. Therefore, never keep diskettes near electrical 
appliances or te lephones. 

The durable co nstruction of the Mac's disks makes them 
very reliable . T hey can be handled, dropped , or written upon 
with out harming the magnetic medium within. At some point 
during norma l opera tio n, you ma y find that the Mac will not 
accept a certain disk. T his sort of erro r is usually referred to as 
a system error and req uires that the system be resta rted . This 
problem is most likely not due to a physical defect in the disk. 
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The Mac has probably da maged the software information o n 
the disk making it impossi ble to read. 

One possible remedy for this problem is as follows. Re­
start the system using a functioning disk. Then eject t he disk 
and insert the faulty disk. As the disk drive begins to read the 
disk, press and hold the Option and Command keys. This key 
combination obliges the Mac to reini tia te the disk and read the 
files o n it. 

Files on the disk a re often organized into groups. A 
grouped collection of icons is known as a folder. See figure 
I .9b. The folder does not , in itself, represent a ny data. It is 
simply a holding place for other icons. When performing the 
a bove procedure, the Mac will probably erase all folders, 
exce pt the Empty Folder, leaving the icons held within them on 
the disk window. The files represented by these icons have not 
been damaged. If des ired, the opera to r can reorganize these. 
icons into folders. 

When naming documents, it is a good practice to name 
each document so that its folder can be identified. This aids the 
Mac user is reorganizing documents into their respective 
folders should these folders be erased. 

DISK FILE RECOVERY 

Whenever a computer uses a disk sto rage medium, there is 
a chance that the disk wi ll become faulty making data inaccess­
ible. The Mac does not provide a normal procedure for retriev­
al of information from such a disk. However, there is a special 
procedure to follow which should give the desired results. 

This method appears to work for recovering MacPaint 
documents. Howeve r, it shou ld be used only as a last resort , 
and only if the previously described method fails. The Mac was 
specifically designed to give complete disk handling control to 
the computer. If the o pera tor forces disk eject ion at an 
improper mome nt, he or she might cause e nough damage to 
the disk's data to make it completely unread able. 
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Access M ac Pa int on a system disk. Close the prese nt 
document and choose Open from the File menu . Select Eject 
and insert the fa ulty disk. If the disk's d ocuments appear, then 
select the one you wish copied. At this point , the Mac will 
req uest disk switches a few times a s it loads the file. Fi nally, the 
document a ppears within the MacPai nt display with the sys­
tem disk inserted. 

The task here is to fool the Mac into thinking one disk is 
present while a nother actually is present. Use an unbent paper 
clip or simila r o bject to "punch out" the system di sk using the 
following procedure. Insert the paper clip into the small pin 
hole to the right of the disk slot. Press in until the di sk ejects. 
Do not attempt to eject a disk while the disk drive is running. 
The pin hole is shown in figure 9.1. 

Figure 9.1 . Disk ejection hole 
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Now, insert the bad disk and select Sa ve As fro m the File 
menu. The Save As dia logue box will a ppea r. The message 
"Sa ve current docume nt as" may not be di splayed , or it may be 
displayed as a group of ga rbled characters. Se lect Eject fro m 
the dialogue box a nd inse rt the system disk. Notice tha t the 
d ialogue box rema ins o n the Desktop. Enter a new fi lena me in 
the space provided in the dia logue box o r keep the old one and 
hit Enter or Return, or select Save. The d ocument will appear 
on the system disk. Be sure the docume nt d oes not have the 
sa me na me as a nother o n the system disk. Only o ne fil e a t a 
time can be copied using this procedure. 

Afte r the Save As command, there is a good cha nce that 
the Mac will display a system error message . All is not yet lost, 
however. At this point, punch out the bad disk aga in and 
reinsert the system d is k. Choose Resta rt from the system error 
box. If all goes well, the system will resta rt and two files will 
a ppear on the system disk la beled .. Pa int I" and .. Paint2." 
These conta in the informa tio n fo r the tra nsferred document. It 
is, however, in a n ina ppropria te form . To properly fo rmat it, 
open the Mac Paint a pplica tion ico n. A new d ocume nt will 
a ppear entitled " rescue. " This document will be the t ra nsferred 
file. Upon closing the d ocume nt, the Mac will trea t it as a new 
fi le a nd ask the a pp ropria te questio ns. Whe n we have returned 
to the F inder, you will see tha t the two Pa int files a re replaced 
by the transfe rred d ocument with the na me entered . 

You may try va ria ti ons on this procedure with the foll ow­
ing guidelines. First, never try to punch out the disk if the disk 
dri ve is running. Second , do not be too surprised if some actio n 
ca uses the disk to become unreada ble, a nd it has to be 
reinitia lized . 
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The Mac Keyboard 

If the keyboa rd o n the Mac malfunctions, there is li tt le the 
operato r ca n d o but co ntact a n a uth orized d ea ler. There are, 
however, so me precauti o ns which ca n pro long the life of the 
keyboa rd . F irst we wo uld rei terate that you should neve r eat or 
d rin k arou nd a ny computer eq uipment. The keyboard is espe­
ciall y susceptible to da mage fro m s pilled food or d rink. Any 
ma tter which falls betwee n the keys can become lodged the re 
hindering the keystroke action. Any liquids which fall on the 
keyboa rd will see p in a nd ca n ca use e lectrica l malfunctions. 

The second preca ut io n is to try to use the softest possible 
key touch. T he keys a re quite sensitive a nd require very little 
pressure to se nse eac h keystro ke. The keys operate by making 
an electrica l co ntact eac h time a key is pressed . Striking a key 
too ha rd may cause the electrica l co ntacts to age prematurely. 
On the wh ole, however, the keyboa rd is durable and ve ry 
re lia ble. 

Taking Care of the Mouse 

The Macintosh mo use s hou ld be clea ned a t regular inter­
va ls to avoid d a mage to the interna l moving parts. First 
remove a nd clea n the mo use ba ll a nd its re tai ning ri ng as 
s hown in fi gure 9.2. Then b low out any de bris lod ged in the ba ll 
ca vity. Use clea ning Ou id s on the m ouse sparingly. To clea n the 
ro llers on the inside o f the mecha nism, use a cott on swa b 
slightly moistened wi th a lco hol or clea ning fluid. Never use 
water to clea n the mouse as this may da mage the interna l 
circuitry. Reassemble the mouse a fte r it is clea n. 
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0 

Figure 9.2. C leaning the m ouse 

The lmagewriter Printer 

The printer designed for use with the Mac is a complex 
a nd versatile machine. If you want to delve deeply into its 
operation you should rev iew the owners manual which came 
with it. The app licat ions ava ilab le for use w ith the Mac at 
present do not a llow the operator to take ad vantage of the 
special control codes for the printer. 

There are a series of switches and settings wi thin the 
lmagewriter printer which must be preset properly to insure 
normal operation. The I magewrit er should have been set up at 
the factory. If not, you should take it to the dea ler for 
adjustment. 

When using the lmagewriter printer, yo u may find that it 
is not an enti rely friend ly machine. To begi n with, the paper 
will cu rl severely if left in the pa per feed for just a few hours. 
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Also, the printer genera tes a considerable amount of noise 
especially when printing repeated patterns such as lines or 
MacPaint images. The construction of the printer is such that 
the paper must lie behind the unit upon the connecting cables. 
This not only increases the space the printer utilizes, but a lso it 
does not allow the pa per to lie flat. This could ca use paper feed 
problems. 

The only suggestion we have to remedy the first problem 
would be to unload the paper feed when the printer is not in 
use. T he latter two problems could be so lved with a covered 
printer stand sold a t many computer supply stores. This would 
help dampen the noise and would a llow the paper to reside 
below the stand . 

Outside of the normal MacWrite a nd MacPaint print 
sequence, there are only two printer operations* which you can 
perfo rm on the Mac. The first is to print the active windo w. If 
the Command, Shift, and 4 keys are pressed sim ulta neously, 
the printer will output the window which is presently active. If 
there is no print job in action, the active window will be 
printed . 

The second print command is similar to the first. Pressing 
the Command, Shift, Caps Lock, and 4 keys will cause the 
printer to print the entire Mac scree n display. While the Mac is 
sending the printer the print data, the screen will freeze . Note 
that such items as the pointer, Mac Paint tools, and menu titles 
a re not part of an active window and will not appear in the 
printout unless Caps Lock is depressed . 

• At the time of writi ng this book the Macintosh programming la nguages, 
Mac intosh BAS IC a nd Pascal. have not been publis hed. They will probably 
enable the, Mac use r to exercise mo re direct co ntrol over the printer. 
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Maintenance on the printer is simply a matter of c hanging 
the ribbon and clearing paper faults. Lubrication is required 
only once a year or so. The ribbon sh ould have a relatively long 
lifetime. When the o utput becomes too faint , it should be 
replaced. Remove the ribbon by pushing back the ribbon 
cassette retaining tabs and lifting the cartridge. Insta llation 
instructions are listed in chapter 2. 

The Imagewriter printer is very re liable and rarely devel­
ops problems with the paper feed. If a problem should occur, 
turn off the machine immediately a nd remove the covers. 
Remove any torn paper and reload the feed mechanism. Rein­
sta ll the covers and restart the printer. It may recommence 
printing if the print sequence was not complete. Allow the 
printer to complete the seque nce before a ttempting to continue. 

If the printer runs out of paper, the PAPER ERROR light 
will sh ine. To print the last few lines of a page, repeatedly press 
the SELECT button unti l the page is complete. 

The printer only uses its preprogrammed character set 
when printing text in draft mode. Otherwise, it will print in 
accordance with the Mac's instructions. To self test the output 
by printing the character set, turn off the machine. Then, press 
the FORM FEED button while turning the printer on. The 
printer will type the character set until you turn the printer off 
again. 

Only a few areas o n the I magewriter need to be cleaned 
and oi led . The printer should be cleaned every few months or 
as needed if it is heavily used. Turn off the printer and remove 
the paper cover toward the rear of the machine. Locate the 
PAPER ERROR switch. Its position is shown in figure 9.3. 
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Figure 9.3. PAPER ERROR switch 

Use a soft brus h to remove a ny dust and debris which 
might be lodged within the mec ha nism . Reassemble the 
printer. 

The print head sho uld a lso be clea ned periodically. To 
remove it, turn off the printer, a nd remove the large ca rrier 
cover over the print mecha nism. Loca te the two meta l re tai n­
ing tabs on either side of the print head nea r the pla ten . Figure 
9 .4 shows their posit ions. With yo ur thumb, press the tabs 
ou tward to relea se the print head. Gras p the print head a nd 
pull up with a firm, steady force. Press the roller shaft back to 
allow cleara nce for the print surface. It s ho uld req uire a bout as 
much force as it takes t o re move a plug from a wa ll soc ket. Do 
not force it or use any too ls. Excessive force may damage the 
print head. 
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Figure 9.4. Print head retaining tabs 

As with the PAPER ERROR switch, remove a ny dust o r 
debris from the print head a nd re insta ll it. Be sure that the 
e lectrical contacts are prope rly a ligned before pressing the 
print head into its socket. The two p ositioning posts s ho uld 
also align into their sockets o n the print head . Reassemble the 
printer for use. Note that the printe r will no t function while the 
carrier cover is removed. 

The only lubrica tio n required o n the printe r is a o nce a 
year oiling of the carrier ba r on which the print mechani sm 
moves. Locate the felt ring below the print head as shown in 
figure 9.5. Place a few d ro ps of machine oi l o n the ri ng. Be s ure 
to use a light oil which d oes not co ntain rust inhibitors. Be 
careful not to put oi l o n a ny othe r pa rts of the printe r. 
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Figure 9.5. Carrier bar oi ling ring 

If the lmagewri te r malfunctions and you are not able to 
discern the cause or trouble, check to see that the Mac is 
sending the proper information. To d o this, first insure that the 
cables are securely plugged into the backs of both units. If there 
is no problem with the cables, c heck the character set as des­
cribed a bove. If the printer opera tes normally, the problem 
may be with the Mac's software. Otherwise take the printer to 
an authorized Apple representa tive. 

Some Additional Hints 

Most computers feature a special set of commands which 
control the opera ti on of the unit. The Mac is very limited in 
that respect. You have a lready rev iewed the use of the Com­
mand and Option keys to oblige the Mac to read a disk whose 
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software is damaged. There are a few other suc h commands 
which perform similar functions. The va lidity of these options 
depends upon the version of the syste m you have. Some func­
tions may not work while some addit ional ones may be 
included on your Mac. 

When using the Backspace key, deleted characters are 
transferred into a special memory space which can be called the 
Backspace buffer. To unload this buffer and print out the 
de leted characters , press the Command key while pressing 
Backspace. The characters will appear in the reverse of the 
order they were deleted. This function is useful whe n using 
MacWrite. If you incorrectly typed the word "Mac" and 
wanted to de lete it and place it elsewhere, simply backspace 
through the word. The letters will be loaded into the Backspace 
buffer in reverse order, "caM." When you reach the point 
where the word should appear, press Command and press 
Backspace three times. The word will appear. 

The combina tion Command! (or Command, Shift, 1) will 
override the computer system and ca use the Mac to eject the 
disk in the main disk drive. Although this opt io n may be useful, 
it may have a drawback if used unwisely. If a document res ides 
in computer memo ry and the operator wants to keep it, he or 
she w ill have to ensure that it is saved before ejecting the disk 
and turning off the Mac. The normal procedure for ex iti ng an 
application and ejecting the d isk is designed to give the opera­
to r the option of saving the document. 

Entering the keystrokes Command# (o r Command, Shift, 
3) will cause th e Mac to create a MacPaint document, cal led 
Screen 0, which ho lds a copy of the display on the Mac screen 
at the time the command is entered. Each successive repetition 
of the command will create a like document entitled Screen I, 
Screen 2, and so on. The MacPaint applica tio n need not be 
present on the disk for the document to be created. Of course, 
to access the d ocument, MacPaint is required. 
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Command $ (or Command, Shift, 4) and Command, 
Shift, Caps Lock,4 ha ve been reviewed previously on page 304. 

On some operating systems, the instruction Command­
will cause the Mac to abort the application presently operating. 
Be ce rta in you save any documents before using this option. 
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Appendix A. 
ASCII Codes 

In the following table, each of the ASC II codes recognized by the 
Mac is listed with its corresponding character. S ince the Mac uses 8 bit 
bytes, 256 (0-255) characters are ava ilable. Cha racters 0-1 27 are rela-
tively standard for most computers. The remaining characters are not 
consistently assigned for a ll fonts. 

0 NUL 32 SP 64 @ 96 
1 SOH 33 65 A 97 a 
2 STX 34 66 B 98 b 
3 ETX 35 - 67 c 99 c 
4 EOT 36 $ 68 D 100 d 
5 ENQ 37 :g 69 E 101 e 
6 ACK 38 & 70 F 102 f 
7 BEL 39 71 G 103 g 
8 BS 40 72 H 104 h 
9 HT 4 1 73 I 105 
10 LF 42 * 74 J 106 j 
11 VT 43 + 75 K 107 k 
12 FF 44 76 L 108 
13 CR 45 77 M 109 m 
14 so 46 78 N 110 n 
15 SI 47 I 79 0 111 0 

16 DLE 48 0 80 p 112 p 
17 DC 1 49 1 81 Q 113 q 
18 DC2 50 2 82 R 114 r 
19 DC3 51 3 83 s 115 s 
20 DC4 52 4 84 T 116 t 
21 NAK 53 5 85 u 117 u 
22 SYN 54 6 86 v 118 v 
23 ETB 55 7 87 w 119 w 
24 CAN 56 8 88 x 120 x 
25 EM 57 9 89 y 12 1 y 
26 SUB 58 90 z 122 z 
27 ESC 59 91 [ 123 { 
28 FS 60 92 \ 124 I 
29 GS 61 93 l 125 } 
30 RS 62 94 126 -
31 us 63 ? 95 127 DEL 
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128 A 160 t 192 l 224 
129 A. 161 0 193 225 
130 ~ 162 ¢ 194 ... 226 
13 1 E 163 £ 195 ./ 227 
132 N 164 s 196 t 228 
133 0 165 • 197 z 229 
134 u 166 q 198 « 230 
135 a 167 B 199 » 23 1 
136 a. 168 €1 200 » 232 
137 a 169 © 20 1 233 
138 a 170 - 202 234 -
139 a 171 , 

203 A 235 
140 s 172 - 204 A. 236 
141 i; 173 ~ 205 0 237 
142 e 174 A! 206 CE 238 
143 e 175 0 207 ce 239 
144 e 176 00 208 - 240 
145 e 177 ± 209 - 241 
146 { 178 i 210 M 242 
147 l 179 1 2 11 .. 243 
148 1 180 ¥ 212 . 244 
149 i 181 µ 213 ' 245 
150 n 182 0 214 246 
151 6 183 ~ 2 15 <> 247 
152 ' 184 TI 216 y 248 0 

153 0 185 11 217 + 249 
154 0 186 I 218 250 
155 0 187 ~ 219 251 
156 u 188 Q 220 252 
157 u 189 0 22 1 253 
158 u 190 cs 222 254 
159 u 191 0 223 255 



Appendix B 313 

Appendix B. 
Warning Boxes 

Introduction 
This appendix reviews some of the warning boxes which might 

occur during normal operation. Each example features a caption 
explaining the condition which might cause the warning. 

File Opening Warnings 

OK 

Those items cen't oll be opened ot 
once. 

Cause: Trying to open too ma ny icons at once. The Mac can 
only perform one function at a time. 

C1rn't open nny more windows. 

OK 

Cause: Attempting to open too many windows on the Desk­
top. 
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OK 

Rn appllcatlon can't be found to open 
this file. 

Cause: Attempt ing to open a document for which there is no 

application present. 

Disk File Copy Warnings 

OK 

Replace items with the same names 
with the selected items? 

( Cancel ) · 

Cause: Attempt to place a file on a d isk which already has a file 
of that na me. 

01( 

That folder can't hold the selected 
item(s). 

Cause: Attempt to place a fo lder within a fo lder of the same 
name. 
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The disk is full. 

OK 

Cause: Attempt to place a file upon a disk with insufficient 
free storage space. 

OK 

The disk copy didn't work. Try copying 
to a different disk. 

Cause: Data transfer error during disk copy. 

OK 

The disk is so full thot the folder 
changes couldn't be recorded. 

Cause: Insufficient disk space to properly record disk file 
copy. Does not indicate a file copy error has occurred. 
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Disk Manipulation Warnings 

OK 

Repairing this disk. All folders were 
lost ; their contents haue moued back 
to the disk window. 

Cause: Software error on a newly inserted disk. 

A disk can only be moued by itself. 

OK 

Cause: Attempting to move multiple disk icons simultan­
eously. 

OK 

That name is too long. Use a name 
shorter thfm 64 choracters (27 for 
applications and disk nomes). 

Cause: Attempt to name a disk (or any other icon) with a name 
which is too long. 
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Internal Memory Warnings 

OK 

There is not enough memory to work 
with another disk. 

Cause: Attempting to place to many disk icons on the 
Desktop. 

OK 

There is not enough memory to ejec:t 
the sy stem disk. Pleflse dispose of fl 
dimmed disk find try flgflin. 

Cause: Ejecting the System disk with inte rnal memory nearly 
full. 

OK 

There is not enough m emory to 
remember this disk. I ts imnge will 
dist1 ppet1r from the desktop. 

Cause: Ejecting a n Alternate disk with internal memory 
nearly full. 
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Warnings Involving Erasure or the Trash Icon 

OK 

Are you sure you want to throw away 
a system flle? 

( Cancel ) 

Cause: Attempt to move a system file to the Trash icon. 

OK 

Thnt item is locked or in use, nnd cnn't 
be remoued. 

Cause: Attempting to discard an item which is locked or in 
use. 

OK 

That is the startup disk; it can't be 
erased. 

Cause: Attempting to erase the System disk. 
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Acoustic Modem see Modem 
Active window see Window 
Active window lines see Window 
A la rm Clock see Desk accessories 
A lternate disk see Disk 
Apple menu see Menus 
Apple modem see Modem 
Apple Lisa 15, 22 
A pplication 16 

Disk Copy 105-106 
Font Mover 107- 110 
MacPaint 161-254 
MacTermina l 262-292 
MacWrite 123-160 

Applicat ion disk see Disk 
Application file 27 
Artistic example 252-254 
ASCII 263, 265, 273 

B 
Backspace see Keys 
Backup disk 103 
Bar graph 231-238 
BASIC 27, 28 
Baud 26, 260 
Bit 18 

c 
C (p rogramming language) 27 
Calculator see Desk accessories 
Caps Lock see Keys 
Clicking 56 
Clipboard 83, 84 
Close box see Window 
Command see Keys 
Communications 26 
Const raints 203-207 
Control Panel see D esk accessories 
Controlling Slot 11 4 
CP/ M 12 
CPU 18 
C RT 19, 3 1, 297 
Cursor 266 
Cut sheet see Paper 

D 

Data base 288-290 
Data d isk see Disk 
Desk accessories 

Alarm Clock 93 
Calculator 96 
Control Panel 97-98 
Note Pad 95 
Puzzle 99 
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Desktop 46 
Dimensional illustratio n 238-246 
Direct connect modem see Modem 
Directory 55 
Disk 20, 298 

alternate disk 113 
data disk 110 
application disk 113 

Disk Copy see Applicatio n 
Disk drive 20 
Document 27, 28 

MacWrite 124-141 
MacPaint 162-187 
MacTerminal 263-270 

Dot inversion technique 174 
Double-clicking 56 
Dragging 54 
Drawing surface 165 

E 

Edit menu see Menus 
Eject 49 
Elect rical circuit 246 
Emulator 259 
Enter see Keys 

F 
File menu see Menus 
Finder 13, 43-99 
Fonts see Menus 
Font Mover see Application 
Format see Menus 
Fo rmaui ng 103 
FORTRAN 27 
Friction feed system 38 

G 

Goodies menu see Menus 
Grid coordinate 190 

H 

Handshake 27 1 

IBM PC 13- 15 
I BM PC XT 290-292 
Icon 46, 50-57 

Trash 45 
lmagewrite r 16. 24-25. 36-39. 303 
Initialization 103-104 
Insertion point 57. 8 1. 126. 143- 144. 266 
Installa tion 32-42 

K 

Keyboard 16. 22. 33-34. 47-48. 302 
Keys 

Backspace 146 
Caps Lock 47 
Co mmand 22. 47. 143 

W / MacTerminal 287 
Enter 22. 47 

W / MacTerminal 287 
Opt io n 22. 47 

Keywo rd search 290 

L 

Lisa see Apple Lisa 
Literate operating system 12 
Lockup 112 

M 

MacPaint see Document. see also Menus 
MacTerminal see Document. see also Menus 
MacWrite see Docume nt. see also Me nus 
Main conso le 33 
Menus 

Apple 68. 154 
Co mmands 28 1 
Edit 

System 80-87 
MacWrite 154- 155 
Mac Paint 188 
MacTerminal 279 
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System 49. 69-79 
MacWrite 154 
Mac Pa int 20 1 
MacTerminal 283 

Fonts 158 
Fo rmat 157 
Goodies 190 
Keypad 285 
Phone 276 
Search 155 
Settings 265 
Special 9 1 
Styles 158-1 60 
View 88-91 

Microprocesso r 18-1 9 
Modem 16 

Acoustic 256 
Apple 40-42. 260, 277-278 
Direct Connect 257 
Hayes 260-262 

Modulation 262 
Motorola 68000 see microprocessor 
Mouse 16. 23, 34-35, 302 
MS-DOS 12 

N 

Note Pad see Desk accessories 
Numeric key pad 16, 26, 40 

0 
Operati ng system 12 see also Finder 
Operations disk 110 
Optio n see Keys 
Optional d isk drive 25. 40. 11 2-113 
Orga nizational chart 2 14-220 

p 

Palo Alto Research Center 15 
Pa per 37-38. 152 
Pascal 27. 28 
Pie cha rt 220-231 
Pin feed see Pa per 
Pixel 19 
P ri nter see lmagewriter 
Puzzle see Desk accessories 

R 
RAM 19 
Rand om access 21 
Read / write head 20 
Ribbon 36-37 
ROM 19 

s 
Scrapbook 92 
Scroll bars see Window 
Search menu see Menus 
Select 8 1. 144- 146 
Sequential access 20 
Size box see Wind ow 
Special functions 207-2 11 
Specia l menu see Menus 
Startup diskettes 43 
Styles menu see Menus 
System d isk 16. 43, 113 
System file 27 
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System unit 16-22 see also Main console 

T 
Tab Ru ler 275 
Tone Modula tion 256 
Trash see Icon 

v 
View menu see Menus 
Visua l operating system 13 see also Finder 

w 
Winchester d isk drive 21-22 
Window 55. 58-6 7 

active window 58 
cha nging 59-61 

act ive window lines 58 
close box 56 
moving 62 
scroll bars 59 

scrolling 62-67 
size box 59. 62 

Write protect hole 115 
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x 
Xerox Star 15 
XModc m 273 
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